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Préface

Le système de bibliothèque modulaire StorageTek SL3000 d'Oracle est une solution de
stockage d'entreprise qui permet le stockage et l'extraction entièrement automatisés de
cartouches de bande.

Ce guide suppose que vous êtes déjà familiarisé avec les modules et les composants de la
bibliothèque SL3000. Pour des informations de présentation et de planification, reportez-vous
au SL3000 Overview and Planning Guide sur OTN.

Documentation connexe
De la documentation supplémentaire sur la bibliothèque SL3000 est disponible sur Oracle
Technical Network (OTN) à l'adresse suivante :

http://www.oracle.com/technetwork/documentation/tape-storage-
curr-187744.html

Accessibilité de la documentation
Pour plus d’informations sur l’engagement d’Oracle pour l’accessibilité à la documentation,
visitez le site Web Oracle Accessibility Program, à l'adresse http://www.oracle.com/
pls/topic/lookup?ctx=acc&id=docacc.

Accès aux services de support Oracle
Les clients Oracle qui ont souscrit un contrat de support ont accès au support électronique
via My Oracle Support. Pour plus d'informations, visitez le site http://www.oracle.com/
pls/topic/lookup?ctx=acc&id=info ou le site http://www.oracle.com/pls/
topic/lookup?ctx=acc&id=trs si vous êtes malentendant.

http://www.oracle.com/technetwork/documentation/tape-storage-curr-187744.html
http://www.oracle.com/technetwork/documentation/tape-storage-curr-187744.html
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
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1 
Installation de StorageTek Library Console

StorageTek Library Console (SLC) Oracle est une application offrant une interface graphique
pour configurer, surveiller et gérer la bibliothèque de bandes SL3000.

Remarque:

Les données clients stockées sur les cartouches ne sont jamais disponibles pour SLC ni pour la
bibliothèque. L'interface de données externe des lecteurs de bande est séparée de l'infrastructure de la
bibliothèque.

• Sélection d'une version de SLC
• Téléchargement du pack de supports de SLC
• Installation de la version autonome de SLC
• Installation de la version Web de SLC

1.1. Sélection d'une version de SLC
Vous pouvez exécuter les procédures décrites dans ce document avec l'une ou l'autre des
versions suivantes de SLC, sauf indication contraire :

• Autonome — SLC s'exécute à distance à partir de tout système disposant d'une connexion
réseau avec la bibliothèque.

• Web — SLC est installé sur un serveur, ce qui permet aux clients individuels d'utiliser un
navigateur pour y accéder.

• Panneau opérateur local — SLC est préinstallé dans la bibliothèque, ce qui permet aux
opérateurs de celle-ci d'accéder à la plupart des fonctions SLC directement à partir de la
bibliothèque.

1.2. Téléchargement du pack de supports de SLC
Le pack de supports inclut le serveur SLC Web, le client SLC Web et la version autonome de
SLC.

1. Accédez au Software Delivery Cloud d'Oracle à l'adresse :

http://edelivery.oracle.com/

2. Cliquez sur Sign In/Register.
3. Lisez les conditions et restrictions. Acceptez ces conditions, puis cliquez sur Continuer.

http://edelivery.oracle.com/
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4. Sur l'écran Recherche d'un Media Pack, sélectionnez Oracle StorageTek Products et
Generic Platform. Cliquez sur Accéder.

5. Sélectionnez la version de SLC à télécharger. Cliquez sur Continuer.
6. Pour consulter les informations de téléchargement, cliquez sur README.
7. Vérifiez que la version de SLC est correcte. Cliquez sur Téléchargement.
8. Enregistrez le fichier. Extrayez le pack de supports dans l'emplacement de votre choix.

1.3. Installation de la version autonome de SLC
1. Avant de procéder à la mise à jour, désinstallez toutes les versions existantes de SLC.
2. Téléchargez le pack de supports de la version autonome de SLC et extrayez-le (voir la

section Section 1.2, « Téléchargement du pack de supports de SLC »).
3. Sélectionnez le fichier du programme d'installation de SLC pour votre système

d'exploitation (voir le fichier README du pack de supports).
4. Consultez les informations. Cliquez sur Next.
5. Indiquez l'emplacement où SLC doit être installé. Cliquez sur Next.
6. Indiquez l'emplacement où créer les icônes de raccourci de SLC. Cliquez sur Next.

Remarque:

Sur Solaris, vous ne pouvez pas choisir le répertoire root par défaut. Oracle recommande /u-sr/
bin ou un emplacement semblable.

7. Vérifiez l'exactitude des informations. Cliquez sur Install.
8. Cliquez sur Done.

1.3.1. Plates-formes prises en charge

• Solaris 10 SPARC, Solaris 10 x86
• Windows Server 2008 SP2 : 64 bits, Windows 2012 Enterprise Server
• Windows 7 SP1 : 64 bits, Windows 8 64 bits, Windows 8.1 64 bits
• Oracle Unbreakable Linux 5 (2.6.18) 32 bits
• SUSE Enterprise Linux 10.2 (2.6.16) 32 bits

1.3.2. Sécurité

SLC communique avec l'interface de bibliothèque principale (PLI) via SSL, qui offre
un chemin de communication sécurisé entre la bibliothèque et la session SLC. Ainsi, un
utilisateur réseau non autorisé ne peut pas surveiller l'activité de la bibliothèque.

1.4. Installation de la version Web de SLC
Seules les mises à jour de la version Web de SLC doivent être installées sur le serveur. Vous
pouvez mettre à jour le serveur SLC Web pendant son exécution. Une fois que les mises à
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jour ont été installées, elles sont téléchargées automatiquement sur tous les clients à chaque
démarrage de l'application.

1. Téléchargez le fichier .war du serveur SLC Web et extrayez-le (voir la section
Section 1.2, « Téléchargement du pack de supports de SLC »).

2. Déployez le fichier sur le serveur (voir le fichier README du pack de supports).

1.4.1. Configuration requise minimum du navigateur

• Internet Explorer 8 (sur Windows 7 : 64 bits)
• Firefox 17.0.2 ESR (sur Windows 7 : 64 bits)

1.4.2. Sécurité

Le logiciel SLC Web est signé numériquement, ce qui garantit qu'il a bien été émis par Oracle
et qu'il n'a pas été modifié ni altéré depuis sa création. En tant que processus Java Web Start,
SLC Web comprend les fonctionnalités de sécurité fournies par la plate-forme Java 2.

Important:

Vous êtes chargé d'implémenter tous les systèmes de sécurité appropriés, dont des pare-feux et l'accès
utilisateur.
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2 
Connexion à SLC

Remarque:

Après un basculement RE, connectez-vous à l'aide de l'adresse IP ou de l'alias DNS du contrôleur de la
bibliothèque nouvellement actif (le contrôleur de secours précédent).

• Première connexion après l'installation de la bibliothèque
• Connexion à SLC autonome
• Connexion à SLC Web
• Connexion au panneau opérateur local
• Modification d'un mot de passe utilisateur

2.1. Première connexion après l'installation de la bibliothèque
1. Avec l'ID utilisateur admin, connectez-vous à SLC avec les huit premiers caractères d'un

mot de passe d'activation fourni par Oracle.
2. Modifiez le mot de passe admin.

a. Sélectionnez Tools > User Mgmt.
b. Renseignez les champs de mot de passe.
c. Cliquez sur Modify.

2.2. Connexion à SLC autonome
Plusieurs utilisateurs peuvent être connectés à SLC autonome.

1. Pour démarrer SLC sur votre système, vous pouvez :
• Double-cliquer sur l'icône du bureau SLC.
• Sélectionner Start > RunSLConsole ou Launch > RunSLConsole.

2. Entrez vos informations de connexion. Cliquez sur Log on.

2.3. Connexion à SLC Web
Pour vous connecter à l'aide d'un navigateur, téléchargez Mozilla Firefox sur le site http://
www.mozilla.com. Sur les plates-formes Solaris, vous pouvez également vous connecter à
SLC Web à l'aide de la ligne de commande.

1. Obtenez l'alias DNS ou l'adresse IP du serveur de SLC.

http://www.mozilla.com
http://www.mozilla.com
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2. Choisissez une méthode de connexion :
• Ligne de commande : uniquement disponible sur Solaris. Dans la fenêtre de terminal,

saisissez :

javaws http://server_ID:port_ID/opel/slc.jnlp
• Navigateur : disponible sur Windows ou Solaris. Dans un navigateur sur le système

client, accédez à l'application SLC Web Start :

http://server_ID:port_ID/opel

Où :
• server_ID : adresse IP ou alias DNS du serveur de SLC
• port_ID : ID de port de l'application SLC, généralement 8080
• opel  : nom (racine du contexte) de l'application SLC Web sur le serveur.

3. Cliquez sur Launch Now.
4. Indiquez la mesure à prendre avec le fichier slc.jnlp. Sélectionnez l'un des éléments

suivants :
• Open with Java(TM) Web Start Launcher pour lancer SLC directement.
• Save to Disk pour enregistrer le fichier slc.jnlp sur votre client et vous connecter à

SLC ultérieurement.
5. Si vous exécutez SLC Web pour la première fois, complétez la boîte de dialogue

d'avertissement de signature numérique (vérifiez l'éditeur et cliquez sur Run).
6. Entrez vos informations de connexion SLC. Cliquez sur Log on.

2.4. Connexion au panneau opérateur local
Seul un utilisateur à la fois peut se connecter au panneau opérateur local.

1. Si la fenêtre est vide, touchez l'écran à un endroit quelconque pour activer l'écran Login.
2. Entrez vos informations de connexion.
3. Cliquez sur Log on.

2.5. Modification d'un mot de passe utilisateur
Chaque site comprend un ensemble défini d'ID utilisateur : admin (administrateur client),
service (représentant du support technique Oracle) et oem (technicien de service après-vente
tiers). Chaque ID utilisateur se voit affecter un ensemble d'autorisations, qui détermine l'accès
aux utilitaires dans SLC.

1. Connectez-vous à SLC à l'aide du compte à modifier.
2. Sélectionnez Tools > User Mgmt.
3. Renseignez les champs de mot de passe.
4. Cliquez sur Modify.
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3 
Activation des fonctionnalités facultatives

Les fichiers d'activation de matériel permettent d'activer des fonctionnalités facultatives
de la bibliothèque comme les mises à niveau de capacité, Redundant Electronics et le
partitionnement. Vous devez installer un fichier d'activation de matériel pour chaque
fonctionnalité.

• Téléchargement d'un nouveau fichier d'activation de matériel
• Installation d'un nouveau fichier d'activation de matériel
• Affichage des fichiers d'activation de matériel actuels
• Suppression d'un fichier d'activation de matériel
• Installation de fichiers d'activation de matériel hérités

3.1. Téléchargement d'un nouveau fichier d'activation de
matériel 

Utilisez cette procédure uniquement avec le microprogramme FRS_3.0 et versions
supérieures. Pour les bibliothèques dont le microprogramme est antérieur à ces versions,
reportez-vous à la section Section 3.5, « Installation de fichiers d'activation de matériel
hérités  ».

1. Accédez au Software Delivery Cloud d'Oracle à l'adresse :

http://edelivery.oracle.com/

2. Cliquez sur Connexion / Enregistrement.
3. Lisez les conditions et restrictions. Acceptez ces conditions, puis cliquez sur Continuer.
4. Sur l'écran Recherche d'un Media Pack, sélectionnez Oracle StorageTek Products et

Generic Platform. Cliquez sur Accéder.
5. Sélectionnez le fichier d'activation de matériel SL3000. Cliquez sur Continuer.
6. Cliquez sur Téléchargement.
7. Enregistrez le fichier.
8. Extrayez le fichier vers un emplacement auquel vous pouvez accéder depuis votre session

SLC.

3.2. Installation d'un nouveau fichier d'activation de matériel
1. Dans SLC, sélectionnez Tools > Hardware Activation.

http://edelivery.oracle.com/
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2. Cliquez sur l'onglet Install Hardware Activation Keys.
3. Accédez au fichier d'activation de matériel.
4. Vérifiez les détails du fichier d'activation de matériel. Cliquez sur Install.
5. Cliquez sur Yes et sur OK.
6. Vérifiez que le fichier d'activation a été correctement installé (voir la section Section 3.3,

« Affichage des fichiers d'activation de matériel actuels »).

Des tâches supplémentaires devront éventuellement être réalisées afin de pouvoir
utiliser la nouvelle fonction (voir les sections Chapitre 4, Configuration de la capacité et
Chapitre 5, Partitionnement de la bibliothèque ).

3.3. Affichage des fichiers d'activation de matériel actuels
Remarque:

Pour afficher un journal d'audit des fonctionnalités qui contient une liste de toutes les activités d'activation
matérielle, utilisez l'utilitaire Reports (voir la section  Affichage de rapports sur la bibliothèque et les
périphériques à l'aide de l'utilitaire de rapports).

1. Dans SLC, sélectionnez Tools > Hardware Activation.
2. Sélectionnez l'onglet Current Hardware Activation Keys.

3.4. Suppression d'un fichier d'activation de matériel
La suppression d'un fichier d'activation de matériel est rarement nécessaire et peut avoir un
impact notable sur le fonctionnement de la bibliothèque. La présence de fichiers d'activation
de matériel supplémentaires dans la bibliothèque ne pose aucun problème (des fichiers
d'activation de capacité dépassant la capacité physique de la bibliothèque par exemple).

1. Dans SLC, cliquez sur Tools > Hardware Activation.
2. Cliquez sur l'onglet Delete Hardware Activation Files.
3. Sélectionnez le fichier d'activation à supprimer.
4. Vérifiez que le fichier d'activation correct est sélectionné et cliquez sur Delete.
5. Cliquez sur Yes.

Selon les fonctionnalités du fichier d'activation de matériel, des tâches supplémentaires
devront peut-être être réalisées après la suppression du fichier (voir la section
Section 5.1.2, « Suppression d'une partition »).

3.5. Installation de fichiers d'activation de matériel hérités
Pour les bibliothèques SL3000 disposant d'un microprogramme antérieur à la version FRS
_3.0, contactez le support technique Oracle. Toutes les fonctionnalités acquises sont incluses
dans un seul fichier d'activation de matériel installé par un représentant du support technique
Oracle.
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Si vous effectuez la mise à niveau vers la version FRS_3.0 ou supérieure du
microprogramme, suivez les procédures décrites dans la section Section 3.2, « Installation
d'un nouveau fichier d'activation de matériel ».
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4 
Configuration de la capacité

Remarque:

La capacité est automatiquement appliquée dans une bibliothèque partitionnée. La capacité peut
uniquement être configurée dans une bibliothèque non partitionnée.

Dans une bibliothèque non partitionnée, la capacité active est automatiquement assignée
après l'installation du fichier d'activation de matériel. La configuration automatique active
les emplacements de stockage dans le même ordre que celui spécifié dans la stratégie de
capacité par défaut. Vous pouvez cependant personnaliser la configuration et sélectionner les
emplacements qui seront activés.

• Création d'une configuration de capacité personnalisée
• Réinitialisation de la configuration de la capacité
• Définition de la stratégie de capacité par défaut
• Affichage de la configuration de la capacité actuelle
• Résolution des problèmes de cartouches orphelines causés par les modifications de la

capacité

Voir aussi

• Section 6.2, « Mise à jour des hôtes après modification de la capacité »

4.1. Création d'une configuration de capacité personnalisée
Vous ne pouvez pas utiliser le panneau opérateur local pour configurer la capacité.

Remarque:

Vous pouvez cliquer sur Refresh pour ignorer les modifications qui n'ont pas été validées et restaurer
la dernière configuration enregistrée. Vous devez appliquer la configuration pour l'enregistrer dans le
contrôleur de la bibliothèque.

1. Afin d'éviter les conflits, concertez-vous avec les autres utilisateurs de la bibliothèque
avant de configurer la bibliothèque.

2. Dans SLC, sélectionnez Tools > Select Active Cells. Sélectionnez l'onglet Module Map.
3. Sélectionnez un module et cliquez sur l'onglet Select Active Cells. Pour afficher un

module adjacent, cliquez sur Move Left ou Move Right.
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Remarque:

Si vous personnalisez la capacité pour la première fois, vous devez désélectionner tous les
emplacements de stockage :
1. Dans la liste déroulante Select by, sélectionnez Library. Puis, sélectionnez l'option Remove.
2. Cliquez sur n'importe quel emplacement "sélectionné" sur le plan du module pour rendre tous les

emplacements "inactifs".

4. Dans la liste déroulante Select by, sélectionnez une plage. Sélectionnez ensuite Add
(pour activer la zone d'activation) ou Remove (pour désactiver la zone).

5. Servez-vous du plan de la bibliothèque pour cliquer sur les emplacements de stockage
que vous souhaitez activer ou désactiver.

6. Lorsque vous avez terminé la configuration, cliquez sur Apply User Design.

Mise en garde:

Si des avertissements s'affichent, NE validez PAS les modifications. Cliquez sur Details >>,
puis effectuez des déplacements de récupérations sur les cartouches orphelines (voir la section
Section 9.1, « Déplacement de cartouches (déplacements de récupération) »).

7. Reconfigurez les applications hôtes de la bibliothèque afin qu'elles reconnaissent les
modifications (voir la documentation du logiciel hôte et la section Section 6.2, « Mise à
jour des hôtes après modification de la capacité »).

Icônes de capacité

Icône SLC Description

Not Accessible : emplacement non disponible pour l'activation (réservée aux cartouches de
diagnostic, physiquement bloquées, etc.)

Inactive : pas de licence pour cet emplacement pour l'instant

Active : emplacement disposant d'une licence

Selected : emplacement désigné pour l'activation ou la désactivation

No activation needed : ressource active par défaut

4.2. Réinitialisation de la configuration de la capacité
Mise en garde:

La réinitialisation de la configuration supprime les activations de capacité personnalisée, le
partitionnement, les pools de validation de média et réinitialise tous les ID d'élément SCSI dans une
bibliothèque SCSI.

La réinitialisation de la capacité applique la capacité par défaut telle que définie par la
stratégie de capacité par défaut (voir la section Section 4.3, « Définition de la stratégie de
capacité par défaut »).

1. Afin d'éviter les conflits, concertez-vous avec les autres utilisateurs de la bibliothèque
avant de configurer la bibliothèque.
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2. Dans SLC, sélectionnez Tools > Select Active Cells. Sélectionnez l'onglet Module Map.
3. Sélectionnez un module dans la bibliothèque. Cliquez sur l'onglet Select Active Cells.
4. Cliquez sur Reset to Default.
5. Reconfigurez les applications hôtes de la bibliothèque afin qu'elles reconnaissent les

modifications (voir la documentation du logiciel hôte et la section Section 6.2, « Mise à
jour des hôtes après modification de la capacité »).

4.3. Définition de la stratégie de capacité par défaut
Remarque:

Ce paramètre définit uniquement l'ordre d'affectation pour la nouvelle capacité ajoutée dans une
bibliothèque non partitionnée. Après la modification du paramètre de stratégie, vous pouvez suivre les
instructions de la section Section 4.2, « Réinitialisation de la configuration de la capacité » pour retirer la
capacité existante et l'affecter de nouveau en suivant le nouveau paramètre.

1. Dans SLC, sélectionnez Tools > Configuration.
2. Cliquez sur l'onglet Default Capacity Policy.
3. Sélectionnez le type d'affectation de capacité pour la bibliothèque :

• Left to Right (valeur par défaut) : l'affectation de capacité commence dans
l'emplacement supérieur gauche sur la façade arrière du module le plus à gauche. Elle
se déplace ensuite vers la droite, puis passe à l'emplacement supérieur gauche sur la
façade avant du module le plus à gauche (voir la section Figure E.6, « Numérotation de
l'élément de stockage SCSI »).

• Center Out : l'affectation de capacité démarre au plus près des lecteurs et se répartit
uniformément entre la gauche et la droite et entre l'avant et l'arrière.

4. Cliquez sur Apply.

4.4. Affichage de la configuration de la capacité actuelle
1. Dans SLC, sélectionnez Tools > Select Active Cells. Sélectionnez l'onglet Module Map.
2. Cliquez sur le module à afficher.
3. Sélectionnez l'onglet Current Active Cells. Placez le pointeur sur un emplacement ou un

lecteur pour en afficher les détails.

4.5. Résolution des problèmes de cartouches orphelines
causés par les modifications de la capacité

Dans une bibliothèque non partitionnée, une cartouche orpheline désigne une cartouche
située dans un emplacement de stockage inactif et est inaccessible à tous les hôtes. Une
cartouche peut devenir orpheline en cas de réduction de la capacité de stockage active ou de
déplacement manuel d'une cartouche vers un emplacement inaccessible.

Pour résoudre les problèmes liés aux cartouches orphelines, vous pouvez :
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• Générer un rapport sur les cartouches orphelines (voir la section Section 13.2, « Affichage
desrapports de capacité active »)

• Effectuer un audit de la bibliothèque (voir la section Chapitre 11, Audit de la bibliothèque )
• Effectuer une récupération en déplaçant une cartouche (voir la section Section 9.1,

« Déplacement de cartouches (déplacements de récupération) »)

Pour les bibliothèques partitionnées, voir la section Section 5.4, « Résolution des cartouches
orphelines résultant de modifications du partitionnement ».
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5 
Partitionnement de la bibliothèque

Le partitionnement sert à réserver certaines ressources de la bibliothèque (lecteurs,
emplacements et CAP) à l'usage exclusif d'hôtes HLI et FC-SCSI spécifiés. Le
partitionnement est une fonctionnalité facultative mise en oeuvre à l'aide d'un fichier
d'activation de matériel (voir la section Chapitre 3, Activation des fonctionnalités
facultatives).

• Partitionnement de la bibliothèque à l'aide de SLC
• Affichage des allocations de partitions actuelles
• Partitionnement des CAP
• Résolution des cartouches orphelines résultant de modifications du partitionnement

Voir aussi

• Section 6.3, « Mise à jour des hôtes après modification du partitionnement »

5.1. Partitionnement de la bibliothèque à l'aide de SLC
Remarque:

Les modifications du partitionnement n'entrent en vigueur que lorsque vous les appliquez à l'aide de
l'onglet Commit. Pour annuler les modifications non validées, cliquez sur Refresh.

• Ajout d'un ID de partition
• Suppression d'une partition
• Modification du type d'interface d'une partition
• Modification des infirmations sur une connexion hôte FC-SCSI
• Allocation de ressources à une partition
• Validation des modifications de partitionnement

5.1.1. Ajout d'un ID de partition

1. Arrêtez toutes les opérations en cours sur l'hôte.
2. Sélectionnez l'onglet Tools > Partitions > Summary (Step 2).
3. Dans la zone Partition Allocation Summary, cliquez sur Add Partition.
4. Sélectionnez l'ID de la partition, entrez un nom et sélectionnez un type d'interface. Il n'est

pas nécessaire que les ID des partitions se suivent.
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5. Cliquez sur OK.
6. Répétez les étapes 3 à 5 pour ajouter jusqu'à huit partitions. Pour les connexion FC-SCSI,

reportez-vous à Ajout d'une connexion hôte FC-SCSI.
7. Passez à Section 5.1.5, « Allocation de ressources à une partition ».

Ajout d'une connexion hôte FC-SCSI

Pour les partitions FC-SCSI, vous devez ajouter une connexion hôte (la configuration des
connexions hôte-partition HLI s'effectue par l'intermédiaire du logiciel de gestion de la
bibliothèque de bandes hôte).

a. Sélectionnez l'onglet Tools > Partitions > Summary (Step 2).
b. Dans la zone Partition Allocation Summary, sélectionnez la partition.
c. Cliquez sur Add Connection.
d. Saisissez l'initiateur (WWPN) ainsi que le LUN. Chaque initiateur connecté à la

bibliothèque de bandes doit comporter une partition de celle-ci affectée au LUN 0.
e. Cliquez sur OK.
f. Répétez ces étapes jusqu'à ce que toutes les connexions FC-SCSI requises soient ajoutées.

Chaque partition peut comprendre jusqu'à neuf connexions hôtes dont chacune peut se
connecter à plusieurs partitions.

5.1.2. Suppression d'une partition

Lorsque vous supprimez une partition, toutes les ressources qui lui sont affectées sont
signalées comme disponibles, toutes les connexions hôtes de la partition sont supprimées et
l'ID de la partition est supprimé.

1. Sortez les cartouches de données valides de la partition à supprimer (reportez-vous à
Section 9.1, « Déplacement de cartouches (déplacements de récupération) »).

2. Sélectionnez l'onglet Tools > Partitions > Summary (Step 2).
3. Dans la zone Partition Allocation Summary, cliquez sur la partition à supprimer.
4. Cliquez sur Delete Partition.

Remarque:

Si vous avez supprimé toutes les partitions, vous devez sélectionner un type d'interface de
bibliothèque (HLI ou FC-SCSI).

5. Passez à Section 5.1.6, « Validation des modifications de partitionnement ».

5.1.3. Modification du type d'interface d'une partition

Mise en garde:

La modification du type d'interface peut entraîner la perte des connexions hôtes actives ou des
affectations de CAP partagées existantes.

1. Sélectionnez l'onglet Tools > Partitions > Summary (Step 2).
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2. Dans la zone Partition Allocation Summary, sélectionnez la partition à modifier.
3. Cliquez sur Modify Partition.
4. Passez à Section 5.1.6, « Validation des modifications de partitionnement ».

5.1.4. Modification des infirmations sur une connexion hôte
FC-SCSI

1. Sélectionnez l'onglet Tools > Partitions > Summary (Step 2).
2. Dans la section Connections, sélectionnez la connexion hôte-partition à modifier.
3. Cliquez sur Modify a Connection.
4. Passez à Section 5.1.6, « Validation des modifications de partitionnement ».

5.1.5. Allocation de ressources à une partition

1. Sélectionnez l'onglet Tools > Partitions > Module Map (Step 3a).
2. Sélectionnez un module, puis cliquez sur l'onglet Design (Step 3b).
3. Sélectionnez un ID de partition dans la liste déroulante.
4. Dans la liste déroulante Select by, sélectionnez une plage. Sélectionnez ensuite Add ou

Remove.
5. Le plan de la bibliothèque de bandes permet de sélectionner les ressources à ajouter ou à

supprimer. Les partitions peuvent être non contigües.

Remarque:

Avant de réaffecter une ressource d'une partition à une autre, vous devez supprimer la ressource de la
partition initiale.

6. Répétez ces étapes pour chaque ID de partition. Une fois la conception de partition
terminée, cliquez sur Verify.

Mise en garde:

Si des avertissements s'affichent, cliquez sur Details >> et effectuez des déplacements de
récupération sur les cartouches orphelines (reportez-vous à Section 9.1, « Déplacement de
cartouches (déplacements de récupération) »). Ensuite, vérifiez de nouveau la conception.

7. En l'absence d'avertissement, passez à Section 5.1.6, « Validation des modifications de
partitionnement ».

Icônes de partitionnement

Icône SLC Description

(rectangle avec une croix) Non accessible — ressources indisponibles pour les opérations sur l'hôte
(emplacement système réservé, physiquement bloqué, etc.).

(rectangle blanc) Non allouée — ressource disponible pour affectation

(rectangle jaune) N° de partition — ressources affectées à la partition actuelle
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Icône SLC Description

(rectangle rouge) Autres partitions — ressources affectées à une autre partition

(rectangle gris) CAP partagé — CAP affecté à plusieurs partitions

5.1.6. Validation des modifications de partitionnement

Vous devez exécutez les procédures ci-dessous pour apporter des modifications à la
bibliothèque.

Remarque:

Pour éviter tout conflit de configuration, vous devez rendre la bibliothèque indisponible pour les autres
utilisateurs et arrêter les opérations sur l'hôte avant de valider les modifications du partitionnement.

1. Mettez la bibliothèque hors ligne sur l'hôte (voir la documentation relative au logiciel
hôte).

2. Cliquez sur l'onglet Commit (Step 4) de l'interface Partitions.
3. Cliquez sur Apply.

Remarque:

Si le bouton Apply est grisé, cela indique un dépassement de capacité de la bibliothèque. Supprimez
des emplacements de stockage d'une partition ou rachetez de la capacité.

Mise en garde:

Si des avertissements s'affichent, cliquez sur Details >> et effectuez des déplacements de
récupération sur les cartouches orphelines (reportez-vous à Section 9.1, « Déplacement de
cartouches (déplacements de récupération) »).

4. Configurez toutes les applications hôtes de la bibliothèque affectées (voir la
documentation sur le logiciel hôte et Section 6.3, « Mise à jour des hôtes après
modification du partitionnement »).

5.2. Affichage des allocations de partitions actuelles 
Voir aussi Section 13.3, « Affichage des rapports de partitionnement ».

1. Sélectionnez l'onglet Tools > Partitions > Module Map (Step 3a).
2. Cliquez sur un module à afficher.
3. Cliquez sur l'onglet Current Partition Definitions. Passez le pointeur de la souris sur

une ressource pour afficher des informations détaillées.

5.3. Partitionnement des CAP
Remarque:

Les CAP des AEM sont soumis aux mêmes règles et restrictions de partitionnement que les CAP de
rotation. Le terme CAP se rapporte aux deux types de CAP, sauf mention contraire.
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Chaque partition peut comporter des CAP dédiés ou des CAP partagés, mais pas les deux.
Seules les partitions ayant le même type d'interface hôte (FC-SCSI ou HLI) peuvent partager
un CAP. Une seule partition à la fois peut utiliser un CAP partagé.

Pour plus d'informations sur les états des CAP dans une bibliothèque partitionnée, reportez-
vous à Section 8.7, « États des CAP  ».

Réservation d'un CAP dans les partitions HLI

Un hôte HLI peut réserver un CAP si celui-ci est vide, fermé, verrouillé et s'il n'est pas déjà
réservé. Chaque hôte HLI réserve un CAP pour une utilisation exclusive en fonction des
besoins, puis le libère lorsqu'il n'est plus nécessaire.

Si l'hôte ne débloque pas la réservation du CAP et que vous ne pouvez pas mettre fin à
l'opération d'insertion ou d'éjection dans ACSLS ou ELS, vous pouvez annuler la réservation
de la partition hôte (reportez-vous à Section 8.4, « Annulation d'une réservation de CAP par
une partition »).

Association d'un CAP à une partition FC‐SCSI 

Généralement, la plupart des hôtes FC‐SCSI sont seuls propriétaires d'un CAP. Ainsi,
lors de l'utilisation d'un CAP partagé pour insérer ou éjecter des cartouches, vous devez
associer manuellement un CAP à la partition (reportez-vous à Section 8.6, « Affectation de la
propriété d'un CAP partagé à une partition FC‐SCSI  »).

5.4. Résolution des cartouches orphelines résultant de
modifications du partitionnement

Dans les bibliothèques partitionnées, une cartouche orpheline se trouve dans un emplacement
non alloué à l'hôte d'origine. Des cartouches orphelines peuvent apparaître à la suite d'une
modification de la taille d'une partition, de la suppression d'une partition ou de la migration
d'une cartouche vers une emplacement ou un lecteur qui n'est affecté à aucune partition.

Dans une bibliothèque partitionnée, les cartouches orphelines peuvent entraîner des pertes de
données. Si un hôte repère une cartouche orpheline dans sa partition, il risque de la considérer
comme un volume de travail et d'écraser les données qu'elle contient.

Pour résoudre les problèmes liés aux cartouches orphelines, vous pouvez :

• Générer un rapport sur les cartouches orphelines (reportez-vous à Section 13.3, « Affichage
des rapports de partitionnement »)

• Effectuer un audit de la bibliothèque (voir la section Chapitre 11, Audit de la bibliothèque )
• Effectuer une récupération en déplaçant une cartouche (voir la section Section 9.1,

« Déplacement de cartouches (déplacements de récupération) »)

Pour les bibliothèques non partitionnées, reportez-vous à Section 4.5, « Résolution des
problèmes de cartouches orphelines causés par les modifications de la capacité ».
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6 
Configuration des applications hôte

• Modification du type d'interface hôte d'une bibliothèque non partitionnée
• Mise à jour des hôtes après modification de la capacité
• Mise à jour des hôtes après modification du partitionnement
• Mise à jour des hôtes après modification du pool MV
• Mise à jour du logiciel de gestion des hôtes HLI pour RE
• Configuration de la fonctionnalité TCP/IP double

Voir aussi

• Section 7.2, « Activation du nettoyage des lecteurs gérer par les hôtes HLI »
• Section 9.5, « Configuration du format des codes-barres pour les hôtes FC‐SCSI »

6.1. Modification du type d'interface hôte d'une bibliothèque
non partitionnée

Remarque:

Pour une bibliothèque partitionnée; voir la section Section 5.1.3, « Modification du type d'interface d'une
partition ».

1. Sélectionnez Tools > Select Active Cells.
2. Cliquez sur l'onglet Select Active Cells.
3. Sélectionnez le type d'interface.
4. Cliquez sur Apply, puis sur Yes pour mettre à jour la base de données du contrôleur de la

bibliothèque.

Le nouveau type d'interface est immédiatement actif. Vous n'avez pas besoin de
réinitialiser la bibliothèque.

6.2. Mise à jour des hôtes après modification de la capacité
• Mise à jour d'ACSLS et ELS après modification de la capacité
• Mise à jour des hôtes SCSI après modification de la capacité
• Voir également : Chapitre 4, Configuration de la capacité pour modifier la capacité
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6.2.1. Mise à jour d'ACSLS et ELS après modification de la
capacité

Lancez un audit via ACSLS et ELS pour mettre à jour la base de données de l'hôte (reportez-
vous à la documentation du logiciel hôte).

6.2.1.1. Effet sur les hôtes HLI après modification de la
capacité

Après la modification de la configuration de la capacité, le contrôleur de la bibliothèque
envoie un message asynchrone à tous les hôtes, en les avertissant que la configuration de la
bibliothèque a changé.

Après l'ajout d'emplacements de stockage actifs, la bibliothèque demeure en ligne. Les tâches
hôtes et la connectivité ne sont pas affectées.

Après la désactivation d'un emplacement de stockage ou la suppression d'un emplacement de
lecteur vide, la bibliothèque est temporairement mise hors ligne. La bibliothèque est remise
en ligne après la mise à jour de la base de données du contrôleur de la bibliothèque.

6.2.2. Mise à jour des hôtes SCSI après modification de la
capacité

Emettez des commandes pour mettre à jour les informations de configuration de l'hôte
(reportez-vous à la documentation du logiciel hôte).

6.2.2.1. Effet sur les hôtes FC-SCSI après modification de la
capacité

Après l'activation ou la désactivation des ressources ou la modification d'une connexion
de LUN hôte, la bibliothèque est temporairement mise hors ligne avec une condition "Unit
Attention".

Après l'activation ou la désactivation des lecteurs, la bibliothèque met à jour la numérotation
des éléments SCSI (voir la section Section E.5.1.1, « Schéma de numérotation de l'élément de
stockage SCSI par défaut (cartouches) »).

6.3. Mise à jour des hôtes après modification du
partitionnement

• Mise à jour d'ACSLS ou ELS après modification du partitionnement
• Mise à jour des hôtes SCSI après modification du partitionnement
• Voir également : Chapitre 5, Partitionnement de la bibliothèque  pour modifier le

partitionnement
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6.3.1. Mise à jour d'ACSLS ou ELS après modification du
partitionnement
• Après la création d'une partition HLI, configurez la connexion hôte par le biais d'ACSLS

ou ELS (reportez-vous à la documentation du logiciel hôte). Une partition HLI peut
comporter jusqu'à 16 hôtes.

• Après la modification de la configuration du partitionnement, lancez un audit par le biais
d'ACSLS et ELS pour mettre à jour la base de données de l'hôte.

6.3.1.1. Effet de la modification d'une partition HLI sur les
hôtes
Pour les hôtes HLI, pendant l'allocation des ressources à la partition, celle-ci reste en
ligne. Toutefois, la partition est temporairement mise hors ligne lors de la suppression
des ressources qu'elle contient. La partition affectée revient automatiquement en ligne et
la bibliothèque signale à tous les hôtes connectés à la partition qu'une modification de la
configuration a été effectuée. Les partitions voisines ne sont pas dérangées.

Après l'allocation ou la suppression de ressources, les hôtes connaissent une brève
interruption lors de la mise à jour des informations de configuration de leur bibliothèque de
bandes. L'hôte continue de traiter les tâches automatiquement.

6.3.2. Mise à jour des hôtes SCSI après modification du
partitionnement
• Après la création d'une partition FC-SCSI, configurez la connexion hôte-partition dans

SLC (voir la section Section 5.1.4, « Modification des infirmations sur une connexion hôte
FC-SCSI »).

Une partition FC-SCSI peut comporter plusieurs connexions hôte-partition. Les
informations de connexion incluent le nom de port universel de l'adaptateur de bus hôte
FC-SCSI ainsi que le numéro d'unité logique de l'hôte (LUN, logical unit number).

• Après la modification de la configuration du partitionnement, émettez des commandes pour
mettre à jour les informations de configuration de l'hôte (reportez-vous à la documentation
du logiciel hôte).

6.3.2.1. Effet de la modification d'une partition FC‐SCSI sur
les hôtes
Après l'ajout ou la modification d'une connexion hôte-partition ou la modification du LUN,
la partition affectée est mise hors ligne avec une condition "LUNS Data Has Changed Unit
Attention". Si un hôte possède des mappages de connexion ITL nexus pour chaque connexion
de partition, alors seule la partition concernée par la modification de connexion est affectée.

Après l'allocation ou la suppression d'une ressource, la partition affectée est mise hors ligne
avec une condition "Mode Parameters Have Changed Unit Attention". Les partitions voisines
ne sont pas dérangées.
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6.4. Mise à jour des hôtes après modification du pool MV

• Mise à jour d'ACSLS et ELS après modification du pool MV
• Mise à jour des hôtes SCSI après modification du pool MV
• Voir également : Section 10.2, « Définition du pool de validation de média » pour modifier

le pool MV

6.4.1. Mise à jour d'ACSLS et ELS après modification du pool
MV

• Pour ACSLS, vous devez lancer la reconfiguration après la modification du pool MV.
Utilisez l'utilitaire config drives <panel_id>. Pour plus d'informations, reportez-
vous au ACSLS Administrator's Guide.

• Pour ELS, aucune action n'est requise après la modification du pool MV. Les hôtes ELS
sont reconfigurés automatiquement.

6.4.1.1. Effet de la modification du pool MV sur les hôtes HLI

Après l'ajout de lecteurs au pool MV, la bibliothèque (ou la partition affectée) est mise hors
ligne. Les messages "Configuration Changed", "LSM Ready", puis "Not Ready" sont envoyés
aux hôtes affectés par la bibliothèque. ELS retire automatiquement les lecteurs déplacés
vers le pool MV depuis sa configuration. ACSLS met automatiquement à jour l'état des
lecteurs déplacés vers le pool MV sur hors ligne, mais ACSLS nécessite le lancement de la
reconfiguration par vos soins.

Après la suppression de lecteurs d'un pool MV, la bibliothèque et les partitions demeurent
en ligne. S'il s'agit d'une bibliothèque non partitionnée, les emplacements de lecteur sont
disponibles immédiatement pour les hôtes. Les hôtes ELS démarrent la reconfiguration, mais
les hôtes ACSLS nécessitent le lancement de la reconfiguration par vos soins. S'il s'agit d'une
bibliothèque partitionnée, vous devez allouer l'emplacement de lecteur retiré du pool MV à
une partition (voir la section Chapitre 5, Partitionnement de la bibliothèque ).

6.4.2. Mise à jour des hôtes SCSI après modification du pool
MV

Lancez une reconfiguration pour mettre à jour les informations de configuration de l'hôte
(voir la documentation relative au logiciel hôte).

6.4.2.1. Effet de la modification du pool MV sur les hôtes SCSI

Après l'ajout de lecteurs au pool MV, la bibliothèque (ou la partition affectée) est mise
hors ligne. La bibliothèque renumérote les ID d'éléments et envoie deux messages "Unit
Attentions" : "Not Ready to Ready Transition" et "Mode Parameters Changed". Vous devez
lancer une reconfiguration de l'hôte.
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Lors du retrait de lecteurs du pool MV, la bibliothèque et les partitions demeurent en
ligne. La bibliothèque affecte logiquement le dernier ID d'élément au lecteur quel que soit
l'emplacement physique du lecteur. Lorsque la bibliothèque revient en ligne, les hôtes SCSI
r reçoivent deux messages "Unit Attentions" : "Not Ready to Ready Transition" et "Mode
Parameters Changed". Vous devez lancer une reconfiguration. S'il s'agit d'une bibliothèque
partitionnée, vous devez allouer l'emplacement de lecteur retiré du pool MV à une partition
(voir la section Chapitre 5, Partitionnement de la bibliothèque ).

6.4.2.2. Effet de la modification du pool MV sur les ID
d'éléments SCSI

La modification du pool MV permet de renuméroter les ID d'éléments SCSI. Si la
renumérotation a lieu, vous devez reconfigurer l'hôte.

Lorsque vous ajouter un lecteur au pool MV, la bibliothèque réaffecte automatiquement
les ID d'éléments à tous les lecteurs. L'emplacement du lecteur MV est considéré comme
"empty" (vide) et la bibliothèque ne lui affecte pas d'ID d'élément (voir la section
Section E.5.1.1, « Schéma de numérotation de l'élément de stockage SCSI par défaut
(cartouches) »).

Lorsque vous retirez un lecteur d'un pool MV, la bibliothèque lui affecte logiquement le
dernier ID d'élément quel que soit l'emplacement physique du lecteur.

Pour éviter la renumérotation, sélectionnez le lecteur qui correspond à la fois physiquement et
logiquement au dernier ID d'élément (vérifiez qu'il s'agit d'un lecteur T10000C ou D).

6.5. Mise à jour du logiciel de gestion des hôtes HLI pour RE
Pour plus d'informations sur RE, reportez-vous à Annexe B, Présentation de Redundant
Electronics.

ACSLS

ACSLS 7.3 ou version supérieure est requis pour RE et vous devrez peut-être ajouter des
connexions aux ports aux bibliothèques. Il existe deux méthodes :

• Arrêtez ACSLS. Exécutez la commande acsss_config, en spécifiant les ACS et les
connexions aux ports existants (avec les ACS dans la même séquence) et ajoutez de
nouvelles connexions aux ports. Démarrez ACSLS.

• Exécutez l'utilitaire config ports tout en exécutant ACSLS, en spécifiant les ports
existants dans la même séquence et en ajoutant de nouveaux ports à la fin. Vous ne pouvez
pas modifier ou supprimer de connexions aux ports avec config ports.

ELS

Oracle recommande vivement les PTF L1H15S0(VM)/L1H15S1(MVS) pour la version 6.2 et
L1H15S2 pour la version 7.0.
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Tableau 6.1. Prise en charge du niveau de compatibilité PTF HLI HSC/ELS pour FRS_4.00 et
version supérieure

Niveau
HSC/ELS

Niveau 20 ou
inférieur

Niveau 21 Niveau 22 Prise en charge
RE minimum
Niveau 231

Prise en charge
RE améliorée
Niveau 232

Prise en charge
de plusieurs RE
Niveau 233

6.1 PTF Niveau 21 L1H14UU (VM)

L1H14UV (MVS)

Non pris en charge Non pris en charge Non pris en charge Non pris en charge

6.2 PTF Niveau 21 L1HA4UW (VM)

L1H14UX (MVS)

L1H15DH (VM)

L1H15DI (MVS)

L1H15H9 (VM)

L1H15HA (MVS)

L1H15MF (VM)

L1H15ME (MVS)

L1H168F (VM)

L1H168G (MVS)

7.0 (MVS) PTF Niveau 21 L1H14UY L1H15DJ L1H15HB L1H15MH L1H168H

7.1 (MVS) Inclus Inclus Inclus Inclus Inclus L1H168I
1Peut se connecter à une bibliothèque RE SL3000 au sein d'une chaîne ACS. Seule la bibliothèque connectée peut être commutée par le
biais de la commande de commutation HSC.
2Peut se connecter à une bibliothèque RE SL3000 au sein d'une chaîne ACS. Toutes les bibliothèques RE peuvent être commutées par le
biais de la commande de commutation HSC. Prend en charge 32 connexions TCP/IP. Inclut la prise en charge de la fonctionnalité TCP/IP
double, l'affichage d'acs-id, la récupération automatique des CAP et la prise en charge de 64 cartouches de lecture en transition pendant la
récupération des cartouches.
3Peut se connecter à plusieurs bibliothèques RE SL3000 au sein d'une chaîne ACS. Inclut la même fonctionnalité que la prise en charge
RE améliorée.

6.6. Configuration de la fonctionnalité TCP/IP double
Remarque:

Avant de configurer la fonctionnalité TCP/IP double, rassemblez les informations relatives au réseau, au
routage et aux adresses IP fournies par l'administrateur ou utilisez la commande network ip appropriée.

• Configuration de la bibliothèque pour la fonctionnalité TCP/IP double
• Configuration d'un hôte ACSLS pour la fonctionnalité TCP/IP double
• Configuration d'un hôte ELS pour la fonctionnalité TCP/IP double
• Voir aussi : Annexe C, Présentation du TCP/IP

6.6.1. Configuration de la bibliothèque pour la fonctionnalité
TCP/IP double

Utilisez la commande route pour gérer les tables de routage. Définissez les routages pour les
ports 2A et 2B vers les hôtes.

1. A l'aide de l'interface de ligne de commande, mettez les deux ports hors ligne :

SL3000> network ip link set dev 2A down

SL3000> network ip link set dev 2B down

2. Ajoutez les nouvelles adresses IP et les nouveaux masques de sous-réseau pour les deux
ports :
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SL3000> network ip address add IP_address/netmask dev 2A

SL3000> network ip address add IP_address/netmask dev 2B

3. Pour rendre effective la modification, mettez les deux ports en ligne :

SL3000> network ip link set dev 2A up

SL3000> network ip link set dev 2B up

4. Saisissez la configuration du routage du réseau pour chaque port :
• Pour les hôtes multiples, ajoutez l'adresse IP et le masque de réseau pour chaque hôte :

SL3000> network ip route add IP_address/netmask dev 2A

SL3000> network ip route add IP_address/netmask dev 2B

• Pour un hôte unique, aucune valeur de masque de réseau n'est requise :

SL3000> network ip policy route add host_IP_address dev 2A

SL3000> network ip policy route add host_IP_address via gateway_IP_address dev 2A

SL3000> network ip policy enable 2A |2B

SL3000> network ip policy status

5. Vérifiez la configuration.

SL3000> network ip address show

SL3000> network ip route show

SL3000> network ip policy route show dev 2A |2B

6. Vérifiez la précision de la date et de l'heure.

SL3000> time

time print

time HH: MM

time HH:MM:SS

7. Testez la configuration pour vous assurer que vous pouvez accéder à la bibliothèque par
le biais des deux ports.

6.6.2. Configuration d'un hôte ACSLS pour la fonctionnalité
TCP/IP double

Pour le serveur ACSLS, vous devez utiliser la commande acsss_config ou l'utilitaire
config Dynamic Configuration pour configurer les deux interfaces réseau sur deux sous-
réseaux distincts. Utilisez la commande route pour définir les deux routages sur le serveur
ACSLS. Une seconde connexion physique améliore la fiabilité.
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1. Mettez à jour les tables de routage du serveur ACSLS en suivant les instructions de la
documentation ACSLS. S'il existe une interface réseau unique sur le serveur ACSLS,
aucun routage spécial n'est requis sur l'hôte.

2. A l'aide de l'invite de commande UNIX sur le serveur ACSLS, utilisez la commande
Dynamic Config pour ajouter une connexion de port à la bibliothèque SL3000.
a. Assurez-vous qu'ACS est en ligne ou en mode diagnostic vers ACSLS.
b. Utilisez config port acs_id pour ajouter un port.
c. Si ce n'est pas déjà le cas, mettez ACS en ligne vers ACSLS.

3. Pour supprimer ou remplacer une adresse IP existante par un port différent :
a. Interrompez ACSLS à l'aide de la commande kill.acsss (pour 7.3 et inférieur) ou

acsss disable (pour 8.0 et supérieur).
b. Configurez les nouveaux ports à l'aide de la commande acsss_config.
c. Rétablissez ACSLS en ligne à l'aide de la commande rc.acsss (pour 7.3 et

inférieur) ou acsss enable (pour 8.0 et supérieur).

Pour plus d'informations, reportez-vous au ACSLS Administrator's Guide.

6.6.3. Configuration d'un hôte ELS pour la fonctionnalité TCP/
IP double

1. Mettez à jour les tables de routage du mainframe IBM en suivant les instructions de la
documentation ELS. S'il existe une interface réseau unique sur le mainframe IBM, aucun
routage spécial n'est requis sur l'hôte.

2. Sur la console du mainframe IBM ou PARMLIB, utilisez l'instruction de contrôle
LMUPATH pour définir les pièces jointes LMU réseau.

3. Spécifiez un second paramètre LMUADDR pour définir les fonctionnalités TCP/IP double.
ELS détermine automatiquement si la connexion est TCP/IP double ou LMU double.

4. Mettez l'ACS hors ligne, exécutez la commande LMUPDEF et remettez l'ACS en ligne
pour sélectionner l'instruction LMUPATH mise à jour qui inclut la seconde connexion.

Pour plus d'informations, consultez la documentation d'ELS.
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7 
Configuration des lecteurs

• Activation du nettoyage automatique des lecteurs
• Activation du nettoyage des lecteurs gérer par les hôtes HLI
• Activation/désactivation de la fonctionnalité SCSI FastLoad
• Ajout ou modification des numéros de série de tiroir de lecteur

Voir aussi
• Section 9.4, « Définition des seuils d'avertissement du nombre d'utilisation des cartouches

de nettoyage »
• Section 12.3, « Affichage du statut et des propriétés des périphériques »
• Section 13.1, « Affichage de rapports sur la bibliothèque et les périphériques à l'aide de

l'utilitaire de rapports »

7.1. Activation du nettoyage automatique des lecteurs
Le nettoyage des lecteurs de bande doit se faire régulièrement au moyen d'une cartouche de
nettoyage afin d'éviter l'apparition d'erreurs de lecture ou d'écriture. Le nettoyage des lecteurs
peut être géré par la bibliothèque (il s'agit du nettoyage automatique) ou par les hôtes HLI.

Remarque:

La fonction de nettoyage automatique de la bibliothèque est activée par défaut. Si vous désactivez le
nettoyage automatique de la bibliothèque, le logiciel de gestion des hôtes doit gérer le nettoyage des
lecteurs (voir la section Section 7.2, « Activation du nettoyage des lecteurs gérer par les hôtes HLI »).

1. Sélectionnez Tools > Configuration.
2. Sélectionnez Enable Auto Clean, puis cliquez sur Apply.

Remarque:

Dans le cas d'une bibliothèque de bandes partitionnée, la fonction de nettoyage automatique peut être
activée ou désactivée pour chaque partition.

3. Vérifiez que la bibliothèque contient assez de cartouches de nettoyage compatibles (voir
la section Section 9.7, « Affichage de l'état des cartouches de nettoyage »).

Si nécessaire, insérez ou éjectez des cartouches de nettoyage (voir la section Section 9.3,
« Importation/exportation des cartouches de nettoyage et de diagnostic »).

4. Définissez le seuil des cartouches de nettoyage (voir la section Section 9.4, « Définition
des seuils d'avertissement du nombre d'utilisation des cartouches de nettoyage »).
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7.2. Activation du nettoyage des lecteurs gérer par les hôtes
HLI

Le nettoyage des lecteurs de bande doit se faire régulièrement afin d'éviter l'apparition
d'erreurs de lecture ou d'écriture. Le nettoyage des lecteurs peut être géré par les hôtes HLI
ou la bibliothèque (voir la section Section 7.1, « Activation du nettoyage automatique des
lecteurs »).

a. Dans SLC, sélectionnez Tools > Configuration.
b. Désélectionnez Enable Auto Clean, puis cliquez sur Apply.

Remarque:

Dans le cas d'une bibliothèque de bandes partitionnée, la fonction de nettoyage automatique peut être
activée ou désactivée pour chaque partition.

c. Activez le nettoyage des lecteurs sur l'hôte (consultez la documentation du logiciel hôte).
d. Importez les cartouches de nettoyage à l'aide du logiciel hôte. N'utilisez pas la fonction

d'importation/d'exportation de SLC.

7.3. Activation/désactivation de la fonctionnalité SCSI FastLoad
L'activation de la fonctionnalité SCSI FastLoad peut améliorer la vitesse des opérations de
montage et de démontage nécessaires pour une partition ou une bibliothèque FC‐SCSI.

Remarque:

Si vous activez la fonctionnalité SCSI FastLoad et que le chargement d'une cartouche échoue dans le
lecteur, l'hôte FC‐SCSI doit déplacer la cartouche du lecteur vers l'emplacement d'origine.

Cette fonctionnalité requiert au minimum le microprogramme SL3000 FRS_2.33 et
SLC 4.47.

Vous pouvez activer ou désactiver la fonctionnalité SCSI FastLoad séparément pour chaque
partition FC-SCSI.

1. Sélectionnez Tools > Configuration.
2. Pour chaque partition, définissez l'option d'activation de la fonctionnalité FastLoad :

• Sélectionnez cette option pour activer la fonctionnalité SCSI FastLoad.
• Désélectionnez cette option pour désactiver la fonctionnalité SCSI FastLoad (par

défaut).
3. Cliquez sur Apply, puis sur OK.

Rapidité accrue avec SCSI FastLoad

Une fois qu'un robot a chargé une cartouche dans un lecteur, il devient immédiatement
disponible pour la prochaine demande et n'attend pas que le lecteur signale le chargement
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de la cartouche. Le contrôleur de la bibliothèque attend de détecter que le lecteur de bande a
correctement chargé la cartouche avant de renvoyer la réponse à la demande de montage.

7.4. Ajout ou modification des numéros de série de tiroir de
lecteur

1. Sélectionnez Tools > Configuration.
2. Cliquez sur l'onglet Drive Tray S/N.
3. Cliquez sur Refresh pour afficher les données de configuration actuelles.
4. Pour modifier un numéro de série individuel du tiroir de lecteur :

a. Double-cliquez sur le champ Drive Tray S/N.
b. Saisissez le numéro de série du tiroir de lecteur. Passez à l'étape 6.

5. Pour modifier plusieurs numéros de série de tiroir de lecteur à la fois, vous pouvez
modifier un fichier CSV :
a. Cliquez sur Export puis enregistrez le fichier à l'emplacement de votre choix.
b. Ouvrez le fichier et modifiez uniquement les numéros de série du tiroir de lecteur. Ne

modifiez aucune autre valeur. Enregistrez les modifications.
c. Dans SLC, cliquez sur Import. Localisez le fichier .csv mis à jour, puis cliquez sur

Open.
6. Cliquez sur Apply.
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8 
Fonctionnement d'un port d'accès aux cartouches

(CAP)

Utilisez les ports d'accès aux cartouches (CAP) pour insérer des cartouches dans la
bibliothèque, ou pour les en éjecter.

Remarque:

Il existe deux types de CAP : CAP de rotation et AEM. Le terme CAP se rapporte aux deux types, sauf
mention contraire.

• Insertion de cartouches à l'aide d'un CAP
• Éjection de cartouches à l'aide d'un CAP
• Verrouillage et déverrouillage d'un CAP HLI
• Annulation d'une réservation de CAP par une partition
• Modification du mode d'affectation des CAP dans une bibliothèque FC‐SCSI non

partitionnée
• Affectation de la propriété d'un CAP partagé à une partition FC‐SCSI
• États des CAP
• Modes des CAP
• Ordre d'utilisation des CAP lors de l'éjection de cartouches (hôtes FC‐SCSI)

Voir aussi

• Section 5.3, « Partitionnement des CAP »

8.1. Insertion de cartouches à l'aide d'un CAP
Lors de l'insertion de cartouches à l'aide d'un CAP partagé d'une partition FC-SCSI, reportez-
vous à Section 8.6, « Affectation de la propriété d'un CAP partagé à une partition FC‐SCSI
 ».

Les magasins CAP sont amovibles. Vous pouvez placer des cartouches dans n'importe quel
emplacement de magasin, dans l'ordre de votre choix. Une fois que vous avez inséré une
cartouche par le CAP, la bibliothèque la transfère du CAP vers un emplacement de stockage ,
enregistre l'emplacement de la cartouche et envoie l'emplacement à l'hôte. Une fois le CAP
vide, la bibliothèque rétablit son état par défaut.
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Mise en garde:

Pour préserver votre matériel, ne forcez pas pour ouvrir ou fermer le CAP. N'insérez pas de cartouches
non étiquetées et ne placez pas de cartouches à l'envers.

Insertion de cartouches à l'aide d'un CAP de rotation

1. Si le CAP est en mode d'insertion automatique (voir la section Section 8.8, « Modes
des CAP »), passez à l'étape suivante. S'il est en mode manuel, démarrez l'opération
d'insertion sur l'hôte (voir la documentation relative au logiciel de gestion de bandes).

2. Appuyez sur le bouton CAP.

Le voyant du bouton s'allume et la porte s'ouvre.
3. Placez les cartouches dans le CAP avec le moteur du hub vers le bas et le code barres vers

vous.
4. Appuyez sur le bouton CAP.

Le CAP se ferme et se verrouille automatiquement et le voyant du bouton CAP s'éteint.

Insertion de cartouches à l'aide d'un AEM

1. Si le CAP est en mode d'insertion automatique (voir la section Section 8.8, « Modes
des CAP »), passez à l'étape suivante. S'il est en mode manuel, démarrez l'opération
d'insertion sur l'hôte (voir la documentation relative au logiciel de gestion de bandes).

2. Lorsque l'indicateur Unlocked s'allume, appuyez sur le bouton AEM CAP.

L'indicateur Wait clignote jusqu'à ce que la porte de sécurité soit complètement fermée.
En fonction du niveau d'activité dans la bibliothèque, cette opération peut prendre
plusieurs minutes.

3. Lorsque l'indicateur "Enter" s'allume, soulevez le loquet et ouvrez la porte. Placez les
cartouches dans le CAP avec le moteur du hub vers le bas et le code barres vers vous.

4. Fermez la porte d'accès à l'AEM avec le loquet.
5. Appuyez sur le bouton AEM CAP.

Le voyant Enter s'éteint et le voyant Wait commence à clignoter. La porte de sécurité se
lève.

8.2. Éjection de cartouches à l'aide d'un CAP
Lors de l'éjection de cartouches à l'aide d'un CAP partagé d'une partition FC-SCSI, reportez-
vous à Section 8.6, « Affectation de la propriété d'un CAP partagé à une partition FC‐SCSI
 ».

Une fois toutes les cartouches éjectées de la bibliothèque, le robot contrôle le CAP pour
s'assurer qu'il est vide (le robot ne lit pas les étiquettes des cartouches lors des opérations
d'exportation). Ensuite, la bibliothèque supprime l'emplacement de la cartouche de la base de
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données du contrôleur de la bibliothèque et de celle de l'hôte. L'état par défaut du CAP est
rétabli.

Mise en garde:

Pour préserver votre matériel, ne forcez pas pour ouvrir ou fermer le CAP.

Éjection de cartouches à l'aide d'un CAP de rotation

1. Lancez l'opération d'éjection au niveau de l'hôte. Spécifiez les ID de volume des
cartouches à éjecter (voir la documentation relative au logiciel de gestion de bandes).

Remarque:

Pour les hôtes HLI, vous pouvez sélectionner un CAP pour l'opération d'éjection. Pour les hôtes
FC‐SCSI, la bibliothèque utilise des CAP selon un ordre prédéfini (voir la section Section 8.9,
« Ordre d'utilisation des CAP lors de l'éjection de cartouches (hôtes FC‐SCSI) »).

2. Appuyez sur le bouton CAP. La porte du CAP s'ouvre et le bouton CAP s'allume.
3. Retirez les cartouches du CAP.

Mise en garde:

Pour éviter toute perte de données, ne laissez pas les cartouches de nettoyage expirées dans le
CAP. La bibliothèque considère les cartouches de nettoyage expirées comme nouvelles.

4. Appuyez sur le bouton CAP pour refermer le CAP.

Le CAP se ferme et se verrouille, et le voyant du bouton CAP s'éteint.
5. Le Robot continue de remplir le CAP jusqu'à ce que toutes les cartouches sélectionnées

soient éjectées. Attendez le déverrouillage de la porte du CAP, puis répétez les étapes 2 à
4.

Éjection de cartouches à l'aide d'un AEM

1. Lancez l'opération d'éjection au niveau de l'hôte. Spécifiez les ID de volume des
cartouches à éjecter (voir la documentation relative au logiciel de gestion de bandes).

2. Appuyez sur le bouton AEM CAP.

L'indicateur Wait clignote jusqu'à ce que la porte soit enclenchée, puis le voyant Enter
s'allume. En fonction du niveau d'activité dans la bibliothèque, cette opération peut
prendre plusieurs minutes.

3. Soulevez le loquet et ouvrez la porte. Retirez les cartouches du CAP de l'AEM. Fermez la
porte d'accès à l'AEM avec le loquet.

4. Appuyez sur le bouton AEM CAP. Le voyant Enter s'éteint et le voyant Wait commence
à clignoter. La porte de sécurité se lève. Si d'autres cartouches doivent être exportées, le
robot poursuit le remplissage des AEM nécessaires.

5. Le Robot continue de remplir l'AEM jusqu'à ce que toutes les cartouches sélectionnées
soient éjectées. Attendez le déverrouillage de la porte, puis répétez les étapes 2 à 4.
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8.3. Verrouillage et déverrouillage d'un CAP HLI

Un CAP déverrouillé est réservé par la bibliothèque et est indisponible pour tous les hôtes
jusqu'à ce qu'il soit verrouillé. Tentez toujours de déverrouiller le CAP ou la porte d'accès de
l'AEM à l'aide du logiciel hôte avant d'utiliser SLC.

Remarque:

Si le CAP est réservé par un hôte, celui-ci doit lever la réservation avant que le CAP puisse être
déverrouillé.

1. Dans SLC, sélectionnez Tools > Diagnostics.
2. Développez le dossier CAP dans l'arborescence de périphériques, puis sélectionnez le

CAP à modifier (colonne –31 pour le CAP de gauche et 31 pour le CAP de droite).
3. Cliquez sur l'onglet Access.
4. Dans la liste déroulante Locked, sélectionnez :

• True pour verrouiller
• False pour déverrouiller

5. Cliquez sur Apply.

8.4. Annulation d'une réservation de CAP par une partition

Si une réservation de CAP n'est pas libérée par une partition et que l'hôte ACSLS ou HSC ne
peut pas y mettre fin, effectuez la procédure suivante pour annuler la réservation.

Remarque:

Si vous n'effectuez pas toutes les étapes de la procédure, le CAP pourrait devenir indisponible pour toutes
les partitions.

1. Dans SLC, sélectionnez Tools > Shared CAP Assignment.
2. Développez le dossier CAP, puis sélectionnez le CAP dont la réservation doit être

contournée (colonne –31 pour le CAP de gauche et 31 pour le CAP de droite).
3. Cliquez sur l'onglet Unreserve.
4. Cliquez sur Apply pour annuler la réservation.
5. Cliquez sur OK pour poursuivre l'opération.
6. Si le CAP est verrouillé, déverrouillez-le via SLC (reportez-vous à Section 8.3,

« Verrouillage et déverrouillage d'un CAP HLI »).
7. Ouvrez le CAP. Retirez toutes les cartouches et étiquetez-les avec l'ID de partition.
8. Fermez le CAP. Le statut du CAP passe à "unreserved".
9. Déterminez si les cartouches du CAP doivent être réinsérées dans la bibliothèque, puis

insérez-les dans la partition appropriée.
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8.5. Modification du mode d'affectation des CAP dans une
bibliothèque FC‐SCSI non partitionnée

Le changement du mode d'affectation des CAP s'applique à tous les CAP de la bibliothèque.
Le mode d'affectation des CAP contrôle si les CAP de la bibliothèque peuvent être utilisés
pour les opérations d'hôte normales ou les actions de diagnostic.

1. Assurez-vous que tous les CAP de la bibliothèque sont non réservés, vides, fermés et
verrouillés.

2. Si vous basculez les CAP en mode de diagnostic, arrêtez les opérations sur tous les hôtes
(voir la documentation du logiciel de gestion des bandes).

3. Sélectionnez Tools > CAP Assignment.
4. Dans la liste déroulante Mode, sélectionnez l'une des options suivantes :

• Host Operations — rend tous les CAP disponibles pour les opérations d'hôte
normales. Sélectionnez cette option pour que la bibliothèque revienne à des opérations
normales de montage/démontage.

• Diagnostics — rend tous les CAP disponibles pour les opérations de diagnostic.
Sélectionnez cette option pour effectuer des mouvements de cartouches manuels, tels
que déplacer des cartouches de nettoyage ou de diagnostic depuis les CAP vers les
emplacements système.

5. Cliquez sur Apply.

8.6. Affectation de la propriété d'un CAP partagé à une partition
FC‐SCSI 

Vous devez affecter un CAP partagé à une partition FC-SCSI pour insérer ou éjecter des
cartouches.

• Une seule partition à la fois peut être affectée à un CAP partagé.
• S'il existe plusieurs CAP partagés, ils sont tous associés.
• Une association de CAP reste active jusqu'à ce que vous la supprimiez, jusqu'à ce que la

bibliothèque soit réinitialisée, jusqu'à ce que le CAP soit réaffecté ou qu'il soit initialisé.

Remarque:

Si vous supprimez l'association du CAP alors que celui-ci est ouvert ou contient des cartouches, le
contrôleur de la bibliothèque endosse la propriété du CAP et celui-ci devient indisponible pour l'ensemble
des partitions. Videz et fermez le CAP avant de l'associer de nouveau.

1. Dans SLC, sélectionnez Tools > Shared CAP Assignment.
2. Sélectionnez la partition.
3. Cliquez sur Apply.
4. Effectuez l'opération d'insertion ou d'éjection (voir les sections Section 8.1, « Insertion

de cartouches à l'aide d'un CAP » et Section 8.2, « Éjection de cartouches à l'aide d'un
CAP »).
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5. Une fois l'insertion ou l'éjection effectuée, désélectionnez la partition pour supprimer
l'association du CAP.

6. Cliquez sur Apply.

8.7. États des CAP 
Tableau 8.1. États des CAP dans une bibliothèque non partitionnée
Type de CAP État par défaut Indicateur de CAP

HLI en mode manuel Verrouillé Éteint

HLI en mode d'insertion automatique Déverrouillé Allumé

FC‐SCSI Déverrouillé Allumé

Tableau 8.2. États par défaut des CAP FC-SCSI dans une bibliothèque
partitionnée
Type de CAP État par

défaut
Indicateur de
CAP

Commentaire

Dédié Déverrouillé Allumé Aucune

Partagé Verrouillé Éteint L'association partition-CAP déverrouille le CAP et
allume le voyant.

Tableau 8.3. États par défaut des CAP HLI dans une bibliothèque partitionnée
Type de CAP État par

défaut
Indicateur de
CAP

Commentaire

Dédié ou partagé Verrouillé Éteint La réservation par l'hôte déverrouille le CAP et allume le
voyant.

Mode d'insertion
automatique

Déverrouillé Allumé Aucune

8.8. Modes des CAP
Mode d'insertion automatique
Seules les bibliothèques HLI prennent en charge le mode d'insertion automatique (voir la
documentation relative au logiciel de gestion de bandes).

Le mode d'insertion automatique permet à un utilisateur de la bibliothèque de bandes
d'ouvrir un CAP et de réaliser une opération d'insertion sans émettre une demande d'insertion
explicite. En mode d'insertion automatique, les CAP sont déverrouillés et ne nécessitent pas
de réservation par l'hôte. Dans une bibliothèque partitionnée, les CAP doivent être dédiés
pour que le mode d'insertion automatique puisse être utilisé.

Mode manuel
Le mode manuel est le plus sécurisé. En mode manuel, le système verrouille un CAP par
défaut. Pour lancer une opération d'insertion ou d'éjection en mode manuel, vous devez saisir
une demande d'insertion ou d'éjection explicite avant d'appuyer sur le bouton CAP Open.
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Mode d'affectation

Seules les connexions hôte FC-SCSI non partitionnées prennent en charge le mode
d'affectation. Le mode d'affectation des CAP contrôle si les CAP peuvent être utilisés pour les
opérations d'hôte normales ou les diagnostics (reportez-vous à Section 8.5, « Modification du
mode d'affectation des CAP dans une bibliothèque FC‐SCSI non partitionnée »).

8.9. Ordre d'utilisation des CAP lors de l'éjection de cartouches
(hôtes FC‐SCSI)

Dans une bibliothèque non partitionnée, l'interface SCSI traite tous les CAP comme un
seul. Quand vous initiez une opération d'éjection sur un hôte FC‐SCSI, le robot charge
les cartouches dans le CAP de rotation situé le plus à gauche, puis se déplace vers la droite
avant de passer aux AEM. Pour les bibliothèques de bandes partitionnées, la priorité du CAP
dépend de la manière dont les CAP sont affectés aux partitions.

L'exemple suivant prend en compte une bibliothèque FC‐SCSI avec un module de base
composée de deux CEM (situés de chaque côte de la base) et deux AEM (sur chaque côté
de la bibliothèque). Pour une opération d'éjection de 350 cartouches, le robot remplit les
emplacements des CAP dans l'ordre suivant :

Ordre Module Nombre de cartouches éjectées Total de cartouches
éjectées

1er CEM gauche 26 26

2ème Module de base 26 52

3ème CEM droit 26 78

4ème AEM gauche 234 312

5ème AEM droit 38 350
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9 
Gestion des cartouches

• Déplacement de cartouches (déplacements de récupération)
• Localisation d'une cartouche
• Importation/exportation des cartouches de nettoyage et de diagnostic
• Définition des seuils d'avertissement du nombre d'utilisation des cartouches de nettoyage
• Configuration du format des codes-barres pour les hôtes FC‐SCSI
• Affichage des informations de la cartouche
• Affichage de l'état des cartouches de nettoyage
• Utilisation des emplacements système réservés
• Types de cartouches
• Manipulation des cartouches

Voir aussi
• Section 8.1, « Insertion de cartouches à l'aide d'un CAP »
• Section 8.2, « Éjection de cartouches à l'aide d'un CAP »
• Section 4.5, « Résolution des problèmes de cartouches orphelines causés par les

modifications de la capacité »
• Section 5.4, « Résolution des cartouches orphelines résultant de modifications du

partitionnement »

9.1. Déplacement de cartouches (déplacements de
récupération)

Le déplacement d'une cartouche à l'aide de SLC met uniquement à jour l'emplacement de
la cartouche dans la base de données du contrôleur de la bibliothèque. Vous devez réaliser
un audit à partir du logiciel hôte pour mettre à jour la base de données de l'hôte afin d'éviter
l'échec des montages.

Pour afficher un tableau de toutes les cartouches de la bibliothèque, voir la section
Section 9.6, « Affichage des informations de la cartouche ».

Mise en garde:

Pour éviter les pertes de données, déplacez les cartouches avec précaution dans les bibliothèques
partitionnées. Déplacer involontairement une cartouche d'une partition à une autre rend la cartouche
orpheline et la nouvelle partition peut la traiter comme une cartouche provisoire.
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1. Sélectionnez Tools > Diagnostics. Cliquez sur Library dans l'arborescence du
périphérique.

2. Cliquez sur l'onglet RcvrMove.
3. Sélectionnez le mode d'emplacement source :

• Pour VOLID, entrez l'ID de volume de la cartouche à déplacer.
• Pour Location, sléectionnez l'emplacement actuel de la cartouche (CAP,

Emplacement, Lecteur, Emplacements réservés).
4. Sélectionnez le type d'emplacement de destination (CAP, Emplacements de stockage,

Lecteur et Emplacements réservés) et sélectionnez l'adresse de destination.

Remarque:

Sélectionnez Drive uniquement si la source est un CAP ou un emplacement réservé.

Ne déplacez pas les cartouches de données à des emplacements réservés. Les emplacements réservés
doivent uniquement contenir des cartouches de diagnostic ou de nettoyage.

5. Cliquez sur Start.
6. Lancez un audit de la bibliothèque depuis le logiciel hôte pour mettre à jour la base de

données de l'hôte (reportez-vous à la documentation du logiciel de gestion de bandes).

9.2. Localisation d'une cartouche
Vous pouvez rechercher des cartouches par ID de volume, adresse de bibliothèque interne ou
adresse hôte.

Pour afficher un tableau de toutes les cartouches de la bibliothèque, voir la section
Section 9.6, « Affichage des informations de la cartouche ».

9.2.1. Localisation d'une cartouche par ID de volume

1. Sélectionnez Tools > Diagnostics, puis cliquez sur le dossier Library dans l'arborescence
du périphérique.

2. Cliquez sur l'onglet Search.
3. Sélectionnez VOLID.
4. Entrez l'ID du volume (utilisez * comme caractère générique).
5. Depuis la liste déroulante Requester, sélectionnez le format des résultats de la recherche :

• default pour afficher les résultats au format de l'adresse interne de la bibliothèque.
• hli0 ou hli1 pour afficher les résultats au format de l'adresse HLI-PRC.

6. Sélectionnez le type de cartouche.
7. Cliquez sur Search.

9.2.2. Localisation d'une cartouche par adresse

1. Sélectionnez Tools > Diagnostics, puis cliquez sur le dossier Library dans l'arborescence
du périphérique.
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2. Cliquez sur l'onglet Search.
3. Sélectionnez Location.
4. Sélectionnez les critères de recherche dans la liste déroulante, puis entrez l'adresse (les

caractères génériques sont incorrects).
5. Dans la liste déroulante Requester, sélectionnez le type d'adresse entré dans le champ

Location.
6. Cliquez sur Search.
7. Cliquez sur . . . pour afficher les détails de la cartouche.

9.3. Importation/exportation des cartouches de nettoyage et de
diagnostic

La bibliothèque peut exécuter une seule opération d'importation ou d'exportation de cartouche
de diagnostic ou de nettoyage à la fois. Le contrôleur de la bibliothèque réserve le CAP pour
toute la durée de l'opération.

Avant de procéder à l'importation, vérifiez que la cartouche est correctement étiquetée. Les
identifiants de volume de cartouche de diagnostic doivent comporter huit caractères dont les
deux premiers doivent être DG. Les trois premiers caractères des cartouches de nettoyage
doivent être CLN.

9.3.1. Importation de cartouches de nettoyage et de
diagnostic

Mise en garde:

La bibliothèque considère une cartouche de nettoyage utilisée comme neuve, et réinitialise le compteur
d'utilisation à zéro.

Remarque:

Importez uniquement des cartouches de nettoyage utilisant SLC si le nettoyage automatique est activé
(voir la section Section 7.1, « Activation du nettoyage automatique des lecteurs »). Pour le nettoyage des
lecteurs gérés par les hôtes, importez les cartouches de nettoyage à l'aide du logiciel hôte.

1. Vérifiez que la bibliothèque dispose de suffisamment d'emplacements système réservés
vides. Un emplacement système doit rester vide dans la base et DEM pour la récupération
du robot ou l'initialisation de la bibliothèque (voir la section Section 9.8, « Utilisation des
emplacements système réservés »).

2. Vérifiez que le CAP est vide, non réservé par un hôte, fermé et verrouillé (voir la section
Section 12.3, « Affichage du statut et des propriétés des périphériques »).

3. Dans SLC, sélectionnez Tools > Diagnostics.
4. Développez le dossier CAP dans l'arborescence du périphérique, puis cliquez sur un CAP

à utiliser.
5. Cliquez sur l'onglet Import/Export.
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6. Dans la section Operation, sélectionnez Import Cleaning/Diagnostic cartridges.
7. Cliquez sur Start.
8. Chargez les cartouches dans le CAP (suivez les instructions fournies dans la section

Section 8.1, « Insertion de cartouches à l'aide d'un CAP » en commençant par l'étape 2).

9.3.2. Exportation de cartouches de nettoyage et de
diagnostic

1. Vérifiez que le CAP est vide, non réservé par un hôte, fermé et verrouillé (voir la section
Section 12.3, « Affichage du statut et des propriétés des périphériques »).

2. Dans SLC, sélectionnez Tools > Diagnostics.
3. Développez le dossier CAP dans l'arborescence du périphérique, puis cliquez sur un CAP

à utiliser.
4. Cliquez sur l'onglet Import/Export.
5. Sélectionnez un type d'opération d'exportation. Pour exporter des cartouches spécifiques,

sélectionnez les cartouches à exporter dans la liste "Select Cartridges(s) to export".
6. Cliquez sur Start.
7. Lorsque la notification de déchargement apparaît, déchargez le CAP (suivez les

instructions fournies dans la section Section 8.2, « Éjection de cartouches à l'aide d'un
CAP » en commençant par l'étape 2).

9.4. Définition des seuils d'avertissement du nombre
d'utilisation des cartouches de nettoyage

Le seuil d'avertissement doit être inférieur au nombre maximum d'utilisations recommandé
pour la cartouche afin de laisser du temps pour remplacer la cartouche (consultez la
documentation des fabricants de lecteur pour en savoir plus sur l'utilisation recommandée).

Lorsque vous importez une cartouche de nettoyage dans la bibliothèque de bandes, le
contrôleur de la bibliothèque de bandes remet le compteur d'utilisation à zéro. Pour afficher le
nombre d'utilisations en cours, voir la section Section 9.7, « Affichage de l'état des cartouches
de nettoyage ».

1. Dans SLC, sélectionnez Tools > System Detail. Sélectionnez le dossier Library dans
l'arborescence du périphérique.

2. Sélectionnez Auto Clean, puis l'onglet Warning Threshold.
3. Sélectionnez le numéro d'index du type de cartouche de nettoyage à configurer.
4. Entrez le nouveau seuil d'avertissement pour le type de cartouche. Pour désactiver

l'avertissement, définissez le seuil sur 0.

Remarque:

Le seuil d'avertissement de toutes les cartouches de nettoyage de ce type va être modifié.

5. Cliquez sur Apply.
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9.5. Configuration du format des codes-barres pour les hôtes
FC‐SCSI

Le format du code-barres spécifie la partie du code d'une cartouche que la bibliothèque
transmet aux hôtes FC-SCSI.

1. Dans SLC, sélectionnez Tools > Configuration.
2. Dans la liste déroulante, sélectionnez le format de présentation à utiliser pour chaque

partition :
• all : les huit caractères du code-barres sont transmis à l'hôte.
• left6 (valeur par défaut) : transmet uniquement les six caractères d'ID de volume à

l'hôte. Les caractères de domaine et de type, qui sont les deux caractères de droite, ne
sont pas transmis.

3. Cliquez sur Apply.

9.6. Affichage des informations de la cartouche
1. Dans SLC, sélectionnez Tools > Reports.
2. Développez le dossier Status Summary dans l'arborescence de navigation.
3. Sélectionnez Cartridge Table.

Voir aussi
• Section 9.7, « Affichage de l'état des cartouches de nettoyage »
• Section 13.1, « Affichage de rapports sur la bibliothèque et les périphériques à l'aide de

l'utilitaire de rapports »

9.7. Affichage de l'état des cartouches de nettoyage
Important:

Si un lecteur ne peut pas utiliser une cartouche de nettoyage, il notifie la bibliothèque que la cartouche
a expiré. Remplacez les cartouches de nettoyage expirées le plus rapidement possible (voir la section
Section 9.3, « Importation/exportation des cartouches de nettoyage et de diagnostic »).

1. Dans SLC, sélectionnez Tools > System Details.
2. Sélectionnez le dossier Library dans l'arborescence du périphérique
3. Cliquez sur l'onglet Auto Clean, puis sur l'onglet Cleaning Cartridges.

Remarque:

Il est possible qu'une cartouche de nettoyage en cours d'utilisation, en transition ou insérée dans la
bibliothèque à l'aide du logiciel hôte n'apparaisse pas dans la liste.

Etats des cartouches de nettoyage
• OK : la cartouche peut être utilisée pour le nettoyage.
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• warning : le compteur d'utilisation a atteint ou dépassé le seuil d'avertissement défini pour
ce type de cartouche.

• expired  : la cartouche a expiré d'après les informations fournies par les lecteurs.

9.8. Utilisation des emplacements système réservés
Le module de base et le DEM comportent des emplacements système réservés sur la façade
arrière inférieure. Les emplacements réservés stockent les cartouches de nettoyage et de
diagnostic importées à l'aide de SLC et du bloc de configuration du module. Ne stockez pas
les cartouches de données dans les emplacements système réservés.

Figure 9.1. Emplacement des cellules système réservées

9.8.1. Affichage des cartouches présentes dans les
emplacements système

1. Dans SLC, sélectionnez Tools > Reports.
2. Développez Status Summary dans l'arborescence de navigation.
3. Sélectionnez le rapport Cartridge Table.
4. Cliquez sur l'en-tête de la colonne Location Type pour trier le tableau. Le type

d'emplacement de tous les emplacements système est "sysCell".

9.8.2. Bloc de configuration du module

Chaque module possède un bloc d'identification avec des étiquettes identifiant la
configuration du module. Ce bloc se trouve sur la façade arrière inférieure dans la quatrième
colonne en partant de la gauche, lignes 49, 50, 51 et 52. Durant une initialisation ou après
une mise à niveau, l'assemblage robotique inspecte le bloc d'identification de module afin de
déterminer la configuration du module.

Ce bloc identifie les éléments suivants :

• Le type de module : module de base, module d'extension de lecteurs, module d'extension de
cartouches, module d'extension de stockage (PEM) ou module d'extension d'accès.

• La configuration de façade arrière : 1, 2, 3 ou 4 baies de lecteurs, des baies, des magasins
de chargement en masse ou vide.
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• La configuration de façade avant : baies, port d'accès aux cartouches (CAP), vide ou
magasins de chargement en masse.

• Options : baies, panneau ou fenêtre, vide ou baie de service.

Figure 9.2. Exemple de module de base du bloc d'identification de module
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9.8.2.1. Etiquettes spéciales

Les étiquettes CAPID/ et NOMAG/ sont des étiquettes spéciales qui ne contiennent pas
d'icône.

• CAPID/ n'est monté au-dessus de tous les CAP en tant qu'identificateur générique pour la
bibliothèque que si aucun magasin n'est installé sur le CAP de destination.

• NOMAG/ est monté derrière les magasins amovibles dans l'AEM de chargement en masse.

Tableau 9.1. Etiquettes spéciales

Fonction Texte de l'étiquette Code-barres Icône

ID de port d'accès aux cartouches SPECIAL: CAP IDENTIFICATION CAPID/ Aucune

Aucun magasin SPECIAL: NO MAGAZINES NOMAG/ Aucune

9.9. Types de cartouches
• Cartouches de données : utilisées pour stocker les données des clients
• Cartouches de diagnostic : utilisées par les représentants du service technique pour

effectuer des tests d'écriture/lecture sur les lecteurs (voir la section Section 9.3,
« Importation/exportation des cartouches de nettoyage et de diagnostic »).

• Cartouches de nettoyage : utilisées pour nettoyer le chemin de la bande et lire/écrire sur
les têtes des lecteurs de bande (voir la section Section 9.3, « Importation/exportation des
cartouches de nettoyage et de diagnostic »).

9.9.1. Etiquettes de cartouches

Pour plus d'informations sur les normes d'étiquetage des cartouches, reportez-vous à la
section Barcode Label Technical Brief sur OTN. Toutes les cartouches de la bibliothèque
doivent être munies d'une étiquette externe lisible. Le robot signale une erreur lorsqu'il
rencontre une étiquette illisible.

Les cartouches non étiquetées ne sont pas prises en charge. La bibliothèque éjecte via le
CAP toute cartouche non étiquetée qu'elle identifie. Une cartouche non étiquetée ou de type
inconnu ne peut pas être montée dans un lecteur.

9.10. Manipulation des cartouches
Mise en garde:

Une manipulation incorrecte des cartouches peut entraîner une perte de données ou endommager un
composant de la bibliothèque.

• Les cartouches doivent rester propres et vous devez les inspecter avant chaque utilisation.
• N'ouvrez jamais une cartouche.
• Ne manipulez pas la bande qui est hors de la cartouche ; le bord de la bande risque d'être

endommagé.
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• N'exposez pas directement la bande ou la cartouche aux rayons du soleil, à l'humidité ou
aux champs magnétiques.

9.10.1. Inspection d'une cartouche

Avant d'insérer une cartouche dans un lecteur de bande ou une bibliothèque, inspectez-la
systématiquement. Une cartouche défectueuse ou sale peut endommager un lecteur de bande.
N'utilisez jamais une cartouche endommagée. Recherchez les éléments suivants :

• Poussière ou débris
• Boîtier fissuré ou brisé
• Commutateur de protection d'écriture endommagé
• Présence de liquide dans la cartouche
• Etiquettes mal fixées ou dépassant le bord de la cartouche

9.10.2. Nettoyage de la partie extérieure de la cartouche

Nettoyez la poussière, les salissures et l'humidité de la cartouche avec un linge non
pelucheux. Utilisez les chiffons de nettoyage de bande Oracle StorageTek pour nettoyer les
cartouches. Ces chiffons sont imprégnés d'alcool isopropylique. Evitez tout contact entre la
solution et la bande ou toute pénétration de solution dans la cartouche.

Mise en garde:

Afin de ne pas endommager les cartouches, n'utilisez pas d'acétone, de trichloroéthane, toluène, xylène,
benzène, cétone, méthyléthylcétone, chlorure de méthylène, éthyldichlorure, esters, acétate d'éthyl ou
autres produits chimiques similaires pour retirer les étiquettes ou nettoyer les cartouches.

9.10.3. Stockage des cartouches

Stockez les cartouches dans un environnement propre. Ne retirez pas une cartouche de son
emballage de protection avant de devoir l'utiliser. Utilisez le ruban d'ouverture pour retirer
l'emballage au lieu d'un instrument coupant. Avant d'utiliser une cartouche, assurez-vous
qu'elle ait passé au moins 24 heures dans son environnement d'utilisation.
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10 
Validation d'une cartouche

Pour valider l'intégrité des cartouches T10000 à l'aide de la fonction de validation de média
(MV), vous devez définir un pool de lecteurs T10000C ou D. Ce pool n'est pas considéré
comme une partition, il ne contient aucune cartouche et les hôtes ne peuvent pas accéder aux
lecteurs qu'il contient. La bibliothèque nettoie automatiquement les lecteurs MV.

Remarque:

Le nettoyage des lecteurs MV est effectué quel que soit le statut de nettoyage automatique de l'ensemble
de la bibliothèque ou des partitions. Vérifiez que la bibliothèque contient des cartouches de nettoyage
(voir Section 9.3, « Importation/exportation des cartouches de nettoyage et de diagnostic »).

• Conditions requises pour la validation de média
• Définition du pool de validation de média
• Démarrage ou reprise de la validation de média
• Arrêt d'une validation

Voir aussi

• Section 6.4, « Mise à jour des hôtes après modification du pool MV »

10.1. Conditions requises pour la validation de média
• Microprogramme SL3000 FRS_4.30 et SLC FRS_6.50 au minimum
• Pool désigné de lecteurs T10000C ou D au niveau TTI 5.40 ou supérieur
• Carte HBT à grande quantité de mémoire
• STA 2.0 au minimum pour automatiser la validation de média (facultatif)

10.2. Définition du pool de validation de média
Important:

Les hôtes n'ont pas accès aux lecteurs du pool MV.

Avant de définir le pool dans une bibliothèque SCSI, reportez-vous à Section 6.4.2.2, « Effet
de la modification du pool MV sur les ID d'éléments SCSI ».

1. Vérifiez qu'aucun hôte n'utilise les lecteurs que vous souhaitez ajouter au pool (reportez-
vous à la documentation relative au logiciel de gestion des hôtes).



Démarrage ou reprise de la validation de média

68

2. Dans SLC, sélectionnez Tools > Media Validation. Cliquez sur l'onglet Slot Selection.
3. Cliquez sur Refresh pour afficher la dernière configuration.
4. Placez 10 lecteurs au maximum dans le pool. Sélectionnez les emplacements de lecteur,

puis cliquez sur Add ou Remove.

Remarque:

Lors de l'ajout de lecteurs au pool MV, la bibliothèque (ou la partition concernée) est mise hors ligne.

5. Cliquez sur Apply.
6. Si vous utilisez une bibliothèque partitionnée, affectez les emplacements de lecteur

supprimés du pool MV à une partition (voir Chapitre 5, Partitionnement de la
bibliothèque )

7. Reconfigurez les applications hôtes (voir Section 6.4, « Mise à jour des hôtes après
modification du pool MV »).

Icônes de validation de média

Icône de lecteur
SLC

Signification

Emplacement de lecteur vide

L'emplacement contient soit un type de lecteur non valide, soit un type de lecteur correct
dans un état non valide

Type de lecteur correct (T10000C ou D) dans un état valide

Numéro de partition de l'emplacement de lecteur

L'emplacement de lecteur se trouve dans le pool de validation de média

10.3. Démarrage ou reprise de la validation de média
Vous ne pouvez valider qu'une cartouche à la fois par session SLC. Pour automatiser
le processus, utilisez StorageTek Tape Analytics 2.0 ou supérieur (reportez-vous à la
documentation relative à STA).

1. Dans SLC, sélectionnez Tools > Media Validation. Cliquez sur l'onglet Media
Validation.

2. Sélectionnez un lecteur. Si aucun lecteur n'est disponible, reportez-vous à Section 10.2,
« Définition du pool de validation de média ».

Remarque:

Si vous ne parvenez pas à sélectionnez un lecteur, celui-ci est peut-être de type incorrect, ou son état
est non valide.

3. Sélectionnez une cartouche dans la liste ou entrez un VOLSER dans le champ d'étiquette
de la cartouche.
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4. Sélectionnez un type de validation (les types de validation sont décrits ci-dessous).

Remarque:

Sélectionnez Complete Resume ou Complete Plus Resume pour reprendre une validation complète
à l'endroit où elle s'est arrêtée.

5. Cliquez sur Start. La validation commence si le chargement de la cartouche aboutit.

Une fois la validation terminée, la cartouche retourne dans son emplacement d'origine.
Si cet emplacement n'est pas disponible, la bibliothèque déplace la cartouche vers un
emplacement système destiné à la récupération de l'hôte.

Types de validation

Type de
validation

Description Démarrage Durée approximative par
cartouche

Basic Verify Montage et démontage pour déterminer si la
MIR est illisible ou désynchronisée

S/O 2 minutes

Standard
Verify

Lit :

- 1 000 enregistrements à partir du début de
la bande

- Le wrap contenant l'EOD, puis le contenu
de l'EOD

- Les wraps les plus à l'extérieur et les bandes
du haut et du bas pour vérifier les bords

Début de la bande 30 minutes maximum

Rebuild MIR Lit les données à la vitesse de la bande Position non
valide dans la
MIR

T10000C — 5 heures

T10000D — 9 heures

Complete BOT Lit les données à la vitesse de la bande Début de la bande T10000C — 6 heures

T10000D — 9 heures au
maximum

Complete Plus
BOT1

Vérifie le CRC de validation d'intégrité des
données pour déterminer s'il existe

Début de la bande T10000C — 6 heures pour
les ratios de compression
inférieurs à 2,5:1.

T10000D — 9 heures pour
les ratios de compression
inférieurs à 3:1.

1Un système de gestion de la décompression et Oracle Key Manager sont requis.

10.4. Arrêt d'une validation
Si l'hôte demande une cartouche en cours de validation, celle-ci prend fin. Vous pouvez
également utiliser SLC pour arrêter la validation.

1. Connectez-vous avec le compte utilisateur qui a lancé la validation.
2. Dans SLC, sélectionnez Tools > Media Validation.
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3. Sélectionnez l'onglet Media Validation.
4. Cliquez sur Stop.

Après l'arrêt de la validation, la cartouche retourne dans son emplacement d'origine.
Si cet emplacement n'est pas disponible, la bibliothèque déplace la cartouche vers un
emplacement système destiné à la récupération de l'hôte.
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11 
Audit de la bibliothèque

Un audit permet de vérifier les emplacements des cartouches et de mettre à jour de la base de
données de la bibliothèque, qui contient l'ID de volume, l'emplacement actuel et l'état vérifié
pour chaque cartouche.

La bibliothèque effectue automatiquement un audit après la fermeture d'une porte d'accès ou
son initialisation.

Remarque:

L'initiation d'un audit depuis SLC permet uniquement de mettre à jour la base de données de la
bibliothèque. Vous devez lancer l'audit depuis l'hôte pour mettre à jour la base de données de l'hôte.

• Exécution d'un audit physique de l'ensemble de la bibliothèque
• Exécution de l'audit physique d'une plage de cellules
• Exécution de l'audit vérifié d'une plage de cellules
• Signification de l'indicateur d'audit

Voir aussi

• Section 9.6, « Affichage des informations de la cartouche »

11.1. Exécution d'un audit physique de l'ensemble de la
bibliothèque

Remarque:

Vous ne pouvez pas arrêter un audit physique après son démarrage.

Pour un audit de l'ensemble de la bibliothèque, le robot vérifie tous les emplacements (de
stockage, CAP, de lecteur, réservés), met à jour la base de données des cartouches et change
l'état "verified" d'une cartouche en true.

Bien que l'audit soit un processus qui s'effectue en arrière-plan, il requiert le partage des
ressources du robot. N'exécutez pas cet audit pendant les périodes de pic d'activité. L'audit
dure environ 0,5 seconde par emplacement de cartouche.

1. Dans SLC, sélectionnez Tools > Diagnostics.
2. Sélectionnez le dossier Library dans l'arborescence du périphérique.
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3. Cliquez sur l'onglet Audit.
4. Sélectionnez Yes dans la section Entire Library (sélectionnez No dans les sections

Physical Audit et Verified Audit).
5. Cliquez sur Audit.

11.2. Exécution de l'audit physique d'une plage de cellules
Remarque:

Vous ne pouvez pas arrêter un audit physique après son démarrage.

1. Dans SLC, sélectionnez Tools > Diagnostics.
2. Sélectionnez le dossier Library dans l'arborescence du périphérique.
3. Cliquez sur l'onglet Audit.
4. Sélectionnez Yes dans la section Physical Audit (sélectionnez No dans les sections Entire

Library et Verified Audit).
5. Dans les listes déroulantes, sélectionnez l'adresse interne des emplacements de début et

de fin de l'audit.
6. Cliquez sur Audit.

11.3. Exécution de l'audit vérifié d'une plage de cellules
Un audit vérifié valide l'état d'un emplacement de cartouche dans la base de données des
cartouches. Si une adresse de cartouche présente false comme état vérifié, la bibliothèque
exécute un audit physique de cet emplacement et met à jour la base de données des
cartouches.

1. Dans SLC, sélectionnez Tools > Diagnostics.
2. Sélectionnez le dossier Library dans l'arborescence du périphérique.
3. Cliquez sur l'onglet Audit.
4. Sélectionnez Yes dans la section Verified Audit (sélectionnez No dans les sections Entire

Library et Physical Audit).
5. Dans les listes déroulantes, sélectionnez l'adresse interne des emplacements de début et

de fin de l'audit.
6. Cliquez sur Audit.

11.4. Signification de l'indicateur d'audit
SLC affiche un indicateur de progression et le message ''Audit in progress'' pour indiquer
qu'un audit est en cours d'exécution. Lorsque vous voyez cet indicateur, n'ouvrez pas la porte
d'accès de la bibliothèque. Cette action entraînerait le redémarrage de l'audit.

L'indicateur d'audit s'affiche uniquement lorsqu'un audit est initié automatiquement (la
porte d'accès à la bibliothèque a été ouverte et fermée, la bibliothèque mise sous tension ou
réinitialisée). L'indicateur n'affiche pas les audits initiés depuis SLC ou l'hôte.
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12 
Affichage des informations sur la bibliothèque et

les périphériques

SLC affiche uniquement les dernières informations sur la bibliothèque et les périphériques
enregistrées dans la base de données du contrôleur de la bibliothèque. Cliquez sur Refresh
pour mettre à jour SLC avec les dernières données de configuration.

• Affichage du statut opérationnel de la bibliothèque
• Affichage des propriétés et de la configuration de la bibliothèque
• Affichage du statut et des propriétés des périphériques
• Affichage du type du panneau opérateur local
• Indicateurs de statut de la bibliothèque et des périphériques SLC

Voir aussi

• Chapitre 13, Génération de rapports et de journaux )
• Section 9.6, « Affichage des informations de la cartouche »
• Section 9.7, « Affichage de l'état des cartouches de nettoyage »

12.1. Affichage du statut opérationnel de la bibliothèque
1. Sélectionnez Tools > System Detail, puis sélectionnez la bibliothèque dans

l'arborescence de périphériques.
2. Cliquez sur l'onglet Status.
3. Sélectionnez un onglet secondaire :

• General - affiche l'état de fonctionnement actuel de la bibliothèque. Ces valeurs sont
mises à jour à chaque opération d'un hôte, opération en arrière-plan ou opération de
l'utilisateur. Vous pouvez mettre à la bibliothèque en ligne ou hors ligne à partir de
cet onglet (reportez-vous à Section 14.1, « Mise hors ligne de la bibliothèque » et à
Section 14.2, « Mise en ligne de la bibliothèque »).

• Status Module - affiche les alertes de statut de la bibliothèque et souligne les messages
importants. Cette fonctionnalité est uniquement disponible si le service est actif
sur la bibliothèque. Voir aussi Section 15.7, « Effacement des alertes de statut de la
bibliothèque ».

• HLI - affiche le statut actuel des ports de l'interface HLI sur la bibliothèque. Ces
informations incluent le socket TCP/IP local, l'adresse IP locale, le statut de connexion,
le statut du port ainsi que les transmissions envoyées et reçues à partir de la connexion.
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• FC-SCSI - affiche le statut actuel de tous les ports de l'interface FC–SCSI hôte sur
la bibliothèque. Le numéro de port permet d'accéder à des informations détaillées.
Si la fonctionnalité Multi Port Fibre est activée sur la bibliothèque, des informations
détaillées sont affichées pour tous les ports.

12.2. Affichage des propriétés et de la configuration de la
bibliothèque

1. Sélectionnez Tools > System Detail, puis sélectionnez la bibliothèque dans
l'arborescence de périphériques.

2. Cliquez sur l'onglet Properties.
3. Sélectionnez un onglet secondaire :

• General - affiche la configuration physique, mécanique, logique et réseau de la
bibliothèque.

• Library Controller - affiche les détails du contrôleur de la bibliothèque, y compris le
numéro de série et les versions du microprogramme.

• Drive Controller - affiche les détails du contrôleur des lecteurs, y compris le numéro
de série et les versions du microprogramme.

12.3. Affichage du statut et des propriétés des périphériques

Vous pouvez afficher des informations sur les CAP, les lecteurs, les robots, Redundant
Electronics, l'alimentation électrique et la porte de sécurité. L'utilitaire de rapports de
SLC permet également d'afficher des informations sur les périphériques (reportez-vous à
Section 13.1, « Affichage de rapports sur la bibliothèque et les périphériques à l'aide de
l'utilitaire de rapports »).

1. Sélectionnez Tools > System Detail.
2. Sélectionnez le dossier du périphérique dans l'arborescence de périphériques.
3. Pour obtenir des informations plus détaillées, développez le dossier. Sélectionnez un

périphérique.
4. Sélectionnez un onglet. Reportez-vous aux informations ci-dessous correspondant au

périphérique sélectionné.

Informations sur le statut et les propriétés des périphériques

Tous les périphériques disposent des onglets d'informations système suivants.

• Onglet Status - affiche l'état de fonctionnement actuel du périphérique. À partir de
cet onglet, vous pouvez mettre un périphérique en ligne ou hors ligne (reportez-vous à
Section 14.3, « Mise hors ligne d'un périphérique » et Section 14.4, « Mise en ligne d'un
périphérique »).
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Remarque:

Pour les AEM, une position de porte "closed" signale que la porte de sécurité est complètement
rabaissée et que vous pouvez ouvrir en toute sécurité la porte d'accès à l'AEM.

• Onglet Properties - affiche les informations de configuration du périphérique, y compris
le numéro de série et les niveaux de microprogramme actuels

Informations sur les lecteurs

Seuls les lecteurs disposent des onglets d'informations système suivants.

• Display - affiche les données de réseau, le Virtual Operator Panel (VOP) pour les lecteurs
T10000 et T9840D, et le statut du voyant du lecteur.

• Drive Tray - affiche le statut actuel d'un tiroir de lecteur.

Statut du lecteur Signification

Empty Aucune cartouche n'est montée dans le lecteur.

Unloaded La cartouche est prête pour être démontée.

Ready La cartouche est chargée.

NotCommunicating La carte de contrôleur ne peut pas communiquer avec le lecteur.

rewindUnload Le lecteur effectue des opérations de rembobinage et de déchargement.

Statut de la carte Redundant Electronics

• hbca - contrôleur de la bibliothèque, emplacement A (inférieur)
• hbcb - contrôleur de la bibliothèque, emplacement B (supérieur)
• hbta - contrôleur des lecteurs, emplacement A (inférieur)
• hbtb - contrôleur des lecteurs, emplacement B (supérieur)

Statut de la carte Signification

Duplex: Software ready, switch
possible

Le contrôleur actif de la bibliothèque fonctionne correctement.

Not installed La carte n'est pas installée dans la bibliothèque.

Ok La carte de contrôleur active ou de secours fonctionne correctement.

Pre-standby: software not ready La carte de contrôleur de secours de la bibliothèque charge le code de secours et
n'est pas disponible pour un basculement automatique ou manuel pour le moment.

Standby: software ready La carte de contrôleur de secours de la bibliothèque fonctionne correctement et
peut être utilisée pour un basculement automatique ou manuel.

12.4. Affichage du type du panneau opérateur local
1. Séelectionnez Tools > Diagnostics.
2. Sélectionnez la bibliothèque dans l'arborescence de périphériques, puis cliquez sur

l'onglet OpPanel.
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Le type est indiqué au bas de l'écran. W indique un panneau Windows et DL ou OL, un
panneau Linux.

12.5. Indicateurs de statut de la bibliothèque et des
périphériques SLC

Icône SLC Définition

Normal

Avertissement

Erreur

Statut d'intégrité d'un périphérique

Ces informations se trouvent dans l'arborescence de périphériques de la page System Details
and Diagnostics.

• Normal - le périphérique de la bibliothèque fonctionne normalement
• Avertissement - le périphérique est hors ligne ou fonctionne en mode dégradé
• Erreur - le périphérique présente un dysfonctionnement

Statut de communication

Ces informations se trouvent dans la partie inférieure gauche de tous les écrans de SLC.
Indique le statut de communication entre SLC et le contrôleur de la bibliothèque.

• Normal - SLC communique normalement avec le contrôleur de la bibliothèque
• Avertissement - le serveur met plus de 10 secondes à répondre
• Erreur - le serveur met plus de 30 secondes à répondre

Après environ 30 à 60 secondes de perte de communication, l'écran de contrôle des pulsations
devient gris, puis rouge et affiche :

Heartbeat message not received from the library controller.

Fermez la session de SLC, puis reconnectez-vous afin de restaurer la communication.

Statut d'intégrité de la bibliothèque

Ces informations se trouvent dans la partie inférieure droite de tous les écrans de SLC.

• Normal - tous les périphériques de la bibliothèque fonctionnent normalement
• Avertissement - un ou plusieurs périphériques de la bibliothèque sont hors ligne ou

fonctionnent en mode dégradé
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• Erreur - un ou plusieurs périphériques de la bibliothèque présentent un dysfonctionnement

Une fois un problème de périphérique résolu, l'indicateur d'intégrité de la bibliothèque
passe à "Avertissement". L'indicateur ne passera pas sur "Normal" tant que la bibliothèque
est hors ligne. Si les conditions d'alerte de périphérique ou de statut indiquent plusieurs
problèmes, l'indicateur d'intégrité reflète le plus grave.
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13 
Génération de rapports et de journaux

• Affichage de rapports sur la bibliothèque et les périphériques à l'aide de l'utilitaire de
rapports

• Affichage desrapports de capacité active
• Affichage des rapports de partitionnement
• Génération de fichiers de diagnostic pour le support technique Oracle
• Contrôle des événements de bibliothèque

Voir aussi

• Chapitre 12, Affichage des informations sur la bibliothèque et les périphériques
• Section 9.6, « Affichage des informations de la cartouche »
• Section 9.7, « Affichage de l'état des cartouches de nettoyage »

13.1. Affichage de rapports sur la bibliothèque et les
périphériques à l'aide de l'utilitaire de rapports

Chaque sortie de rapport est une photographie statique des informations au moment de la
génération du rapport. Cliquez sur Update dans le coin supérieur droit pour actualiser les
informations.

Remarque:

L'exécution de plusieurs instances de SLC sur la même station de travail peut entraîner l'incohérence des
données des rapports. Un seul utilisateur à la fois doit générer des rapports SLC.

1. Dans SLC, sélectionnez Tools > Reports.
2. Dans l'arborescence de navigation, développez un dossier de rapports. Sélectionnez un

rapport.

Dossier Rapport Description

Événements de
lecteur

Affiche les événements et les erreurs de lecteur. Ce rapport peut contenir
jusqu'à 70 entrées.

Événements de
média de lecteur

Affiche les événements d'erreur de cartouche liés à un lecteur. Ce
rapport peut contenir jusqu'à 500 entrées.

Statistiques

Événements
généraux

Affiche un récapitulatif des événements opérationnels de la
bibliothèque.
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Dossier Rapport Description

Événements de
média

Affiche les erreurs de cartouche. Ce rapport peut contenir jusqu'à 2
000 entrées.

Journal Journal
d'événements

Affiche un journal des événements selon leur gravité (reportez-vous à
Gravité).

Tableau des
cartouches

Affiche l'emplacement, le type de média et l'étiquette des cartouches,
ainsi que des informations de statut.

Tableau de
réservation de
périphériques

Affiche des informations sur la réservation de l'ascenseur, du robot et du
PTP.

Tableau des lecteurs Affiche l'emplacement, le type et le numéro de série des lecteurs.

Récapitulatif des
CAP

Affiche l'emplacement des CAP.

Récapitulatif des
cartouches

Affiche l'emplacement, le type de média et l'étiquette de toutes les
cartouches de la bibliothèque.

Récapitulatif des
lecteurs

Affiche l'emplacement, le type et le numéro de série des lecteurs, ainsi
que des informations sur le code et les périphériques.

Informations sur la
bibliothèque

Affiche la configuration et la version du code de la bibliothèque
physique, ainsi que son état.

Récapitulatif
du statut

Récapitulatif du
robot

Affiche l'adresse et l'état du robot.

Détails du CAP/
lecteur/robot

Affiche des informations d'identification, la version du code et le statut
des périphériques.

Détails du
statut

Détails de la
bibliothèque

Affiche la configuration et la version du code de la bibliothèque
physique, ainsi que son état.

Versions matérielles Affiche le numéro de série de FRU des cartes de contrôleur, des CAP,
des robot et des PTP.

Versions

Versions logicielles Affiche la version du code des cartes de contrôleur, des CAP, des robot
et des PTP.

Journal d'audit Journal d'audit des
fonctionnalités

Affiche l'ensemble des activités d'activation de fonctionnalités pendant
la durée de vie de la bibliothèque. Pour afficher uniquement les
fichiers d'activation de matériel courants, reportez-vous à Section 3.3,
« Affichage des fichiers d'activation de matériel actuels ».

13.2. Affichage desrapports de capacité active

Le rapport sur les emplacements actifs affiche uniquement les données enregistrées dans la
base de données du contrôleur de la bibliothèque.

1. Cliquez sur Tools > Select Active Cells, puis sur l'onglet View Reports.
2. Sélectionnez un rapport :

• Cartridge Cell and Media Summary: ce rapport affiche la liste détaillée de
l'ensemble des ressources de la bibliothèque ainsi que leur état (actif ou inactif).

• Orphaned Cartridge Report : ce rapport affiche la liste détaillée de toutes les
cartouches orphelines.

3. Pour enregistrer le rapport sous forme de fichier CSV, cliquez sur Save to File.
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13.3. Affichage des rapports de partitionnement
Vous pouvez générer des rapports pour faciliter la gestion et la conception du
partitionnement.

1. Sélectionnez l'onglet Tools > Partitions > Reports.
2. Sélectionnez un rapport dans le menu :

• Cartridge Cell and Media Summary : affiche une liste de toutes les affectations de
ressources aux partitions.

• Host Connections Summary : affiche les informations relatives aux connexions hôte-
partition.

• Orphaned Cartridge Report : affiche une liste de toutes les cartouches orphelines.
• Partition Details : affiche les informations relatives à une partition sélectionnée.
• Partition Summary : affiche les informations de synthèse relatives à l'ensemble des

partitions.

13.4. Génération de fichiers de diagnostic pour le support
technique Oracle

Votre représentant du support technique Oracle peut vous demander de capturer et de
transférer le fichier de la base d'informations de gestion (MIB) ou d'instantané du journal.

13.4.1. Transfert du fichier MIB de la bibliothèque

1. Dans SLC, sélectionnez Tools > Diagnostics.
2. Sélectionnez le dossier Library dans l'arborescence du périphérique.
3. Cliquez sur l'onglet TransferFile.
4. Sélectionnez SNMP MIB. Cliquez sur Transfer File.
5. Enregistrez le fichier avec l'extension .txt.
6. Envoyez le fichier par e-mail à votre représentant du support technique Oracle.

13.4.2. Transfert du fichier d'instantané du journal de la
bibliothèque

Vous devez enregistrer le journal dans les 15 minutes qui suivent sa génération. Le fichier est
chiffré.

1. Dans SLC, sélectionnez Tools > Diagnostics.
2. Sélectionnez le dossier Library dans l'arborescence du lecteur.
3. Cliquez sur l'onglet Transfer File.
4. Sélectionnez Log Snapshot.
5. Sélectionnez All Devices ou Selected Device. Si vous choisissez Selected Device,

sélectionnez le périphérique.
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6. Cliquez sur Generate Log Snapshot on Library.
7. Cliquez sur Yes et sur OK.
8. Cliquez sur Transfer Log Snapshot To Your Computer.
9. Enregistrez le fichier sous le nom généré automatiquement.
10. Envoyez le fichier par e-mail à votre représentant du support technique Oracle.

13.5. Contrôle des événements de bibliothèque
Le contrôleur de la bibliothèque surveille en continu les opérations de la bibliothèque et
consigne tous les événements. À l'aide de l'utilitaire de contrôle de SLC, vous pouvez ouvrir
un écran de contrôle des événements pour afficher les données des événements ou les envoyer
pour traitement différé vers un fichier. Les écrans de contrôle des événements constituent des
outils utiles pour analyser les causes premières des erreurs.

• Démarrage d'un écran de contrôle d'événements
• Enregistrement des données de contrôle des événements dans un fichier
• Affichage des définitions des codes de résultat
• Types d'écran de contrôle d'événements

13.5.1. Démarrage d'un écran de contrôle d'événements

1. Dans SLC, sélectionnez Tools > Monitors.
2. Développez le dossier Permanent Monitors dans l'arborescence de navigation.
3. Sélectionnez un type d'écran de contrôle, puis cliquez sur Open.
4. Utilisez le menu Monitor pour mettre en pause, reprendre, arrêter ou effacer l'écran de

contrôle des événements. Utilisez le menu Spool File pour enregistrer l'écran de contrôle
des événements dans un fichier (reportez-vous à Section 13.5.2, « Enregistrement des
données de contrôle des événements dans un fichier »).

Remarque:

Pour que plusieurs écrans de contrôle des événements rentrent dans une fenêtre, utilisez le menu
Window situé dans le coin supérieur droit.

13.5.2. Enregistrement des données de contrôle des
événements dans un fichier

Vous devrez peut-être envoyer le fichier à votre représentant du support technique Oracle
pour qu'il vous aide à diagnostiquer les problèmes.

1. Ouvrez un écran de contrôle des événements (reportez-vous à Section 13.5.1,
« Démarrage d'un écran de contrôle d'événements »).

2. Dans la fenêtre de l'écran de contrôle des événements, sélectionnez Spool File > Start
Spooling.

3. Sélectionnez un répertoire et un nom de fichier. Cliquez sur Save.
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4. Pour arrêter l'envoi des données, sélectionnez Monitor > Stop Spooling.

13.5.3. Affichage des définitions des codes de résultat

Les codes de résultat identifient le type d'événement de bibliothèque (ils sont identiques aux
EventId de bibliothèque).

1. Dans SLC, sélectionnez Tools > Diagnostics. Sélectionnez le dossier Library dans
l'arborescence du périphérique.

2. Cliquez sur l'onglet Search.
3. Dans la liste Search Type, sélectionnez Result Code.
4. Pour rechercher un code de résultat spécifique, saisissez le code complet (les caractères

génériques et les codes partiels ne sont pas valides).

Pour établir la liste de tous les codes de résultat, sélectionnez List All.
5. Cliquez sur Search.

13.5.4. Types d'écran de contrôle d'événements

Il existe quatre types d'écran de contrôle d'événements : All, Error Warn Info, Error and
Warnings et Errors. Pour chaque type d'écran de contrôle, les événements sont consignés en
fonction de leur gravité. Par exemple, l'écran de contrôle Errors consigne uniquement les
événements d'erreur (pour obtenir une description des types d'événement, reportez-vous à
Gravité).

Chaque événement consigné dans l'écran de contrôle contient les informations suivantes :

Date/heure
Identifie le moment où l'événement s'est produit.
ID de périphérique
Identifie l'adresse de bibliothèque du périphérique correspondant à l'événement.
Utilisateur
Identifie l'utilisateur à l'origine de l'événement. La valeur est "root" pour les activités des
hôtes HLI ou SCSI.
Interface
Identifie le type d'interface du demandeur. La valeur peut être hli, scsi ou par défaut (pour
les demandes SLC ou CLI).
Activité
Identifie la commande émise, comme ''load drive''.
Identificateur de demande
Identifie toutes les demandes de l'interface hôte. Permet d'effectuer le suivi de la
séquence des activités consignées découlant de chaque demande de l'hôte.
Gravité
Identifie l'importance de l'événement. Certaines données d'événement ne sont pas
volatiles, ce qui signifie qu'elles persistent entre les cycles d'alimentation du système.
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Erreur : données non volatiles indiquant un incident qui a empêché l'exécution correcte
d'une demande (hôte ou diagnostic).

Avertissement : données non volatiles indiquant un incident qui n'a pas empêché la
bibliothèque d'exécuter les demandes (hôte du diagnostic). Un avertissement peut
identifier une perte de performances ou une condition qui pourrait entraîner des erreurs
irréversibles.

Informations : données volatiles fournissant des informations générales sur les
périphériques ou la bibliothèque (état des périphériques, périphérique ajouté, listener
enregistré, numéro de série de tiroir mis à jour, etc.). Ces informations peuvent permettre
d'établir un historique des activités pour l'événement d'avertissement ou d'erreur.

Trace : données volatiles fournissant la trace des activités de diagnostic.
Code de résultat
Identifie le type d'événement de bibliothèque (les codes de résultat sont identiques aux
EventId de bibliothèque). Pour rechercher la signification d'un code de résultat à l'aide de
SLC, reportez-vous à Section 13.5.3, « Affichage des définitions des codes de résultat »
ou au fichier SL3000_FRSxxx_JavaErrorCodes.html qui se trouve dans le package de
code du microprogramme de la bibliothèque.
Texte de résultat
Fournit des informations sur les résultats de la demande ou de l'événement.
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14 
Modification du statut en ligne/hors ligne et

réinitialisation

• Mise hors ligne de la bibliothèque
• Mise en ligne de la bibliothèque
• Mise hors ligne d'un périphérique
• Mise en ligne d'un périphérique
• Réinitialisation du panneau opérateur local
• Réinitialisation de la porte de sécurité de l'AEM
• Réinitialisation de la bibliothèque

14.1. Mise hors ligne de la bibliothèque
Remarque:

Tentez toujours de mettre la bibliothèque hors ligne à l'aide du logiciel de gestion de bandes ACSLS ou
ELS avant d'utiliser SLC.

1. Mettez hors ligne tous les lecteurs de la bibliothèque (reportez-vous à Section 14.3,
« Mise hors ligne d'un périphérique »).

2. Dans SLC, sélectionnez Tools > System Detail.
3. Sélectionnez le dossier Library dans l'arborescence du lecteur.
4. Cliquez sur l'onglet Status, puis sur l'onglet General.
5. Dans le champ Transition Request, cliquez sur Take offline.
6. Cliquez sur Apply. Avant la mise hors ligne de la bibliothèque, toutes les tâches de

bibliothèque non appliquées se terminent.
7. Attendez que le message de confirmation de mise hors ligne s'affiche. Si la bibliothèque

n'est pas mise hors ligne, vérifiez son statut (reportez-vous à Section 12.1, « Affichage du
statut opérationnel de la bibliothèque »).

Quand placer la bibliothèque hors ligne :

• Avant de mettre la bibliothèque hors tension
• Avant d'ouvrir une porte d'accès de la bibliothèque
• Lorsque la bibliothèque est inopérante et a besoin d'être entretenue
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14.2. Mise en ligne de la bibliothèque
Remarque:

Tentez toujours de mettre la bibliothèque en ligne à l'aide du logiciel de gestion de bandes ACSLS ou
ELS avant d'utiliser SLC.

1. Dans SLC, sélectionnez Tools > System Detail.
2. Sélectionnez le dossier Library dans l'arborescence du périphérique.
3. Cliquez sur l'onglet Status, puis sur l'onglet General.
4. Dans le champ Transition Request, cliquez sur Bring online.
5. Cliquez sur Apply.
6. S'il y a lieu, mettez la bibliothèque en ligne pour les hôtes (reportez-vous à la

documentation relative aux logiciels hôtes).

14.3. Mise hors ligne d'un périphérique
Remarque:

Tentez toujours de mettre un périphérique hors ligne à l'aide du logiciel de gestion de bandes ACSLS ou
ELS avant d'utiliser SLC.

1. Dans SLC, sélectionnez Tools > System Detail.
2. Développez le dossier du périphérique (CAP, robot ou lecteur). Sélectionnez le

périphérique à modifier.
3. Cliquez sur l'onglet Status.
4. Dans la liste Transition Request, sélectionnez Take Offline. Le système termine toutes

les tâches en cours pour le périphérique avant de mettre celui-ci hors ligne.

Lorsqu'un robot est mis hors ligne, il est déplacé à la fin du rail et la bibliothèque ne
peut plus l'utiliser. Si la bibliothèque utilise la fonctionnalité de robotique redondante, le
deuxième robot reçoit toutes les demandes.

5. Cliquez sur Apply.

14.4. Mise en ligne d'un périphérique
Remarque:

Les périphériques de la bibliothèque de bandes hors ligne présentant un état d'erreur ne peuvent pas
passer en ligne. Vous devez d'abord corriger l'erreur.

1. Dans SLC, sélectionnez Tools > System Detail.
2. Développez le dossier du périphérique (CAP, robot ou lecteur). Sélectionnez le

périphérique à modifier.
3. Cliquez sur l'onglet Status.
4. Dans la liste Transition Request, sélectionnez Bring Online.
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5. Cliquez sur Apply.

14.5. Réinitialisation du panneau opérateur local
Vous devrez peut-être réinitialiser le panneau opérateur local s'il se bloque ou si les
informations d'aide ne s'affichent pas. Vous pouvez effectuer la réinitialisation à partir du
panneau opérateur local ou d'une session SLC distante.

1. Dans SLC, sélectionnez Tools > Diagnostics.
2. Sélectionnez la bibliothèque dans l'arborescence de périphériques, puis cliquez sur

l'onglet OpPanel.
3. Cliquez sur le bouton Reboot Operator Panel.
4. En cas de réinitialisation à partir du panneau opérateur local, l'écran se vide. La

réinitialisation est terminée lorsque le panneau opérateur repasse en ligne.

En cas de réinitialisation à partir d'une session SLC distante, le message "Reboot
Complete" indique que la réinitialisation du panneau opérateur local est terminée.

14.6. Réinitialisation de la porte de sécurité de l'AEM
Utilisez Tools > Diagnostics pour réinitialiser la porte de sécurité de l'AEM. Vous devrez
peut-être réinitialiser la porte pour effacer les erreurs, si la porte de sécurité de l'AEM se
trouve dans un état anormal.

1. Dans SLC, sélectionnez Tools > Diagnostics.
2. Développez le dossier Safety Door puis sélectionnez la porte de sécurité de l'AEM.
3. Cliquez sur Reboot.
4. Si la porte de sécurité est en ligne, cliquez sur OK pour mettre la porte de sécurité hors

ligne.
5. Cliquez sur OK pour confirmer la réinitialisation. Le contrôleur de la bibliothèque de

bandes réinitialise la porte de sécurité. La porte de sécurité est réinitialisée, puis le robot
analyse l'AEM.

14.7. Réinitialisation de la bibliothèque
La réinitialisation de la bibliothèque implique de recharger le microprogramme à partir de la
mémoire flash et de redémarrer le contrôleur de la bibliothèque.

1. Dans SLC, sélectionnez Tools > Diagnostics.
2. Sélectionnez le dossier Library dans l'arborescence du périphérique.
3. Cliquez sur Reboot.
4. Tous les autres utilisateurs doivent être déconnectés. Cliquez sur OK.
5. Si la bibliothèque est en ligne, cliquez sur OK pour la mettre hors ligne.
6. Cliquez sur OK pour réinitialiser la bibliothèque.
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7. Cliquez sur OK pour mettre fin à la session SLC. Vous ne pouvez pas vous reconnecter à
SLC avant l'initialisation complète de la bibliothèque.
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15 
Dépannage

• Dépannage de base
• Exécution d'un autotest de la bibliothèque
• Exécution de l'autotest d'un périphérique
• Diagnostiquer les problèmes robotiques
• Détermination du statut d'une carte de contrôleur RE
• Exécution d'un basculement RE manuel à l'aide de SLC
• Effacement des alertes de statut de la bibliothèque
• Étalonnage de l'écran tactile
• Dépannage de la connectivité des hôtes

Voir aussi

• Chapitre 14, Modification du statut en ligne/hors ligne et réinitialisation
• Section 13.4, « Génération de fichiers de diagnostic pour le support technique Oracle »
• Section 13.5, « Contrôle des événements de bibliothèque »
• Chapitre 16, Maintenance de la bibliothèque

15.1. Dépannage de base
Avant d'exécuter des tests de diagnostic ou de contacter le support technique Oracle, passez
en revue les conseils de dépannage suivants.

Le voyant orange d'intervention requise (Service Required) est constamment allumé
À l'aide de SLC, vérifiez l'état de santé de la bibliothèque et des périphériques (reportez-
vous à Chapitre 12, Affichage des informations sur la bibliothèque et les périphériques).

Pour vérifier l'état d'intégrité :
1. Connectez-vous à SLC.
2. Accédez au module System Detail, Tools > System Detail.
3. Dans l'arborescence de périphériques, contrôlez les indicateurs suivants pour le

périphérique : Device Healthy ou Device Error

Vérifications supplémentaires :



Dépannage de base

90

1. Vérifiez les onglets Status (par exemple, online/offline) et Statistics (par exemple,
uptime, downtime, errors et warnings) pour plus d'informations sur l'intégrité de la
bibliothèque et des périphériques.

2. Assurez-vous que les cartouches sont correctement insérées et orientées dans leurs
emplacements de stockage.

3. Retirez tout objet ou débris étranger, s'il y a lieu.
La bibliothèque ne se met pas sous tension et SLC n'affiche aucun message
1. Vérifiez que l'interrupteur de mise sous tension de la bibliothèque est sur la position

Marche.
2. Vérifiez les branchements du cordon d'alimentation.
3. Assurez-vous que la prise de courant est sous tension.
4. Remplacez le cordon d'alimentation.
Le voyant indiquant que le CAP est ouvert (CAP Open) clignote
Ouvrez le CAP et assurez-vous que les cartouches dans les emplacements du CAP sont
correctement insérées. Fermez le CAP.
SLC n'affiche pas les données modifiées ou les informations demeurent statiques
Contrôlez l'icône SLC Heartbeat.
Le voyant orange de panne du robot (Robot Fault) ou de panne de la bibliothèque
(Library Fault) est constamment allumé
1. Vérifiez dans SLC si des messages d'erreur s'affichent.
2. Ouvrez la porte avant. Observez l'état des cartouches, de la main du robot et des

lecteurs de bande.
3. Assurez-vous que les cartouches sont correctement insérées et orientées dans leurs

emplacements de stockage.
4. Assurez-vous que l'emballage a été retiré.
5. Retirez tout objet ou débris du plancher de la bibliothèque.
6. Vérifiez le statut des lecteurs de bande.
7. Fermez la porte avant.
8. Assurez-vous que les lecteurs de bande sont correctement insérés et verrouillés à

l'avant, en tirant et en appuyant à l'arrière du tiroir de lecteurs. Tout mouvement du
tiroir indique qu'il doit être à nouveau inséré et verrouillé.

L'ordinateur client ne peut pas communiquer avec la bibliothèque ou les lecteurs de
bande
Assurez-vous que les câbles sont correctement branchés sur leurs connecteurs à l'arrière
de la bibliothèque de bandes, des lecteurs de bande et de l'ordinateur client.
La bibliothèque ne peut pas communiquer avec les lecteurs et l'état des lecteurs sur
SLC affiche "Not communicating"
Assurez-vous que les câbles sont correctement branchés sur leurs connecteurs à l'arrière
de la bibliothèque de bandes, des lecteurs et de l'ordinateur client.
Messages de nettoyage ou nettoyages de lecteur répétés ou excessifs
1. Remplacez la cartouche de nettoyage par une nouvelle.
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2. Exécutez l'autotest de la bibliothèque et notez les erreurs éventuellement signalées
concernant le lecteur.

3. Exécutez les tests de diagnostic de lecteur basés sur l'ordinateur client.

15.2. Exécution d'un autotest de la bibliothèque
Utilisez les autotests de la bibliothèque pour faciliter le diagnostic des problèmes. Les
autotests de la bibliothèque peuvent être effectués sans interruption (les cartouches sont
renvoyées dans leur emplacement initiale) ou avec interruption (les cartouches peuvent être
déplacées vers de nouveaux emplacements).

Remarque:

Avant d'exécuter un test avec interruption, mettez la bibliothèque hors ligne (voir la section Section 14.1,
« Mise hors ligne de la bibliothèque »).

1. Vérifiez que les cartouches de diagnostic des lecteurs appropriées se trouvent dans la
bibliothèque (voir la section Section 9.3, « Importation/exportation des cartouches de
nettoyage et de diagnostic »).

2. Dans SLC, sélectionnez Tools > Diagnostics, puis cliquez sur le dossier Library.
3. Cliquez sur l'onglet SelfTest.
4. Dans la liste Mode, sélectionnez le type d'autotest :

• Non-Disruptive : toutes les cartouches qui ont servi au test retournent à leur
emplacement d'origine.

• Disruptive : les cartouches peuvent être déplacées vers de nouveaux emplacements.
Avant l'exécution du test, la bibliothèque doit être mise hors ligne sur tous les hôtes.

5. Cliquez sur Run. Une fois le test terminé, les résultats s'affichent.
6. Pour les tests avec interruption, placez la bibliothèque en ligne pour reprendre les

opérations normales.

Lors d'un autotest, la bibliothèque :

• Vérifie le chemin des communications entre le contrôleur de la bibliothèque, les lecteurs,
les ascenseurs et les robots.

• Exécute des opérations get et put pour vérifiez l'intégrité des robots, des ascenseurs et
des CAP. Cela inclut les opérations get et put d'un emplacement système réservé à un
emplacement CAP ou un emplacement de stockage vide aléatoire.

• Audite l'ensemble de la bibliothèque.
• Monte et démonte des cartouches de diagnostic pour tous les lecteurs installés dans la

bibliothèque. L'autotest ne démarre pas si aucune cartouche de diagnostic n'est détectée
dans les emplacements système. Si le système détecte une cartouche de diagnostic
compatible, l'autotest est renouvelé pour chaque type de lecteur. Si le système ne détecte
pas de cartouche de diagnostic pour un type de lecteur, il n'effectue pas l'opération de
montage/démontage pour le lecteur.
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15.3. Exécution de l'autotest d'un périphérique
Utilisez les autotests des périphériques pour faciliter le diagnostic des problèmes. Un autotest
peut être exécuté sur un CAP, un robot ou un lecteur.

Remarque:

Pour qu'un autotest puisse être exécuté sur un lecteur ou un robot, des cartouches de diagnostic doivent
être disponibles dans la bibliothèque (Section 9.3, « Importation/exportation des cartouches de nettoyage
et de diagnostic »).

1. Dans SLC, sélectionnez Tools > Diagnostics.
2. Développez le dossier du périphérique (CAP, robot ou lecteur). Sélectionnez le

périphérique à tester.
3. Cliquez sur l'onglet SelfTest.
4. Dans la liste Mode, sélectionnez Non-Disruptive.
5. Cliquez sur Run. Un message apparaît à la fin du test.

15.4. Diagnostiquer les problèmes robotiques
Les actions de diagnostic peuvent permettre de contrôler ou de diagnostiquer des problèmes
robotiques en exécutant une série d'opérations "get" et "put". Le système choisit un robot pour
l'action de diagnostic en fonction des plages minimale et maximale que vous avez définies
pour les adresses cibles et de pool. Plusieurs robots peuvent être sélectionnés si la plage
d'adresses l'exige.

Une action de diagnostic réussie ne réorganise pas les cartouches dans la bibliothèque : le
système renvoie les cartouches dans leurs emplacements d'origine. Il arrive toutefois qu'à la
suite d'échecs d'action de diagnostic, les cartouches restent dans leur nouvel emplacement.

• Définition d'une action de diagnostic
• Démarrage d'une action de diagnostic
• Enregistrement d'une action de diagnostic
• Surveillance des actions de diagnostic ouvertes

15.4.1. Définition d'une action de diagnostic

Remarque:

Les actions de diagnostic exigent que les ressources des robots soient partagées. Vous ne devez pas
exécuter une action de diagnostic pendant les périodes de pic d'activité.

Vous pouvez configurer et exécuter plusieurs routines d'action de diagnostic simultanément si
les plages d'adresses cibles et de pool ne se chevauchent pas pour chaque diagnostic.

1. Séelectionnez Tools > Diagnostics. Sélectionnez le dossier Library dans l'arborescence
du périphérique.
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2. Cliquez sur l'onglet DiagMove, puis sur l'onglet Manage.
3. Cliquez sur Add dans la section Defined Sequence.
4. Définissez la plage d'adresses cibles (la zone utilisée pour les opérations "get").

a. Sélectionnez un type d'emplacement.
b. Sélectionnez les emplacements de début et de fin de la plage.

5. Cliquez sur Next.
6. Définissez la plage d'adresses sources (la zone utilisée pour fournir des cartouches ou

des emplacements vides si une adresse cible ne contient pas de cartouche ou qu'aucun
emplacement vide n'est disponible).
a. Sélectionnez un type d'emplacement.
b. Sélectionnez les emplacements de début et de fin.

7. Cliquez sur Next.
8. Attribuez un nom à l'action et indiquez un nombre d'actions (entre 1 et 5 000).
9. Sélectionnez un ordre d'accès, un type d'action et activez/désactivez le contrôle de

compatibilité effectué avant l'action (voir ci-dessous pour plus d'informations).
10. Cliquez sur Finish. La nouvelle séquence de diagnostic apparaît dans la section Defined

Sequences. Voir Section 15.4.2, « Démarrage d'une action de diagnostic ».

Une action de diagnostic est définie par les éléments
suivants :

• Plage d'adresses cibles : définit la zone utilisée pour exécuter l'opération "get" dans une
action de diagnostic. Les types d'adresse cible valides sont les emplacements de stockage,
les emplacements de stockage de CAP et de lecteur ainsi que les emplacements système,
ou tous ces emplacements.

Remarque:

Toutes les ressources situées dans la plage d'adresses cibles sont réservées. Toutefois, seul
l'emplacement auquel le robot est en train d'accéder pour une opération get/put n'est pas disponible
pour l'hôte.

• Plage d'adresses de pool : définit la zone utilisée pour fournir des cartouches ou des
emplacements vides si une adresse cible ne contient pas de cartouche ou qu'aucun
emplacement vide n'est disponible. Les adresses de pool et cible peuvent se chevaucher.

• Ordre d'accès : détermine comment le robot exécute les opérations get dans la plage
d'adresses cibles. Deux options sont disponibles :
◦ Séquentiel : le robot exécute une opération get en commençant par le premier

emplacement de la plage d'adresses cibles. Le robot continue à visiter les emplacements
de manière séquentielle sur l'ensemble de la plage jusqu'à ce qu'il ait effectué le nombre
d'actions demandé.

◦ Aléatoire : le robot choisit aléatoirement un emplacement dans la plage d'adresses
cibles afin d'obtenir une cartouche. Le robot peut également visiter plusieurs fois le
même emplacement dans la plage d'adresses cibles afin de se procurer une cartouche.
Cependant, si vous indiquez un nombre suffisant de demandes d'actions, le robot est
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assuré de visiter tout les emplacements. La routine à accès aléatoire se termine une fois
que le nombre d'actions demandé est atteint.

15.4.2. Démarrage d'une action de diagnostic

Remarque:

Vous pouvez exécutez plusieurs actions simultanément, tant que les plages d'adresses cibles et de pool
configurées pour les actions ne se chevauchent pas.

Avant d'exécuter une action de diagnostic, vous devez la définir (reportez-vous à
Section 15.4.1, « Définition d'une action de diagnostic »).

1. Séelectionnez Tools > Diagnostics. Sélectionnez le dossier Library dans l'arborescence
du périphérique.

2. Cliquez sur l'onglet DiagMove, puis sur l'onglet Manage.
3. Sélectionnez une action de diagnostic dans la section Defined Sequences. Cliquez sur

Open.
4. Sélectionnez File > Start Sequence.

15.4.3. Enregistrement d'une action de diagnostic

Vous pouvez enregistrer une action de diagnostic définie dans un fichier et l'utiliser
pour restaurer une action supprimée de la bibliothèque, ou pour la copier dans une autre
bibliothèque.

1. Séelectionnez Tools > Diagnostics. Sélectionnez le dossier Library dans l'arborescence
du périphérique.

2. Cliquez sur l'onglet DiagMove, puis sur l'onglet Manage.
3. Dans la section Defined Sequence, sélectionnez une action de diagnostic, puis cliquez sur

Save en haut de l'écran de SLC.

15.4.4. Surveillance des actions de diagnostic ouvertes

Pour démarrer une action de diagnostic, reportez-vous à Section 15.4.2, « Démarrage d'une
action de diagnostic ».

1. Séelectionnez Tools > Diagnostics. Sélectionnez le dossier Library dans l'arborescence
du périphérique.

2. Cliquez sur l'onglet DiagMove, puis sur l'onglet Monitor.
3. Chaque fenêtre d'écran de contrôle indique l'état de l'action :

Indicateurs de statut Valeurs valides

Etat de spool — indique si la sortie de l'action est enregistrée dans un fichier True, False

Etat — état d'exécution de l'action Running, pausing, paused,
stopping, stopped

Intégrité — état d'intégrité de l'action OK, warning, error
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Indicateurs de statut Valeurs valides

Actions terminées — nombre d'actions terminées Nombre

4. Le menu File de chaque fenêtre Monitor permet de démarrer/arrêter/mettre en pause la
séquence, de supprimer la fenêtre de sortie ou de démarrer/arrêter l'envoi dans un fichier
pour traitement différé.

15.5. Détermination du statut d'une carte de contrôleur RE
Le statut de la carte de contrôleur est indiqué par des voyants situés sur la carte et affiché
dans SLC (reportez-vous à Section 12.3, « Affichage du statut et des propriétés des
périphériques »). Vous pouvez utiliser le statut de la carte pour dépanner les problèmes de la
bibliothèque.

Les voyants et leur signification sont identiques pour les deux types de carte (HBC et HBT).

Voyant de la carte de
contrôleur

Définition

ACTIVE - vert La carte fonctionne en tant que carte active et exécute le code actif.

STANDBY - orange La carte fonctionne en tant que carte de secours et exécute le code de secours.

FAULT - rouge Une erreur grave est survenue au niveau de la carte.

EJECT OK - bleu Le représentant du support technique peut déclencher l'éjection d'une carte en toute
sécurité.

15.6. Exécution d'un basculement RE manuel à l'aide de SLC
Vous pouvez également déclencher un basculement à l'aide du logiciel hôte ou de la CLI
(reportez-vous à Section B.6, « Comment effectuer un basculement manuel »).

Cette procédure n'est pas disponible sur le panneau opérateur local.

1. Vérifiez que l'état de la carte indique "switch is possible" (voir la section Section 12.3,
« Affichage du statut et des propriétés des périphériques »).

2. Dans SLC, sélectionnez Tools > Diagnostics.
3. Sélectionnez le dossier Redundant Electronics.
4. Cliquez sur Apply pour lancer le processus de basculement. Si un problème survient

au niveau des cartes de contrôleur de secours de la bibliothèque et des lecteurs, vous ne
pouvez pas poursuivre le basculement.

5. S'il n'y a pas d'erreur, cliquez sur Yes.
6. Cliquez sur OK pour vous déconnecter de SLC.
7. Attendez la fin du basculement pour vous connecter de nouveau à la bibliothèque. Vous

devez spécifier l'adresse IP ou l'alias DNS du nouveau contrôleur actif.

15.7. Effacement des alertes de statut de la bibliothèque
Vous pouvez uniquement effacer les alertes identifiées par "Clearable" et seulement si le
service est actif sur la bibliothèque.
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L'effacement d'une alerte la supprime uniquement de l'affichage Status Module mais ne
résout pas la cause sous-jacente. L'état d'intégrité de la bibliothèque revient sur "Normal" s'il
n'existe aucune autre alerte de périphérique ou de statut. Si l'alerte est soumise à des mises à
jour périodiques, elle réapparaît au cycle de mise à jour suivant.

1. Sélectionnez Tools > System Detail et cliquez sur le dossier Library.
2. Cliquez sur l'onglet Status puis sur l'onglet Status Module.
3. Dans la liste Clear Alert Number, sélectionnez le numéro d'alerte à effacer, puis cliquez

sur Apply.

15.8. Étalonnage de l'écran tactile

L'alignement de l'écran tactile est étalonné en usine. Si l'écran tactile est mal aligné, vous
pouvez le réétalonner ou le réinitialiser. La méthode d'étalonnage dépend du type de panneau
opérateur (reportez-vous à Section 12.4, « Affichage du type du panneau opérateur local »).

• Si vous possédez un panneau opérateur local Linux (DL ou OL), vous pouvez le
réétalonner vous-même ou rétablir les paramètres d'usine par défaut en exécutant les
procédures ci-dessous.

• Si vous possédez un panneau opérateur local Windows (W), contactez votre représentant
du support technique Oracle.

15.8.1. Réétalonnage du panneau opérateur local

Pour un étalonnage précis, assurez-vous qu'aucun débris ne se trouve sur l'écran tactile.

1. Connectez-vous au panneau opérateur local.
2. Sélectionnez Tools > Calibrate.
3. Touchez Calibrate.
4. Une série de cibles s'affiche. Touchez légèrement du doigt ou à l'aide d'un stylet le centre

de chaque cible.
5. Pour enregistrer les nouveaux paramètres :

a. Touchez les boutons Click Me dans le laps de temps indiqué.

Si les boutons ne s'enfoncent pas, l'écran tactile n'est pas aligné correctement.
Annulez les nouveaux paramètres et reportez-vous à l'étape 6.

b. Cliquez sur OK pour enregistrer les nouveaux paramètres.
6. Pour annuler les nouveaux paramètres :

a. Laissez le délai expirer sans toucher le bouton Click Me.
b. Revenez à l'étape 4 et procédez au réétalonnage.

Le panneau opérateur local se réinitialise automatiquement après l'échec d'un deuxième
étalonnage et restaure l'alignement précédemment enregistré.
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15.8.2. Rétablissement de l'étalonnage du panneau opérateur
local configuré en usine

1. Connectez-vous au panneau opérateur local.
2. Sélectionnez Tools > Calibrate.
3. Cliquez sur Reset Calibration. Le panneau opérateur local se réinitialise.

15.9. Dépannage de la connectivité des hôtes
• Utilisez un analyseur de réseau (un périphérique ou un programme qui assure le suivi du

trafic du réseau pour la bibliothèque).
• Affichez les statistiques de port sur le commutateur ou le routeur auquel la bibliothèque est

connectée. Recherchez toute les erreurs rencontrées.
• Exécutez une trace à l'aide du logiciel de gestion de la bibliothèque qui affiche les paquets

et les transmissions entre les hôtes et la bibliothèque.
• Assurez-vous que deux hôtes distincts ne se disputent pas la gestion d'une bibliothèque ou

d'une partition.



98



Chapitre 16. Maintenance de la bibliothèque · 99

16 
Maintenance de la bibliothèque

• Mise hors tension de la bibliothèque
• Mise sous tension de la bibliothèque
• Entrée dans la bibliothèque
• Ouverture de la porte d'accès de l'AEM
• Nettoyage manuel d'un lecteur
• Montage et démontage manuels d'une cartouche

Voir aussi

• Chapitre 15, Dépannage

16.1. Mise hors tension de la bibliothèque
Mise en garde:

Si vous mettez la bibliothèque hors tension sans effectuer la procédure suivante, vous risquez
d'endommager l'équipement ou la cartouche, ou de perdre des données.

1. Assurez-vous que toutes les demandes adressées à la bibliothèques sont terminées.
2. Mettez hors ligne tous les lecteurs de la bibliothèque (reportez-vous à Section 14.3,

« Mise hors ligne d'un périphérique »).
3. Mettez la bibliothèque hors ligne (voir la section Section 14.1, « Mise hors ligne de la

bibliothèque »).
4. Ouvrez les portes arrière du module de base (et du DEM s'il y a lieu).
5. Mettez les interrupteurs d'alimentation sur la position Arrêt.
6. S'il y a lieu, mettez les disjoncteurs des PDU sur la position Arrêt.

16.2. Mise sous tension de la bibliothèque
1. Ouvrez les portes arrière du module de base (et du DEM s'il y a lieu).
2. S'il y a lieu, mettez les disjoncteurs des PDU sur la position Marche.
3. Mettez les interrupteurs d'alimentation sur la position Marche.

La bibliothèque effectue sa séquence d'initialisation. Si les portes d'accès ont été ouvertes
alors que la bibliothèque était hors tension, un audit complet est réalisé.
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16.3. Entrée dans la bibliothèque

Remarque:

L'ouverture de la porte principale entraîne un audit complet de la bibliothèque lorsque celle-ci est remise
en ligne.

1. Respectez toutes les précautions de sécurité (voir la section Section 16.3.1, « Précautions
de sécurité lors de l'entrée dans la bibliothèque »).

2. Mettez hors ligne tous les lecteurs (reportez-vous à Section 14.3, « Mise hors ligne d'un
périphérique »).

3. Mettez la bibliothèque hors ligne (voir la section Section 14.1, « Mise hors ligne de la
bibliothèque »).

4. Déverrouillez la porte.
5. Remontez le loquet de la porte et ouvrez celle-ci.
6. Avant de quitter la bibliothèque, vérifiez qu'aucun élément n'est desserré.
7. Fermez la porte et rabaissez le loquet.
8. Verrouillez la porte et conservez la clé.
9. Mettez la bibliothèque en ligne (reportez-vous à Section 16.2, « Mise sous tension de la

bibliothèque » et Section 14.2, « Mise en ligne de la bibliothèque »).

16.3.1. Précautions de sécurité lors de l'entrée dans la
bibliothèque

AVERTISSEMENT:

Pour éviter toute blessure lorsque vous êtes dans la bibliothèque, bloquez la porte d'accès en
position ouverte et conservez la clé.

• Vérifiez que la bibliothèque est hors ligne. N'entrez pas dans la bibliothèque et ne déplacez
pas les mécanismes des robots si vous avez des raisons de croire que ces derniers sont sous
tension.

• Tant que vous êtes dans la bibliothèque, laissez la porte d'accès ouverte.
• Repérez les déclencheurs mécaniques de la porte (poignées jaunes à l'intérieur des portes

d'accès). Si les portes se referment alors que vous êtes dans la bibliothèque, appuyez sur le
déclencheur mécanique pour déverrouiller et ouvrir la porte.

• Gardez en mémoire les restrictions physiques. Veillez à ne pas vous cogner contre les baies
ou à y coincer des vêtements (l'espace libre dans le passage n'est que de 0,4 mètre).

• Évitez d'endommager les composants mécaniques ou électroniques du robot si vous devez
déplacer celui-ci manuellement.
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16.4. Ouverture de la porte d'accès de l'AEM
Mise en garde:

L'ouverture de la porte d'accès de l'AEM produit les mêmes effets sur la bibliothèque que l'ouverture de
sa porte d'accès principale. Les activités de la bibliothèque sont brutalement interrompues et celle-ci est
soumise à un audit complet lorsque vous refermez la porte de l'AEM.

Cette procédure n'abaisse pas la porte de sécurité de l'AEM interne.

1. Insérez la clé de la porte d'accès à la bibliothèque dans le verrou Deadbolt Override, puis
déverrouillez la porte. Une fois en position déverrouillée, la clé ne peut pas être retirée du
verrou.

2. Levez le loquet de la porte d'accès à l'AEM, puis ouvrez la porte. NE PAS forcer
l'ouverture ou la fermeture de la porte d'accès à l'AEM.

L'alimentation des robots est coupée, tous les travaux en cours s'arrêtent et la bibliothèque
met les robots et l'AEM hors ligne.

3. Fermez la porte de l'AEM et rabaissez le loquet. NE PAS forcer l'ouverture ou la
fermeture de la porte d'accès à l'AEM.

4. Verrouillez la porte et conservez la clé.

Une fois la porte fermée, la bibliothèque et les robots sont réinitialisés, la bibliothèque
exécute un audit complet, puis elle met les AEM en ligne.

16.5. Nettoyage manuel d'un lecteur
Normalement, le nettoyage des lecteurs est géré soit par la fonction de nettoyage automatique
de la bibliothèque, soit par le logiciel de gestion de la bibliothèque hôte. Cependant, dans
certaines circonstances, un nettoyage manuel peut être nécessaire. Reportez-vous à la
documentation du fabricant du lecteur pour en savoir plus sur les conditions dans lesquelles le
nettoyage manuel est autorisé.

Mise en garde:

Il n'est pas recommandé de nettoyer un lecteur qui n'a pas besoin d'être nettoyé. Le nettoyage excessif
d'un lecteur peut en user la tête prématurément.

1. Assurez-vous que le nettoyage du lecteur est nécessaire (voir la section Section 12.3,
« Affichage du statut et des propriétés des périphériques »).

2. Affichez une liste des cartouches de nettoyage (reportez-vous à Section 9.7, « Affichage
de l'état des cartouches de nettoyage »). Vérifiez qu'il existe une cartouche de nettoyage
compatible avec le lecteur.

3. Déplacez une cartouche de nettoyage compatible d'un emplacement système vers
le lecteur à nettoyer (reportez-vous à Section 9.1, « Déplacement de cartouches
(déplacements de récupération) »).

4. Une fois l'opération de nettoyage terminée, replacez la cartouche de nettoyage dans un
emplacement système.
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16.6. Montage et démontage manuels d'une cartouche
Reportez-vous à la documentation relative au lecteur avant de monter manuellement une
cartouche.

Mise en garde:

Vos mains doivent rester à distance des composants de charge mécaniques et électroniques du lecteur.

1. Enregistrez l'ID de volume, l'emplacement de la cartouche et l'emplacement du lecteur
fournis par le logiciel de gestion de la bibliothèque.

2. Localisez le lecteur (reportez-vous à Section 13.1, « Affichage de rapports sur la
bibliothèque et les périphériques à l'aide de l'utilitaire de rapports »).

3. Localisez la cartouche (reportez-vous à Section 9.2, « Localisation d'une cartouche »).
4. Entrez dans la bibliothèque (reportez-vous à Section 16.3, « Entrée dans la

bibliothèque »).
5. Orientez la cartouche de sorte que le moteur du hub soit tourné vers le bas et l'étiquette

d'ID de volume soit face à vous.
6. Enfoncez la cartouche dans le lecteur. Ne forcez pas pour insérer la cartouche dans le

lecteur de bande. Si vous sentez une résistance lors de l'insertion de la cartouche, assurez-
vous que celle-ci est du type approprié pour le lecteur.

7. Pour démonter le lecteur, appuyez sur l'interrupteur UNLOAD à l'avant du lecteur.

Si la cartouche n'est pas éjectée, reportez-vous à la documentation relative au lecteur.
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Annexe A 
Référence de l'interface de ligne de commande

L'interface de ligne de commande (CLI) est basée sur le microprogramme. Ainsi, certaines
commandes de la CLI répertoriées ci-dessous peuvent ne pas être disponibles si vous
exécutez d'anciennes versions du microprogramme de la bibliothèque.

Les commandes de la CLI accessibles à l'administrateur sont les suivantes :

• audit
• capCommand
• cleaning
• config
• date
• drive
• hwActivation
• FibreConfig
• mediaValidation
• network
• partition
• reControl
• snmp
• ssh
• time
• traceRoute
• version
• whereAmi

A.1. audit
Cette commande exécute un audit sur l'ensemble ou une partie de la bibliothèque.

audit
Affiche l'aide de la commande audit, tout comme "help audit".
audit *
Lance un audit physique de l'ensemble de la bibliothèque. Cette commande s'exécute
immédiatement et n'affiche aucun résultat.

Exemple :
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SL3000> audit *
   requestId
   requestId 9
   Done
   Failure Count 0
   Success Count 1
COMPLETED

audit <adresse du périphérique> <adresse>
Effectue un audit physique d'une adresse unique et affiche les résultats.
• <adresse du périphérique> - indique le robot à utiliser au format bibliothèque, rail,

colonne, côté, ligne.
• <adresse> - indique l'emplacement au format bibliothèque, rail, colonne, côté, ligne.

Exemple :

SL3000> audit 1,1,0,1,0 1,1,-10,1,1
   requestId
   requestId 9
   Attributes Media Label #EMPTY..
   Object     Location    1,1,-10,1,1
   Done
   Failure Count 0
   Success Count 1
COMPLETED

audit <adresse du périphérique> <adresse de début> <adresse de fin>
Effectue un audit physique d'une plage d'adresses et affiche les résultats.
• <adresse du périphérique> - indique le robot à utiliser au format bibliothèque, rail,

colonne, côté, ligne.
• <adresse de début> <adresse de fin> - indique l'emplacement de début et de fin qui

doivent faire l'objet de l'audit au format bibliothèque, rail, colonne, côté, ligne. Seule la
ligne est différente dans l'adresse de début et l'adresse de fin.

Exemple :

SL3000> audit 1,1,0,1,0 1,1,-10,1,1 1,1,-10,1,5
   requestId
   requestId 10
   Attributes Media Label #EMPTY..
   Object     Location    1,1,-10,1,1
 
   Attributes Media Label EN34410R
   Object     Location    1,1,-10,1,5
   ...
   Done
   Failure Count 0
   Success Count 5
COMPLETED

audit multiRowScan {enable | disable | print} <adresse du périphérique>
Active ou désactive la fonctionnalité d'audit d'analyse de plusieurs lignes pour augmenter
la vitesse de l'audit.
• print - imprime l'état de l'audit d'analyse sur plusieurs lignes.
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• <adresse du périphérique> - indique le robot à utiliser au format bibliothèque, rail,
colonne, côté, ligne.

Exemple :

SL3000> audit multiRowScan print 1,1,0,1,0
   requestId
   requestId 8401
   Attributes Multi Row Scan enabled
   Object     Robot          1,1,0,1,0
   Done
   Failure Count 0
   Success Count 1
COMPLETED

A.2. capCommand
Cette commande permet de gérer les CAP.

capCommand
Affiche l'aide de la commande capCommand, tout comme "help capCommand".
capCommand forceUnreserve <adresse du périphérique>
Force la libération d'un CAP. Si des cartouches sont présentes dans le CAP, la réservation
passe à "default". Si aucune cartouche n'est présente dans le CAP, la réservation passe à
"none".
• <adresse du périphérique> - indique le CAP à libérer au format bibliothèque, rail,

colonne, côté, ligne.
capCommand {lock | unlock} <adresse du périphérique>
Verrouille ou déverrouille un CAP indiqué par adresse de périphérique.
• <adresse du périphérique> - indique le CAP à verrouiller/déverrouiller dans la

bibliothèque, au format bibliothèque, rail, colonne, côté, ligne.
capCommand resetCap {left | right | both}
Cette commande force la réinitialisation d'une ou plusieurs chaînes CAP en fonction de
l'argument fourni.

Exemple :

SL3000> capCommand resetCap right
   requestId
   requestId 17002
   Done
   Failure Count 0
   Success Count 1
COMPLETED

A.3. cleaning
Cette famille de commandes affiche et contrôle les fonctions de nettoyage et de diagnostic
relatives aux cartouches au sein de la bibliothèque. Seuls les clients disposant de la
fonctionnalité de validation de média doivent utiliser ces commandes.
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cleaning
Affiche l'aide de la commande cleaning, tout comme "help cleaning".
cleaning list {cleaning | diagnostic}
Répertorie toutes les cartouches de nettoyage ou de diagnostic dans les emplacements
système.

Exemple :

SL3000> cleaning list cleaning
   requestId
   requestId 9001
   Attributes Expired  false
      Label            CLN0080U
      Location         1,1,-12,1,13
      Max Usage Count  100
      Media Type       9840_Cleaning
      Status           ok
      Usage Count      0
Object Cartridge       cleaning

cleaning import <adresse du périphérique CAP>
Importe des cartouches de nettoyage et de diagnostic dans des emplacements système.
Une seule opération d'importation/exportation à la fois est permise. Il faut au moins
2 emplacements système vides pour que les bibliothèques SL3000 permettent
l'importation.
• <adresse du périphérique CAP> - indique le CAP à utiliser pour l'opération

d'importation au format bibliothèque, rail, colonne, côté, ligne.

Exemple :

SL3000> cleaning import 1,1,5,2,0
   requestId
   requestId 10101
   Message CAP open(ing). Place cartridges to import in CAP, then close CAP.Use
 CONTINUE cmd to proceed...
   Done
   Failure Count 0
   Success Count 0
COMPLETED

cleaning export <adresse du périphérique CAP> cleaning [select expired]
Exporte les cartouches de nettoyage. Une seule opération d'importation/exportation à la
fois est permise.
• <adresse du périphérique CAP> - indique le CAP à utiliser pour l'opération

d'exportation au format bibliothèque, rail, colonne, côté, ligne.

Exemple :

SL3000> cleaning export 1,1,5,2,0 cleaning
   requestId
   requestId 9601
   Address      1.1.-12.1.12
   Success      Cartridge Exported
   Volume Label CLN002CU
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   Message CAP open(ing). Remove cartridges, then close CAP.Use CONTINUE cmd to
 proceed...
   Done
   Failure Count 0
   Success Count 1
COMPLETED

cleaning export <adresse du périphérique CAP> <adresse de la cartouche>
Exporte une cartouche de nettoyage ou de diagnostic donnée vers le CAP indiqué. Une
seule opération d'importation/exportation à la fois est permise.
• <adresse du périphérique CAP> - indique le CAP à utiliser pour l'opération

d'exportation au format bibliothèque, rail, colonne, côté, ligne.
• <adresse de la cartouche> - indique l'emplacement de la cartouche à exporter au

format bibliothèque, rail, colonne, côté, ligne. La cartouche indiquée doit être dans un
emplacement système et doit être une cartouche de nettoyage ou de diagnostic.

Exemple :

SL3000> cleaning export 1,1,5,2,0 1,4,-12,1,12
   requestId
   requestId 9601
   Address      1.4.-12.1.12
   Success      Cartridge Exported
   Volume Label CLN002CU
   Message CAP open(ing). Remove cartridges, then close CAP.Use CONTINUE cmd to
 proceed...
   Done
   Failure Count 0
   Success Count 1
COMPLETED

cleaning threshold list
Affiche une liste de types de cartouches de nettoyage et leurs seuils d'avertissement.
Chaque cartouche de nettoyage a 4 attributs :
• Index - type de cartouche de nettoyage utilisé par la commande "cleaning threshold

set"
• Media type - type de cartouche de nettoyage utilisé
• Maximum usage count - utilisation maximale recommandée par le fabricant de la

bande
• Warning threshold value - seuil de nombre d'utilisations défini par

l'utilisateur ; lorsqu'une cartouche de nettoyage atteint ce seuil, elle passe dans un état
d'avertissement.

Exemple :

SL3000> cleaning threshold list
   requestId
   requestId 15001
   Attributes
   Object     Index               1
              Media Type          SgtUltrium1_Cleaning
              Recommend Max Usage 100
              Warning Threshold   0
   Attributes
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   Object     Index               3
              Media Type          T10000_Cleaning
              Recommend Max Usage 50
              Warning Threshold   0

cleaning threshold set <valeur du seuil d'avertissement> <numéro d'index de la
liste>
Définit une valeur de seuil d'avertissement pour un type de cartouche de nettoyage en
particulier.
• <valeur du seuil d'avertissement> - doit être un nombre entier pouvant aller jusqu'à 1

000. Une valeur de 0 indique qu'il n'y pas de seuil d'avertissement.
• <numéro d'index de la liste> - type de cartouche de nettoyage spécifié par le numéro

d'index dans la liste tabulaire de la commande ”cleaning threshold list”.

Exemple :

SL3000> cleaning threshold set 55 11
   requestId
   requestId 15101
   Attributes
   Object      Success true
   Done
COMPLETED

cleaning driveWarning set { on | off }
Définit la marque d'avertissement du nettoyage des lecteurs sur ON ou OFF.
• on - l'état d'intégrité du lecteur est paramétré de manière à ce qu'un avertissement soit

émis lorsque le lecteur nécessite un nettoyage
• off - l'état d'intégrité du lecteur n'est pas affecté si le lecteur nécessite un nettoyage

A.4. config
Cette commande affiche la configuration actuelle de la bibliothèque physique ou définit les
paramètres de configuration de la bibliothèque.

config
Affiche l'aide de la commande config, tout comme "help config".
config print
Affiche la configuration actuelle de la bibliothèque physique.
config ilc print
Affiche l'état ILC.
config ilc {enable | disable}
Active ou désactive le LAN Inter-Library Communications (ILC). Si une désactivation
est demandée, la bibliothèque doit d'abord être mise hors ligne à l'aide de la commande
"accessState offline <adresse du périphérique>".
config print
Affiche la configuration actuelle de la bibliothèque physique.
config serviceInfo print
Affiche les informations de service de la bibliothèque.
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config serviceInfo set
Définit les informations de service : contact 'NomContact' phone 'NuméroTél' streetAddr
'AdresseRue' city 'Ville' state 'Etat' country 'Pays' zip 'CodePostal' description 'données de
description'.

La longueur de chaîne maximale est de 31 caractères. Chaque chaîne doit être délimitée
par des ' ' (apostrophes) pour permettre l'utilisation d'espaces et d'autres caractères.

Exemple :

SL3000> config serviceInfo set city 'Denver' contact 'Andy' country 'USA'
 description 'Manager' phone '303 222-4444' state 'C0' streetAddr '1 tape drive'
 zip '80027'

requestId
requestId 1512402
Device serviceInfo
Success true
Done
Failure Count 0
Success Count 1
COMPLETED

A.5. date
Cette commande définit la date de la bibliothèque à l'heure Greenwich Mean Time (GMT).

date
Affiche l'aide de la commande date, tout comme "help date".
date print
Affiche la date actuelle du système.
date <MM> / <JJ> / <AAAA>
Définit la date système. Dans un complexe de bibliothèques, la bibliothèque dont le
libraryID = 1 est la bibliothèque maître. Modifie la date de la bibliothèque maître.
• <MM> - mois en deux chiffres
• <JJ> - jours en deux chiffres
• <AAAA> - année en quatre chiffres

A.6. drive
Cette commande affiche les informations sur les lecteurs ou exécute les utilitaires de lecteur
comme adiEnable, fastLoad, power et rewindUnload.

drive
Affiche l'aide de la commande drive, tout comme "help drive".
drive adiEnable {on | off | print}
Active, désactive ou affiche l'état de la détection de lecteur avec ADI. Lorsque la
commande est activée, tout lecteur supplémentaire ajouté tente la détection de lecteur
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ADI. Pour activer ADI pour tous les lecteurs compatibles ADI dans la bibliothèque, la
bibliothèque doit être réinitialisée.
drive fastLoad {on | off | print}
Active, désactive ou affiche l'état de la fonctionnalité fastLoad. FastLoad modifie le
comportement des montages de lecteur (commandes de déplacement). Lorsque fastLoad
est activé, le robot n'attend pas le chargement complet lors d'une opération "PUT" sur
un lecteur, mais passe immédiatement à l'opération suivante. Modifie également le
comportement de la commande rewindUnload, de sorte qu'elle revient immédiatement,
sans attendre le déchargement du lecteur. L'état de la commande fastLoad s'applique à
tous les lecteurs.

Remarque:

Cette commande affecte uniquement les commandes lancées dans la même session CLI que celle
dans laquelle la commande a été exécutée.

drive print { <adresse du lecteur> | * }
Affiche une synthèse des informations du lecteur : emplacement, état, statut, type, version
du microprogramme, type d'interface, utilisé, numéro de série, état (en ligne/hors ligne),
statut (ok, avertissement, erreur), et fabricant du lecteur.
• <adresse du lecteur> - indique le lecteur au format bibliothèque, rail, colonne, côté,

ligne.
• * - affiche les informations de lecteur de l'ensemble des lecteurs de la bibliothèque de

bandes.
drive search {on | off} <adresse du lecteur>
Provoque le clignotement du voyant vert sur le tiroir de lecteur. Le clignotement se
poursuit jusqu'au lancement de la commande search off. Sert à localiser le lecteur au sein
d'une bibliothèque.
• <adresse du lecteur> - indique le lecteur au format bibliothèque, rail, colonne, côté,

ligne.

A.7. hwActivation
Cette commande active certaines fonctionnalités de la bibliothèque après l'achat d'un permis
d'activation de matériel.

Remarque:

La bibliothèque doit être réinitialisée en cas de désactivation de openVolser, dualRobot, du
partitionnement ou de Redundant Electronics.

hwActivation
Affiche l'aide de la commande hwActivation, tout comme "help hwActivation".
hwActivation addLicenseFile
Ajoute un fichier de licence. Le fichier de licence doit être nommé SL3000_license
_config.dsf. Le chemin d'accès complet est /usr/local/SL3000_license_config.dsf.
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hwActivation deleteFile <index>
Efface le fichier de fonctionnalité installé indiqué.
• <index> - précise le numéro de fichier à supprimer, tel qu'indiqué dans la base de

données du module hwActivation du contrôleur de la bibliothèque. Voir hwActivation
listFiles.

hwActivation listFiles
Répertorie les fichiers de fonctionnalité installés dans la base de données du module
hwActivation du contrôleur de la bibliothèque.
hwActivation print
Répertorie toutes les fonctionnalités activées dans la base de données du module
hwActivation du contrôleur de la bibliothèque.

A.8. FibreConfig
Cette commande obtient et définit les configurations Fibre Channel à ports multiples pour
le contrôleur de bibliothèque. Les contrôles et affichages Fibre Channel associés à cette
commande ne doivent pas être confondus avec les configurations Fibre Channel destinées aux
lecteurs de bande. Cette commande est disponible sur les bibliothèques SL3000 uniquement.

fibreConfig print
Affiche l'état des connexions Fibre Channel de la bibliothèque.
fibreConfig ports print
Affiche le nombre de configurations Fibre Channel à plusieurs ports activées.
fibreConfig config <hard|soft> <loopId> <portNum>
Définit l'adressage logiciel ou matériel, et définit l'ID de boucle de fibre si l'adressage
matériel est activé pour la valeur fournie. L'ID de boucle est défini sur 126 si l'adressage
matériel est désactivé. Cette configuration s'effectue sur chaque port.
fibreConfig ports set <numéro à activer>
Définit le nombre de configurations Fibre Channel à plusieurs ports à activer. La limite
des licences MultiFibrePort et le matériel physique déterminent le nombre maximum de
ports à activer.

A.9. mediaValidation
Cette commande gère la fonctionnalité de validation de média.

mediaValidation
Affiche l'aide de la commande mediaValidation, tout comme "help mediaValidation".
mediaValidation print { all | poolOnly } { * | @ }
Affiche les emplacements des lecteurs du pool de validation de média.
• all - répertorie tous les emplacements de lecteur
• poolOnly - répertorie uniquement les emplacements de lecteur dans le pool de

validation de média
• * - affiche uniquement les informations de la bibliothèque cible
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• @ - affiche les informations de l'ensemble du complexe
mediaValidation reservation clear <adresse du lecteur>
Supprime la réservation de validation de média pour le lecteur indiqué.
• <adresse du lecteur> - indique le lecteur au format bibliothèque, rail, colonne, côté,

ligne.
mediaValidation stopValidation <adresse du lecteur>
Interrompt une validation en cours. La cartouche est renvoyée vers l'emplacement de
stockage source.
• <adresse du lecteur> - indique le lecteur au format bibliothèque, rail, colonne, côté,

ligne.

A.10. network
La commande est utilisée pour configurer et afficher la configuration réseau de la carte de
contrôleur.

network clone [adresse IP du Port 2B] [adresse IP du Port 2A]
Utilisé pour la configuration de Redundant Electronics. Copie toutes les configurations de
port, de routage et de stratégie IP vers le HBC du côté B. Les adresses IP sont remplacées
par celles indiquées dans la commande pour le côté B. Si aucune adresse IP de port n'est
indiquée, elles ne sont pas définies sur le côté B.
network config print
Affiche le côté cible de la bibliothèque (A ou B) défini pour les commandes réseau.
network config side {a | b}
Définit le côté cible de la bibliothèque (A ou B) pour les commandes réseau.
network config clear
Efface la configuration réseau. Cette commande met un terme à la connectivité réseau. La
reconfiguration nécessite l'accès au port série sur la carte HBC.
network export
Exporte le fichier de configuration réseau de la bibliothèque (.lnc) et génère un script
de configuration réseau (.scr). Cette commande peut être uniquement être utilisée
lorsqu'aucune configuration réseau n'a été définie au préalable.
network gateway <adresse IP>
Définit la passerelle par défaut du réseau externe.
network gateway clear
Efface la passerelle par défaut du réseau externe.
network import
Importe le fichier de configuration réseau de la bibliothèque (.lnc).
network ip <adresse IP>
Définit l'adresse IP du port 2B.
network ip address add <adresse IP> dev {2A | 2B}
Définit l'adresse IP d'un port en particulier.
network ip address del <adresse IP> dev {2A | 2B}
Supprime l'adresse IP d'un port.
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network ip address show [dev {2A | 2B}]
Affiche les informations d'adresse actuelles pour un port en particulier ou pour les deux
ports si dev n'est pas précisé.
network ip link set dev {2A | 2B} {up | down}
Définit l'état d'opération d'un port, qui contrôle si un port peut envoyer et recevoir du
trafic Ethernet.
• up - met les ports en ligne
• down - met les ports hors ligne
network ip policy {enable | disable} dev {2A | 2B}
Active ou désactive le routage basé sur stratégie pour le périphérique 2A ou 2B.
network ip policy status
Affiche l'état du routage par stratégie pour les périphériques 2A et 2B.
network ip policy route {add | del} <adresse IP> dev {2A | 2B}
Ajoute ou supprime une route statique à la stratégie du périphérique 2A ou 2B.
network ip policy route {add | del} <adresse IP> via <adresse IP de la passerelle>
dev {2A | 2B}
Ajoute ou supprime une route statique à la stratégie du périphérique 2A ou 2B via la
passerelle.
network ip policy route show [ dev {2A | 2B} ]
Affiche les informations de route basée sur stratégie pour le périphérique 2A ou 2B.
network ip route add default via <adresse IP>
Définit l'adresse IP de routage de passerelle par défaut.
network ip route delete default
Supprime l'adresse IP de routage de passerelle par défaut.
network ip route {add | del} <adresse IP [/netmask] > dev {1A | 1B | 2A | 2B}
Ajoute ou supprime une adresse de routage IP (Internet Protocol) statique pour un hôte
spécifié. Cette commande permet également à un utilisateur de définir le masque de
réseau pour un port en particulier.

Exemple :

SL3000>network ip route add 129.80.81.59/24 dev 1B
COMPLETED

network ip route {add | del} <adresse IP [/netmask] > via <adresse IP de la
passerelle>
Ajoute ou supprime une route statique à une adresse de passerelle IP du réseau de
destination.
network ip route show [dev {2A | 2B}]
Affiche les informations de table de routage actuelles ou les informations de table de
routage pour un port en particulier.
network name <chaîne de nom d'hôte>
Définit le nom d'hôte.
network netmask <masque de réseau>
Définit le masque de réseau du réseau externe au format xxx.xxx.xxx.xxx.
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network print
Affiche la configuration réseau actuelle pour les ports Ethernet externes (2A et 2B).

A.11. partition
Cette commande affiche l'état actuel ou désactive la fonctionnalité de partitionnement.

partition
Affiche l'aide de la commande partition, tout comme "help partition".
partition autoClean set { * | <ID de la partition> }
Définit le nettoyage automatique dans la partition spécifiée (0 correspond à une
bibliothèque non partitionnée).
partition attribute status { * | <ID de la partition> }
Affiche les attributs d'état d'une partition unique spécifiée ou de l'ensemble des partitions.
partition fastLoad set '<ID partition-mode, ID partition-mode, ...>'
Définit le mode fastLoad pour une ou plusieurs partitions spécifiées. Actuellement,
les seuls modes valides sont true ou false. Cette commande est disponible sur les
bibliothèques SL3000 uniquement.

Exemple :

SL3000> partition fastload set '1-true,3-false'
   requestId
   requestId 40901
   Attributes Success true
   Object
   Done
   Failure Count 0
   Success Count 2
COMPLETED

partition getCapacity
Affiche les valeurs de capacité d'une bibliothèque ou d'une partition définie.
partition get state <ID de la partition>
Affiche l'état actuel des partitions spécifiées. Cette commande est disponible sur les
bibliothèques SL3000 uniquement
partition predefined file <numéro de fichier de partition>
Utilise un fichier texte de partition prédéfini pour définir la configuration de la partition
de la bibliothèque. Chaque nom de fichier est composé du mot ”partition” et d'une valeur
numérique, par exemple ”2” et une extension ”.txt”. Les fichiers prédéfinis se trouvent ci-
dessous.

partition1.txt – Base non partitionnée avec une interface HLI.
partition2.txt – Base non partitionnée avec une interface SCSI.
partition3.txt – Base à une partition avec une interface HLI.
partition4.txt – Base à une partition avec une interface SCSI.
partition5.txt – Base à deux partitions avec une interface HLI.
partition6.txt – Base à deux partitions avec une interface SCSI.
partition7.txt – Base à deux partitions avec les partitions HLI et SCSI du DEM.
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partition8.txt – Base à deux partitions avec l'interface SCSI du DEM.
partition9.txt – Interface HLI à plusieurs partitions (bandes).
partition10.txt – Interface SCSI à plusieurs partitions (bandes).
partition11.txt – Interface HLI à plusieurs partitions (aléatoire).
partition12.txt – Interface SCSI à plusieurs partitions (aléatoire).

Exemple :

SL3000> partition predefined file 5
   requestId
   requestId 7601
   Done
   Failure Count 0
   Success Count 1
COMPLETED

partition setCapacity { <ID de la partition> , <capacité> }
Définit la capacité pour la partition désignée. La capacité des partitions existantes qui ne
sont pas répertoriées par cette commande est définie sur zéro.

Exemple :

SL3000> partition setCapacity 1,200 2,50 3,600
   requestId 7601
   Done
   Failure Count 0
   Success Count 1
COMPLETED

partition setNonPartitionedHLI
Définit la partition sur hli0. Si des lecteurs sont présents dans le pool de validation de
média, ceux-ci doivent être retirés au préalable. Si cette commande est exécutée dans un
complexe, toutes les bibliothèques sont définies sur hli0.
partition set state {online | offline} <ID de la partition>
Définit l'état actuel (en ligne/hors ligne) de la partition spécifiée.
partition set {hli | scsi}
Définit le type d'interface pour l'ensemble de la bibliothèque. Disponible sur les
bibliothèques SL3000 uniquement.
partition status
Affiche l'état de partitionnement actuel.

A.12. reControl
Cette commande contrôle/active Redundant Electronics et extrait les états de Redundant
Electronics du contrôleur de la bibliothèque.

reControl
Affiche l'aide de la commande reControl, tout comme "help reControl".
reControl status [ <adresse de la bibliothèque> | * ]
Extrait l'état Redundant Electronics.
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• <adresse de la bibliothèque> - indique la bibliothèque au format bibliothèque, rail,
colonne, côté, ligne. Par exemple : 2, 0, 0, 0, 0.

• * - extrait l'état de toutes les bibliothèques d'un complexe

A.13. snmp
Cette commande configure le protocole SNMP (Simple Network Management Protocol).
Pour des informations détaillées, reportez-vous au SNMP Reference Guide  sur OTN.

A.14. ssh
Cette commande contrôle la configuration pour le démon/serveur SSH situé sur le HBC.
Il s'agit de l'utilitaire de protocole utilisé par SLC et d'autres applications diverses pour se
connecter au contrôleur de la bibliothèque.

ssh print
Affiche les paramètres du protocole de démon SSH actuels.
ssh set version1and2
Définit la restriction de protocole de démon SSH sur v1 et v2 (il s'agit du paramétrage par
défaut). Le serveur SSH redémarre.
ssh set version2
Définit la restriction de protocole de démon SSH uniquement sur v2.

A.15. time
Cette commande définit l'heure de la bibliothèque au format d'heure militaire.

time
Affiche l'aide de la commande time, tout comme "help time".
time print
Affiche l'heure actuelle du système.
time <HH> : <MM>
Définit l'heure système. La résolution temporelle est d'une minute. Dans un complexe
de bibliothèques, la bibliothèque dont le libraryID = 1 est la bibliothèque maître. Il faut
modifier l'heure sur la bibliothèque maître.
• <HH> - heures en deux chiffres
• <MM> - minutes en deux chiffres
time <HH> : <MM> : <SS>
Définit l'heure système. La résolution temporelle est d'une seconde. Dans un complexe
de bibliothèques, la bibliothèque dont le libraryID = 1 est la bibliothèque maître. Il faut
modifier l'heure sur la bibliothèque maître.
• <HH> - heures en deux chiffres
• <MM> - minutes en deux chiffres
• <SS> - secondes en deux chiffres
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A.16. traceRoute
Cette commande trace la route réseau vers une adresse IP spécifiée.

traceRoute <adresse IP>
Exécute la commande traceRoute vers l'adresse IP indiquée.

A.17. version
Cette commande affiche la version client et les versions des logiciels pour le(s)
périphérique(s) indiqué(s).

version print [ <adresse du périphérique> | *]
Affiche la version logicielle du code d'un périphérique ou de l'ensemble des
périphériques.
• <adresse du périphérique> - indique le périphérique au format bibliothèque, rail,

colonne, côté, ligne.

A.18. whereAmi
Cette commande affiche les informations système et de carte logique relatives à la
bibliothèque et à la carte sur lesquelles la commande Redundant Electronics est en cours
d'exécution.

whereAmi
Affiche les informations relatives à l'endroit où la commande est exécutée.

Exemple :

SL3000> whereAmI
   Host Name: gulibtst02b
   Port 2B IP Address: 172.20.151.24
   Library Type: SL3000
   HBC side: B
   Active side: B
COMPLETED
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Annexe B 
Présentation de Redundant Electronics

La fonctionnalité Redundant Electronics facultative fournit une protection par basculement
pour le contrôleur de la bibliothèque. Si le contrôleur de la bibliothèque ou le contrôleur des
lecteurs présentent des erreurs, les opérations peuvent être basculées sur le contrôleur de
secours. Le contrôleur de la bibliothèque et le contrôleur des lecteurs installés dans le même
panier à carte sont toujours basculés simultanément.

La fonction RE permet à un représentant du support technique Oracle de remplacer une carte
défectueuse lorsque la bibliothèque est en ligne et réduit au minimum les interruptions des
opérations lors de la mise à niveau des microprogrammes.

Remarque:

Toute référence à la carte HBC est également valable pour la carte HBCR.

• Conditions requises pour Redundant Electronics
• Exemples de configuration de Redundant Electronics.
• Basculement en cas d'incident
• Facteurs qui interdisent le basculement RE
• Facteurs qui déclenchent un basculement automatique
• Comment effectuer un basculement manuel
• Mise à niveau des microprogrammes lors de l'utilisation de RE

Voir aussi

• Section 6.5, « Mise à jour du logiciel de gestion des hôtes HLI pour RE »
• Section 15.5, « Détermination du statut d'une carte de contrôleur RE »
• Section 15.6, « Exécution d'un basculement RE manuel à l'aide de SLC »

B.1. Conditions requises pour Redundant Electronics
• Deux cartes de contrôleur de bibliothèque (HBC)
• Deux cartes de contrôleur des lecteurs (HBT)

Remarque:

Pour que le mode ADI puisse être activé, les deux cartes doivent être des cartes HBT à grande quantité
de mémoire.

Si la validation de média est utilisée, Oracle recommande que les deux cartes HBT soient à grande
quantité de mémoire.
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• Microprogramme SL3000 version FRS_3.0 et SLC version 5.00 au minimum
• Fichier d'activation de matériel (voir Chapitre 3, Activation des fonctionnalités facultatives

)
• Hôte HLI avec hôte TCP/IP ou FC-SCSI utilisant ACSLS (voir Section 6.5, « Mise à jour

du logiciel de gestion des hôtes HLI pour RE »). La fonction RE n'est pas disponible pour
les hôtes qui utilisent une interface FC‐SCSI native.

B.2. Exemples de configuration de Redundant Electronics.
Chaque carte de contrôleur de la bibliothèque requiert sa propre adresse IP unique. Si
la fonctionnalité TCP/IP double est active dans la bibliothèque, chaque carte requiert 2
adresses IP uniques : une pour le port principal 2B et une pour le port secondaire 2A. Ainsi,
une bibliothèque dotée des fonctionnalités Redundant Electronics et TCP/IP double requiert
quatre adresses IP uniques.

Sur chaque carte de contrôleur, les ports 2A et 2B doivent se trouver dans deux domaines
de diffusion distincts. Cependant, le port 2B sur la carte active et le port 2B sur la carte de
secours peuvent se trouver sur le même domaine de diffusion. Cette règle est également
valable pour les ports 2A.

Figure B.1. Exemples de configuration de Redundant Electronics.

Pour plus d'informations sur la fonctionnalité TCP/IP double, reportez-vous à Annexe C,
Présentation du TCP/IP.

B.3. Basculement en cas d'incident
Lors d'un basculement, le contrôleur actif de la bibliothèque tente de terminer toutes les
tâches en cours et copie la base de données des cartouches sur la carte de contrôleur de
secours. Si la base de données ne peut pas être copiée (généralement uniquement en cas
de panne soudaine), vous devez exécuter un audit après le basculement (reportez-vous à
Chapitre 11, Audit de la bibliothèque ). La bibliothèque replace les cartouches en transit dans
leurs emplacements initiaux. Les cartouches qui ne peuvent pas être renvoyées dans leur
emplacement initial sont placées dans un emplacement système pour la récupération de l'hôte
(voir la documentation sur le logiciel hôte).
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Une fois toutes les tâches en cours terminées ou expirées, les cartes changent de rôle. Le
contrôleur de secours devient actif et le contrôleur précédemment actif devient le contrôleur
de secours. Si le contrôleur de secours précédemment actif ne peut pas activer le logiciel de
secours, le contrôleur présente un état d'erreur.

Impact d'un basculement sur les utilisateurs

• Les utilisateurs du logiciel de gestion de bandes (Symantec ou Virtual Storage Manager) ne
remarquent pas d'interruption.

• Les applications de l'hôte HLI placent les demandes en file d'attente au cours du processus
de basculement, et ces dernières sont traitées une fois le basculement terminé. Pour
ACSLS, seules les demandes de montage et de démontage sont affectées (reportez-vous à
la documentation sur le logiciel hôte).

• Les connexions de SLC et de la CLI sont interrompues. Vous devez rétablir les connexions
à la bibliothèque à l'aide de l'adresse IP ou de l'alias DNS du contrôleur de bibliothèque qui
vient d'être activé (le contrôleur de secours précédent).

B.4. Facteurs qui interdisent le basculement RE
• Le contrôleur de secours de la bibliothèque ou des lecteurs présente un état d'erreur ou

d'éjection.
• Le code de secours n'est pas en cours d'exécution sur les cartes de contrôleur de secours de

la bibliothèque ou des lecteurs.
• Un microprogramme est en cours de téléchargement ou une carte est en cours

d'initialisation.

B.5. Facteurs qui déclenchent un basculement automatique
Un basculement automatique peut être déclenché par le contrôleur actif ou le contrôleur de
secours de la bibliothèque.

Le contrôleur actif de la bibliothèque lance un basculement automatique :

• Lorsque la carte de contrôleur des lecteurs qui lui est associée n'est pas installée ou qu'elle
ne communique pas.

• Lorsqu'il détecte une erreur logicielle interne irrémédiable.

Le contrôleur de secours de la bibliothèque lance un basculement automatique si le contrôleur
actif ne fonctionne pas normalement.

B.6. Comment effectuer un basculement manuel
Remarque:

Avant de lancer un basculement manuel, vous devez vérifier que les contrôleurs de secours de la
bibliothèque et des lecteurs fonctionnent correctement (voir Section 12.3, « Affichage du statut et des
propriétés des périphériques »).
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• Gestion des bandes de l'hôte (ACSLS ou ELS) : vous pouvez déclencher le basculement
depuis le contrôleur actif ou de secours de la bibliothèque. Le contrôleur de secours de la
bibliothèque accepte uniquement les demandes HLI set host path group et force
switchover.

• SLC : le basculement est uniquement lancé depuis le contrôleur actif de la bibliothèque
(voir la section Section 15.6, « Exécution d'un basculement RE manuel à l'aide de SLC »).

• CLI : le basculement peut être lancé depuis le contrôleur actif ou le contrôleur de secours
de la bibliothèque. Cette fonction n'est disponible que pour les représentants du support
technique Oracle.

Vous pouvez souhaiter procéder à un basculement manuel après l'installation initiale des
cartes de secours, après la mise à niveau d'un microprogramme, ou régulièrement pour
vérifier le fonctionnement correct de la fonction de basculement. Il est impossible de basculer
manuellement les contrôleurs de la bibliothèque sans basculer également les contrôleurs des
lecteurs : les contrôleurs sont toujours basculés par paires.

B.7. Mise à niveau des microprogrammes lors de l'utilisation de
RE

Pour les bibliothèques dotées de la fonctionnalité Redundant Electronics, les mises à niveau
du microprogramme perturbent très peu le fonctionnement normal. Vous pouvez charger
et décompresser le nouveau code en même temps sur les cartes de contrôleur actives et de
secours et sur tous les périphériques. Le code est ensuite activé, et les contrôleurs actif et
de secours ainsi que la plupart des périphériques sont réinitialisés. Dans la plupart des cas,
l'initialisation du Robot est évitée.

Le fonctionnement de la bibliothèque n'est pas interrompu par le chargement, la
décompression et l'activation du code, tant que la bibliothèque n'est pas réinitialisée. Lors du
processus de réinitialisation (qui prend environ 10 minutes), les applications de l'hôte HLI
(ACSLS et ELS) mettent en file d'attente toutes les demandes de montage et de démontage.
Une fois la réinitialisation terminée, les demandes en attente sont soumises au contrôleur de
la bibliothèque.

Reportez-vous à Annexe D, Mise à niveau du microprogramme de la bibliothèque pour plus
d'informations sur le téléchargement et l'activation du microprogramme.
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Annexe C 
Présentation du TCP/IP

La fonctionnalité TCP/IP double fournit deux connexions distinctes entre l'hôte de la
bibliothèque (ACSLS ou ELS) et la carte de contrôleur HBC/HBCR à l'aide du port principal
2B et du port secondaire 2A. Cette fonctionnalité évite la perte de connectivité entre la
bibliothèque et l'hôte en évitant automatiquement l'échec d'un chemin de communication.

• Conditions minimales requises pour la fonctionnalité TCP/IP double
• Utilisation d'un réseau partagé
• Exemples de configuration TCP/IP

Voir aussi

• Section 6.6, « Configuration de la fonctionnalité TCP/IP double »
• Documentation ACSLS ou ELS.

C.1. Conditions minimales requises pour la fonctionnalité TCP/
IP double

• ACSLS 7.1 avec PUT0701 pour Solaris ou AIX. Oracle recommande ACSLS 8.1 ou
version supérieure.

• NCS 6.2 avec les PTF suivants pour HSC/MVS/VM: SOS620 L1H168G, SMS620
L1H168F et MSP: MSP PTF LF620DL.

• Le port du commutateur ou du routeur doit être configuré pour négocier automatiquement.
Les ports SL3000 sont configurés pour négocier automatiquement par défaut et prennent en
charge des vitesses comprises entre 10 et 100 Mbits/s.

C.2. Utilisation d'un réseau partagé
Remarque:

Oracle recommande l'utilisation d'un réseau privé pour un throughput maximal, une contention des
ressources minimale et une sécurité accrue.

Si vous devez utiliser un réseau partagé :

• Connecter directement la bibliothèque à un commutateur ou un routeur qui filtre le trafic
(de diffusion) non dirigé.

• Placer la bibliothèque sur son propre sous-réseau. Cela peut protéger la bibliothèque de la
réception de messages de diffusion.
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• Utiliser un commutateur ou un routeur géré pour :
◦ Définir des priorités sur les ports afin d'accorder une priorité plus élevée à l'hôte et à la

bibliothèque.
◦ Fournir une bande passante dédiée entre l'hôte et la bibliothèque.
◦ Créer un VLAN entre l'hôte et la bibliothèque.

• Utiliser un réseau privé virtuel (VPN) pour isoler le trafic entre l'hôte et la bibliothèque
d'autres interférences, telles que les diffusions insignifiantes.

Problèmes de diffusions de réseau sur un réseau partagé
Les diffusions envoyées à tous les noeuds de réseau peuvent être dirigées vers la bibliothèque.
Lorsque la bibliothèque reçoit ces diffusions insignifiantes, elle ne peut pas traiter
efficacement les demandes. Par conséquent, l'hôte peut déterminer que la connexion TCP/IP à
la bibliothèque a été perdue.

Le trafic réseau important peut également submerger le contrôleur Ethernet sur la carte HBC/
HBCR. Par conséquent, le contrôleur est sans cesse réinitialisé.

Inondations ARP sur un réseau partagé
Le processeur de la bibliothèque SL3000 peut être submergé par des inondations de
diffusions ARP (Address Resolution Protocol). Nous vous recommandons de connecter la
bibliothèque derrière un commutateur ou un routeur.

C.3. Exemples de configuration TCP/IP
• Exemple de la fonctionnalité TCP/IP double ACSLS et de sous-réseaux partagés
• Exemple de fonctionnalité TCP/IP double d'ACSLS via un réseau public
• Exemple de fonctionnalité TCP/IP double d'ACSLS High Availability
• Voir aussi la section Section B.2, « Exemples de configuration de Redundant Electronics. »

pour consulter un exemple de RE et de TCP/IP double

C.3.1. Exemple de la fonctionnalité TCP/IP double ACSLS et
de sous-réseaux partagés
Dans cet exemple, le serveur ACSLS et la bibliothèque partagent deux sous-réseaux distincts.
La bibliothèque SL3000 utilise une relation bi-univoque avec les interfaces réseau sur le
serveur ACSLS. La carte d'interface réseau sur le sous-réseau 192.168.0/23 se connecte au
port 2B tandis que la carte d'interface réseau sur le sous-réseau 192.168.1/23 se connecte au
port 2A.

C.3.1.1. Routage
Vous pouvez forcer une relation à l'aide des commandes route UNIX. Pour plus
d'informations, reportez-vous au ACSLS Administrator's Guide et au Manuel d'installation
SL3000 .
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Figure C.1. Fonctionnalité TCP/IP double d'ACSLS avec des sous-réseaux
partagés

C.3.2. Exemple de fonctionnalité TCP/IP double d'ACSLS via
un réseau public

Dans cet exemple, le serveur ACSLS contient deux interfaces réseau qui se trouvent sur deux
sous-réseaux distincts. Les deux interfaces passent par un réseau public et dans deux sous-
réseaux différents avant de se connecter à la bibliothèque SL3000. Cette configuration utilise
les mêmes commandes que le premier exemple.

Figure C.2. Fonctionnalité TCP/IP double d'ACSLS

C.3.3. Exemple de fonctionnalité TCP/IP double d'ACSLS High
Availability

L'exemple suivant est un environnement ACSLS High Availability (HA) qui requiert la
fonctionnalité TCP/IP double. Le but de l'environnement High Availability (HA) est de
disposer de deux serveurs ACSLS, l'un actif et l'autre de secours. Dans cette configuration,
deux serveurs ACSLS connectent six interfaces réseau (trois sur chaque serveur) à deux sous-
réseaux distincts. Un troisième sous-réseau se connecte à deux serveurs ACSLS via un réseau
public.

Pour plus d'informations sur les fonctionnalités ACSLS HA et TCP/IP double, reportez-vous
au ACSLS Administrator's Guide.

C.3.3.1. Routage

Vous devez séparer les interfaces réseau de la bibliothèque SL3000 sur deux sous-réseaux
différents lorsque vous utilisez ACSLS HA. Les deux serveurs ACSLS utilisent des interfaces
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réseau différentes, c'est pourquoi vous devez ajouter des entrées de routage personnalisées
aux deux serveurs ACSLS HA. Ajoutez les adresses IP des deux serveurs à la configuration
de la bibliothèque SL3000.

C.3.3.2. Tables de routage

Ajoutez des entrées personnalisées aux tables de routage sur le serveur ACSLS. Toutefois,
toutes les entrées de table de routage personnalisées sont perdues après la réinitialisation du
serveur ACSLS. Pour conserver les entrées de table de routage personnalisées, créez des
scripts pour ajouter les routes personnalisées. Placez les scripts dans la structure de répertoire
rc pour une exécution automatique lors de l'initialisation.

Pour plus d'informations, reportez-vous au ACSLS Administrator's Guide.

Figure C.3. Fonctionnalité TCP/IP double d'ACSLS High Availability

C.3.4. Exemple ELS/HSC et TCP/IP double

L'exemple suivant présente une configuration recommandée pour les systèmes de mainframe
utilisant la fonctionnalité TCP/IP double. L'hôte du mainframe contient deux interfaces
réseau qui se trouvent sur deux sous-réseaux distincts. Chaque connexion transite par un
réseau public puis se connecte à deux sous-réseaux différents avant d'atteindre la bibliothèque
SL3000.

Pour plus d'informations, reportez-vous à la documentation d'ELS.
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Figure C.4. Fonctionnalité TCP/IP double d'ELS/HSC
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Annexe D 
Mise à niveau du microprogramme de la

bibliothèque

Contactez le support Oracle pour mettre à niveau le microprogramme. Seuls les représentants
du service Oracle doivent installer le nouveau microprogramme de la bibliothèque.

Remarque:

Vous ne pouvez pas télécharger ou activer le code depuis le panneau opérateur local.

Le microprogramme de la bibliothèque ne contient pas de mises à niveau de code du lecteur
(voir la documentation spécifique au lecteur).

• Téléchargement du code dans le contrôleur de la bibliothèque
• Activation du code sur le contrôleur de la bibliothèque

D.1. Téléchargement du code dans le contrôleur de la
bibliothèque

1. Localisez le package de mise à niveau du microprogramme (fichier .jar) à l'adresse :

http://edelivery.oracle.com

2. Téléchargez le code sur votre système.
3. Dans SLC, sélectionnez Tools > Diagnostics, puis sélectionnez le dossier Library dans

l'arborescence du périphérique.
4. Cliquez sur l'onglet Load Code.
5. Localisez le package du microprogramme.
6. Vérifiez le contenu et le nom du fichier. Cliquez sur Load.

Le processus de téléchargement peut durer une dizaine de minutes.
7. Vérifiez que le package s'est correctement décompressé (un 0 s'affiche en regard de

l'étiquette Failed).

D.2. Activation du code sur le contrôleur de la bibliothèque
Seuls les représentants du service Oracle doivent télécharger et installer le nouveau
microprogramme de la bibliothèque. Pour obtenir de l'aide, contactez le support technique
Oracle.

http://edelivery.oracle.com
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Remarque:

Une réinitialisation de la bibliothèque est nécessaire pour activer le code. Planifiez l'activation à une
heure qui convient aux utilisateurs.

1. Téléchargez le code dans la bibliothèque (voir Section D.1, « Téléchargement du code
dans le contrôleur de la bibliothèque »).

2. Sélectionnez Tools > Diagnostics, puis sélectionnez le dossier Library dans
l'arborescence du périphérique.

3. Cliquez sur l'onglet Activate Code.
4. Dans la liste Target, sélectionnez le package de code que vous souhaitez activer (dans ce

cas, SL3000 Code).
5. Dans la section Available Versions, sélectionnez la version de code à activer. Cliquez sur

Activate.

Mise en garde:

ALTERATION POSSIBLE DE FICHIERS INTERNES. Ne réinitialisez aucun périphérique dans la
bibliothèque et n'exécutez aucune opération sur la bibliothèque pendant l'activation du code.

6. Lorsque le processus d'activation se termine, cliquez sur OK pour réinitialiser la
bibliothèque.

7. Cliquez sur OK pour terminer la session de SLC.

Après la fin de l'initialisation de la bibliothèque, reconnectez-vous à SLC.
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Annexe E 
Référence de l'adressage de la bibliothèque

Remarque:

Sauf mention contraire, "gauche" et "droite" font référence à l'affichage de la bibliothèque depuis le côté
du CAP (face avant).

• Comparaison des schémas d'adressage
• Présentation de la ligne centrale
• Schéma d'adressage du microprogramme interne
• Schéma d'adressage HLI-PRC
• Numérotation des éléments FC-SCSI
• Numérotation du matériel des lecteurs de bande
• Diagramme des façades

Voir aussi

• Section 9.8, « Utilisation des emplacements système réservés »

E.1. Comparaison des schémas d'adressage
• Schéma d'adressage du microprogramme interne (bibliothèque, rail, colonne, côté,

ligne) : utilisé par les communications du microprogramme et internes pour représenter
tous les périphériques et emplacements de la bibliothèque.
◦ Commence par 1 et utilise des numéros négatifs.
◦ Le côté indique la façade avant ou arrière de la bibliothèque.
◦ Les valeurs de colonne des baies de lecteurs sont comprises entre 1 et 4 (BM) et -1 et -4

(DEM).
• Schéma d'adressage HLI-PRC (LSM, panneau, ligne et colonne) : utilisé par les clients

HLI tels qu'ACSLS et ELS pour représenter les emplacements et les composants de la
bibliothèque.
◦ Commence par 0 et n'utilise pas de numéros négatifs.
◦ Le panneau indique la façade avant ou arrière d'un module spécifique.
◦ La valeur de colonne des baies de lecteurs est toujours égale à 0.

• Numérotation des éléments FC-SCSI : utilisé par les hôtes avec les connexions FC-SCSI
à la bibliothèque.
◦ Utilise un numéro positif unique pour l'ID d'élément.
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◦ Les emplacements de cartouches commencent à 2000, les lecteurs de bande à 1000 et les
CAP à 10.

◦ Les emplacements inactifs et les lecteurs de bande vides sont ignorés lorsque les
numéros d'élément sont assignés.

◦ La numérotation des éléments par défaut est réassignée à chaque modification de la
configuration de la bibliothèque.

◦ La numérotation des éléments dépend de la capacité active.
• Numérotation du matériel des lecteurs de bande : emplacements de lecteur affectés par

la carte HBC.

E.2. Présentation de la ligne centrale

Le microprogramme interne et l'adressage HLI utilisent la ligne centrale de la bibliothèque
comme point de référence. Lorsque des modules sont ajoutés d'un côté ou de l'autre de la
bibliothèque, les composants existants ne modifient pas le numéro d'adresse.

Figure E.1, « Emplacement de la ligne centrale dans les exemples de bibliothèque » affiche
l'emplacement de la ligne centrale pour les différentes configurations de la bibliothèque.
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Figure E.1. Emplacement de la ligne centrale dans les exemples de bibliothèque

E.3. Schéma d'adressage du microprogramme interne
• Présentation de l'adressage du microprogramme interne
• Adressage du microprogramme interne des lecteurs de bande
• Adressage du microprogramme interne des robots
• Adressage du microprogramme interne des CAP

E.3.1. Présentation de l'adressage du microprogramme
interne
L'adressage du microprogramme interne désigne l'emplacement physique à l'aide des
paramètres Library (bibliothèque), Rail (rail), Column (colonne), Side (côté), Row (ligne) -
L,R,C,S,W.

Bibliothèque
Toujours égal à 1.
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Rail
Toujours égal à 1.
Colonne
Indique l'emplacement horizontal d'une cartouche ou d'un lecteur référencé à partir de la
ligne centrale (voir la section Section E.2, « Présentation de la ligne centrale »).
• Une valeur positive (+) indique la droite de la ligne centrale
• Une valeur négative (-) indique la gauche de la ligne centrale

Module de base
• Comprend les colonnes 1 à 6 pour les cartouches de données et les colonnes 1 à 4 pour

les lecteurs de bande.

DEM
• Comprend les colonnes -1 à -6 pour les cartouches de données et les colonnes -1 à -4

pour les lecteurs de bande.

CEM
• Comprend six colonnes pour les cartouches de données.
• La numérotation des colonnes se poursuit de manière consécutive à partir du module

adjacent. Notez qu'en l'absence de DEM, un CEM placé directement à gauche d'une
base comprend les colonnes -7 à -12 (les colonnes -1 à -6 sont omises).

PEM
• Comprend seulement trois colonnes destinées aux cartouches de données. Les trois

colonnes les plus à l'extérieur sont inactives.

AEM
• En d'autres termes, la numérotation des colonnes AEM se base sur la présence d'un

DEM et de quatre CEM installés à gauche du module de base et de quatre CEM
installés à sa droite.

• Les colonnes AEM de gauche sont toujours numérotées de –33 à –31.
• Les colonnes AEM de droite sont toujours numérotées de 31 à 33.
Côté
Indique la façade avant (côté CAP) ou arrière (côté lecteur) de la bibliothèque.
• Façade arrière = 1
• Façade avant = 2
Ligne
L'emplacement vertical d'une cartouche de données, numérotée de manière consécutive
de haut (1) en bas (52).
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Figure E.2. Exemples d'adressage (Côté et Colonne) du microprogramme interne (vue du
haut de la bibliothèque)

E.3.2. Adressage du microprogramme interne des lecteurs de
bande

L'adressage du microprogramme (bibliothèque, rail, colonne, côté, ligne) distingue un lecteur
en fonction de la colonne et de la ligne. Les valeurs bibliothèque, rail et côté sont toujours
égales à 1.
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Remarque:

La Figure E.3, « Adressage du microprogramme interne du lecteur de bande (vue arrière de la
bibliothèque) » présente la vue arrière (côté lecteur) de la bibliothèque.

Figure E.3. Adressage du microprogramme interne du lecteur de bande (vue arrière de la
bibliothèque)

E.3.3. Adressage du microprogramme interne des robots
Colonne
La valeur de la colonne est toujours égale à 0.
Côté
En présence d'un seul robot : la valeur du côté est toujours égale à 1.

Pour des configurations de robotique redondantes :
• Robot gauche = 1
• Robot droit = 2
Ligne
Durant l'adressage du périphérique : la ligne est égale 0.
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Durant l'adressage de l'emplacement spécifique : la ligne est la valeur de l'emplacement
(1).
Exemple - Adressage du microprogramme du robot
Dans cet exemple, l'adresse fait référence au robot droit dans une bibliothèque d'unités
robotiques redondante.

L'adresse du microprogramme est : (1, 1, 0, 2, 0)

E.3.4. Adressage du microprogramme interne des CAP

• Adressage des CAP de rotation
• Adressage du CAP des AEM

E.3.4.1. Adressage des CAP de rotation

Colonne
La valeur de la colonne dépend de la taille de la bibliothèque et de l'emplacement du
module contenant le CAP.

Pour les modules situés à gauche de la ligne centrale, la valeur de la colonne du CAP
correspond à la deuxième colonne à partir de la droite du module. Par exemple, la valeur
de la colonne du CAP serait -2 tandis qu'elle serait égale à -8 dans un CEM situé à gauche
du DEM.

Pour les modules situés à droite de la ligne centrale, la valeur de la colonne du CAP
correspond à la cinquième colonne à partir de la gauche du module. Par exemple, la
valeur de la colonne d'un CAP serait 5 dans un module de base tandis qu'elle serait égale
à 11 dans un CEM situé à droite du module de base.
Côté
La valeur de côté est toujours égale à 2, étant donné que les CAP sont uniquement situés
à l'avant du module.
Ligne
Durant l'adressage du périphérique : la valeur de ligne est égale à 0.

Durant l'adressage d'un emplacement spécifique : la valeur de ligne correspond à
l'emplacement du magasin CAP (valeurs 1 à 26).
Exemple - Adressage du microprogramme de rotation
Dans cet exemple, la bibliothèque possède un module de base, un DEM et quatre CEM
(deux sur chaque côté). L'adresse se rapporte au sixième emplacement vers le bas dans le
CAP du CEM situé à l'extrémité gauche.

L'adresse du microprogramme est : (1, 1, -14, 2, 6)

E.3.4.2. Adressage du CAP des AEM

Colonne
En cas de référencement, la valeur de la colonne est toujours :
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• -31 pour l'AEM de gauche
• 31 pour l'AEM de droite

En cas de référencement d'un emplacement dans le CAP, la valeur de la colonne est
toujours comprise entre :
• -31 et -33 pour l'AEM de gauche
• 31 et 33 pour l'AEM de droite
Côté
Indique les portes du CAP avant ou arrière de la bibliothèque.
• Façade arrière = 1
• Façade avant = 2
Ligne
Durant l'adressage du périphérique : la valeur de ligne est égale à 0.

Durant l'adressage d'un emplacement spécifique : la valeur de la ligne correspond à
l'emplacement du CAP (valeurs 1 à 26).
Exemple - Adressage du microprogramme du CAP des AEM
Dans cet exemple, l'adresse fait référence à un emplacement de cartouche dans l'AEM
droit. L'emplacement est le 37e à partir du haut dans la colonne la plus à droite de la porte
du CAP arrière.

L'adresse du microprogramme est : (1, 1, 33, 1, 37)

E.4. Schéma d'adressage HLI-PRC
• Présentation de l'adressage HLI
• Adressage HLI des CAP
• Adressage HLI des lecteurs de bande

E.4.1. Présentation de l'adressage HLI

L'adressage HLI-PRC désigne l'emplacement physique à l'aide des paramètres : LSM
(Library Storage Module), Panel (panneau), Row (ligne) et Column (colonne).

LSM
Toujours égal à 0.
Panneau
Indique la façade avant (côté CAP) ou arrière (côté lecteur) d'un module. Le nombre de
panneaux va de 0 à 23 en fonction de la configuration de la bibliothèque.
• Façade arrière = numéros impairs
• Façade avant = numéros pairs

L'emplacement du panneau est défini en fonction du module de base (panneaux 12 et 13).
Les valeurs de panneau inférieures à 12 indiquent que le module se trouve à gauche du
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module de base, tandis que les valeurs supérieures à 13 indiquent que le module se trouve
à droite du module de base.

Module de base
• Panneaux 12 et 13

DEM
• Panneaux 10 et 11

CEM
• Les panneaux sont numérotés de manière consécutive à partir du module adjacent.

Toutefois, en l'absence de DEM, un CEM placé directement à gauche d'un module de
base comprend les panneaux -8 et -9 (les panneaux -10 et -11 sont omis).

AEM
• Les AEM sont considérés comme des CAP par l'adressage HLI. Ils sont associés à ID

de CAP plutôt qu'à un numéro de panneau (voir la section Section E.4.2, « Adressage
HLI des CAP »)

• L'ID de CAP de l'AEM de gauche est toujours 0
• L'ID de CAP de l'AEM de droite est toujours 11
Ligne
Position verticale d'un emplacement, numéroté de manière consécutive du haut vers le
bas (0 à 51). Toutefois, la numérotation des lignes des baies de lecteurs va de 0 à 23 pour
le module de base et de 0 à 31 dans le DEM.
Colonne
Position horizontale d'un emplacement de la gauche vers la droite (0 à 5). La valeur de
colonne des baies de lecteur est néanmoins toujours égale à 0 (voir la section Section E.6,
« Numérotation du matériel des lecteurs de bande »").

La numérotation de la colonne AEM débute à partir de la façade arrière et se poursuit
de gauche à droite (colonnes 0 à 2), puis continue vers la façade avant et se poursuit de
gauche à droite (colonnes 3 à 5).
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Figure E.4. Exemples d'adressage de colonnes et de panneaux HLI-PRC (vue du haut de la
bibliothèque)

E.4.2. Adressage HLI des CAP

L'adressage HLI définit les emplacements de CAP à l'aide d'un ID de CAP plutôt qu'une
valeur de panneau. L'adressage est LSM, ID de CAP, ligne, colonne.

• Adressage des CAP de rotation
• Adressage du CAP des AEM
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E.4.2.1. Adressage des CAP de rotation

LSM
Toujours égal à 0.
ID de CAP
Les ID de CAP sont compris entre 1 et 10.
• CEM à gauche de la ligne centrale = 1 à 4 (gauche à droite)
• DEM = 5
• Module de base = 6
• CEM à droite de la ligne centrale = 6 à 10 (gauche à droite)
Ligne
La valeur correspond à l'emplacement dans le CAP (les valeurs peuvent être comprises
entre 0 et 25).
Colonne
La valeur est toujours égale à 0.
Exemple - Adressage HLI des CAP de rotation
Dans cet exemple, la bibliothèque possède un module de base, un DEM et huit CEM
(quatre sur chaque côté). L'adresse se rapporte au sixième emplacement vers le bas dans
le CAP du CEM situé à l'extrémité gauche.

L'adresse HLI est : (0, 1, 5, 0)

E.4.2.2. Adressage du CAP des AEM

LSM
Toujours égal à 0.
ID de CAP
L'AEM gauche est égal à 0.

L'AEM droit est égal à 11.
Ligne
La valeur correspond à l'emplacement dans une colonne (les valeurs peuvent être
comprises entre 0 et 38).
Colonne
Façade arrière = colonnes 0 à 2

Façade avant = colonnes 3 à 5

E.4.3. Adressage HLI des lecteurs de bande

L'adressage HLI définit les lecteurs de bande à l'aide d'un ID de lecteur plutôt qu'une valeur
de ligne. L'adressage est LSM, panneau, ID de lecteur, colonne (voir la section Section E.6,
« Numérotation du matériel des lecteurs de bande »). HLI distingue un lecteur en fonction de
la valeur du panneau et du lecteur. Les valeurs de LSM et de colonne sont toujours égales à 0.
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Remarque:

La Figure E.5, « Adressage HLI-PRC du lecteur de bande (vue arrière de la bibliothèque) » présente la
vue arrière (côté lecteur) de la bibliothèque.

Figure E.5. Adressage HLI-PRC du lecteur de bande (vue arrière de la bibliothèque)

E.5. Numérotation des éléments FC-SCSI

Remarque:

La modification de la configuration de la bibliothèque peut entraîner la réaffectation des numéros
d'éléments par la bibliothèque.

Pour la numérotation des éléments FC-SCSI, chaque composant actif de la bibliothèque est
défini par un ID d'élément unique. La numérotation de l'élément SCSI contient englobe trois
types d'éléments :

• Eléments de stockage (emplacements de stockage actifs)
◦ Commence à 2000.
◦ Numérotés de haut en bas, de gauche à droite et de l'arrière vers l'avant.

• Eléments d'importation/exportation (CAP de rotation)
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◦ Commence à 10 pour le CAP le plus à gauche dans la bibliothèque. Les éléments
de stockage et d'importation/exportation sont numérotés de manière séquentielle par
emplacement. Aucun emplacement n'est omis.

◦ Numérotés de haut en bas, de gauche à droite (voir la section Figure E.9, « Numérotation
de l'élément SCSI par défaut - Façade avant (vue de l'avant de la bibliothèque) »)

• Eléments de transfert de données (lecteurs)
◦ Commence à 1000 et est incrémenté de un pour chaque lecteur installé.
◦ Numérotés de gauche à droite et de haut en bas à partir de la ligne centrale du module de

base et jusqu'au DEM, le cas échéant.

Remarque:

Quand une bibliothèque est mise sous tension, aucun emplacement de lecteur vide n'est inclut
dans la séquence de numérotation des éléments. Les applications de sauvegarde Open Systems ne
tolèrent pas les éléments de transfert de données qui ne répondent pas ou ne peuvent pas répondre
lorsque vous mettez la bibliothèque sous tension.

E.5.1. Numérotation SCSI par défaut

Remarque:

Le modèle de numérotation par défaut part du principe que vous disposez d'une bibliothèque non
partitionnée utilisant la configuration de capacité par défaut de "gauche à droite".

E.5.1.1. Schéma de numérotation de l'élément de stockage
SCSI par défaut (cartouches)

1. La numérotation démarre à 2000 dans l'emplacement supérieur gauche de la façade
arrière du module le plus à gauche.

2. La numérotation progresse du haut vers le bas et de gauche à droite.
3. Lorsque la numérotation atteint le dernier emplacement de la façade arrière, elle passe à

la façade avant du module le plus à gauche (A à B dans la Figure E.6, « Numérotation de
l'élément de stockage SCSI »).

4. Elle se poursuit de haut en bas, puis de gauche à droite et se termine dans la partie
inférieure droite du module le plus à droite.
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Figure E.6. Numérotation de l'élément de stockage SCSI

E.5.1.2. Schéma de numérotation de l'élément de transfert de
données SCSI par défaut (lecteurs)

1. La numérotation débute dans l'emplacement de lecteur supérieur gauche du module de
base.

2. La numérotation progresse de gauche à droite et de haut en bas (en ignorant tous les
emplacements de lecteur vides).

3. Quand elle atteint l'emplacement de lecteur inférieur droit du module de base, elle passe
dans le module d'extension de lecteur (A à B dans la Figure E.7, « Numérotation de
l'élément de transfert de données SCSI (vue de l'avant de la bibliothèque) »).

4. Elle se poursuit de gauche à droite, de haut en bas puis se termine dans la partie inférieure
droite du DEM.
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Figure E.7. Numérotation de l'élément de transfert de données SCSI (vue de
l'avant de la bibliothèque)

E.5.1.3. Exemple de numérotation par défaut

Remarque:

La bibliothèque de cet exemple a été simplifiée. Il ne s'agit pas d'une représentation exacte d'une
bibliothèque SL3000.

L'exemple de bibliothèque inclut :

• Quatre modules : un module de base, un module DEM et deux CEM
• 166  emplacements de cartouche de données : numérotés de 2000 à 2165
• 40 baies de lecteurs de bande (deux baies de lecteur sont manquantes, une sur chaque

module) : numérotées de 1000 à 1037
• Deux CAP, contenant sept emplacements chacun : numérotés de 10 à 23

La numérotation par défaut est illustrée sur les schémas ci-dessous.
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Figure E.8. Numérotation de l'élément SCSI par défaut - Façade arrière (vue de
l'avant de la bibliothèque)

Figure E.9. Numérotation de l'élément SCSI par défaut - Façade avant (vue de
l'avant de la bibliothèque)

E.5.2. Numéroration SCSI dans une bibliothèque non
partitionnée utilisant une capacité personnalisée

Après l'activation d'une zone de la bibliothèque, la numérotation commence dans
l'emplacement le plus à gauche de la façade arrière dans la zone active. Ensuite, le schéma de
numérotation suit le modèle défini dans la section Section E.5.1.1, « Schéma de numérotation
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de l'élément de stockage SCSI par défaut (cartouches) » pour tous les emplacements actifs et
omet tous les emplacements inactifs.

Lorsque vous activez de la capacité supplémentaire ultérieurement, la numérotation SCSI des
emplacements activés précédemment reste inchangée. La bibliothèque ajoute la numérotation
SCSI pour les emplacements activés récemment.

Si vous ajoutez des lecteurs de bande, la bibliothèque réassigne la numérotation de l'élément
de transfert de données SCSI, en procédant comme décrit à la section Section E.5.1.2,
« Schéma de numérotation de l'élément de transfert de données SCSI par défaut (lecteurs) ».
La bibliothèque est ensuite réinitialisée.

E.5.2.1. Exemple de numérotation de la capacité
personnalisée

Remarque:

La bibliothèque de cet exemple a été simplifiée. Il ne s'agit pas d'une représentation exacte d'une
bibliothèque SL3000.

Pour cet exemple, l'utilisateur active 50 emplacements, en commençant par le DEM.
Par conséquent, la numérotation de l'élément de stockage SCSI commence à 2000 par
l'emplacement actif le plus à gauche dans la partie supérieure du DEM (voir la section
Figure E.10, « Numérotation des éléments SCSI de la capacité personnalisée - Façade
arrière » ci-dessous).

Figure E.10. Numérotation des éléments SCSI de la capacité personnalisée -
Façade arrière

Ultérieurement, l'utilisateur active les 30 emplacements restants dans la bibliothèque. La
bibliothèque numérote les emplacements en démarrant à 2050 dans le coin supérieur gauche
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du CEM (voir la section Figure E.11, « Numérotation de l'élément SCSI ajoutée d'une
capacité ajoutée- Façade arrière » ci-dessous).

Figure E.11. Numérotation de l'élément SCSI ajoutée d'une capacité ajoutée-
Façade arrière

E.5.3. Numérotation SCSI dans une bibliothèque partitionnée

Lorsque vous définissez une partition, la numérotation commence dans l'emplacement
le plus à gauche de la façade arrière dans la partition. Le schéma de numérotation suit le
modèle défini dans la section Section E.5.1.1, « Schéma de numérotation de l'élément de
stockage SCSI par défaut (cartouches) » pour tous les emplacements actifs, mais omet les
emplacements inactifs et absents de la partition. La numérotation des éléments est continue
pour chaque partition même si les emplacements de la partition ne sont pas adjacents.

Si vous allouez plus de ressources à la partition, la numérotation SCSI des éléments
numérotés précédemment dans la partition reste inchangée. La bibliothèque ajoute
simplement la numérotation SCSI aux nouveaux emplacements activés ou aux nouveaux
lecteurs de bande insérés dans la partition.

E.6. Numérotation du matériel des lecteurs de bande
La numérotation du matériel est assignée par la carte de contrôleur HBC. Elle permet
d'identifier un emplacement de lecteur de bande. La carte assigne automatiquement un
numéro, compris entre 1 et 56, à chaque emplacement de lecteur.

Remarque:

La Figure E.12, « Numérotation du matériel physique du lecteur de bande (vue arrière de la
bibliothèque) » présente la vue arrière (côté lecteur) de la bibliothèque.
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Figure E.12. Numérotation du matériel physique du lecteur de bande (vue arrière de la
bibliothèque)

Voir aussi

• Section E.3.2, « Adressage du microprogramme interne des lecteurs de bande »
• Section E.4.3, « Adressage HLI des lecteurs de bande »
• Section E.5.1.2, « Schéma de numérotation de l'élément de transfert de données SCSI par

défaut (lecteurs) »).

E.7. Diagramme des façades
• Façade avant du module de base (Figure E.13, « Module de base, façade avant »)
• Façade arrière du module de base (Figure E.14, « Module de base, façade arrière » et

Figure E.15, « Module de base, façade arrière avec 24 lecteurs »)
• Façade avant du DEM (Figure E.16, « Façade avant du DEM » et Figure E.17, « Façade

avant du DEM (suite) »)
• Façade arrière du DEM (Figure E.18, « Façade arrière du DEM » et Figure E.19, « Façade

arrière du DEM (suite) »)
• Façade avant du CEM (Figure E.20, « Module d'extension de cartouche, façade avant »)
• Façade arrière du CEM (Figure E.21, « Module d'extension de cartouche, arrière »)
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• PEM gauche (Figure E.22, « Module d'extension de stockage (PEM), gauche »)
• PEM droit (Figure E.23, « Module d'extension de stockage, droit »)
• AEM gauche (Figure E.24, « Module d'extension d'accès, gauche »)
• AEM droit (Figure E.25, « Module d'extension d'accès, droit »)
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Figure E.13. Module de base, façade avant
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Figure E.14. Module de base, façade arrière
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Figure E.15. Module de base, façade arrière avec 24 lecteurs
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Figure E.16. Façade avant du DEM
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Figure E.17. Façade avant du DEM (suite)



Diagramme des façades

156

Figure E.18. Façade arrière du DEM
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Figure E.19. Façade arrière du DEM (suite)
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Figure E.20. Module d'extension de cartouche, façade avant
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Figure E.21. Module d'extension de cartouche, arrière
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Figure E.22. Module d'extension de stockage (PEM), gauche
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Figure E.23. Module d'extension de stockage, droit
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Figure E.24. Module d'extension d'accès, gauche
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Figure E.25. Module d'extension d'accès, droit
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Annexe F 
Contrôle des contaminants

• Contaminants présents dans l'environnement
• Niveaux exigés en matière de qualité de l'air
• Sources et propriétés des contaminants
• Effets des contaminants
• Conditions ambiantes
• Zones d'exposition
• Filtration
• Pressurisation positive et ventilation
• Equipement et procédures de nettoyage
• Activités et processus

F.1. Contaminants présents dans l'environnement
Dans la mesure où les particules en suspension dans l'air risquent d'endommager les
bibliothèques de bandes, lecteurs de bande et supports de bande, il est crucial de surveiller
la concentration des contaminants dans les salles informatiques. Si la plupart des particules
inférieures à dix microns ne sont pas visibles à l'oeil nu dans la plupart des conditions, elles
n'en restent pas moins les plus nuisibles. L'environnement de fonctionnement doit donc
respecter les exigences suivantes ;:

• Environnement ISO 14644-1 Classe 8.
• La masse totale des particules en suspension dans l'air doit être inférieure ou égale à

200 microgrammes par mètre cube.
• Niveau de gravité G1 selon ANSI/ISA 71.04-1985.

Actuellement, Oracle exige la norme ISO 14644-1 approuvée en 1999, mais exigera toutes
ses mises à jour à mesure de leur approbation par l'organe réglementaire de l'ISO. La norme
ISO 14644-1 s'intéresse principalement à la taille et à la quantité des particules ainsi qu'à la
méthodologie de mesure adéquate, mais n'aborde pas la masse globale des particules. Par
conséquent, l'exigence en termes de limitations de la masse totale est également nécessaire,
car même si une salle informatique ou un centre de données répond à la norme ISO 14644-1,
le type spécifique de particules en suspension risque d'endommager les équipements qui s'y
trouvent. En outre, la spécification ANSI/ISA 71.04-1985 traite des contaminations sous
forme gazeuse, certains produits chimiques en suspension dans l'air étant plus dangereux.
Ces trois exigences correspondent à celles établies par d'autres fournisseurs de stockage sur
bande.
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F.2. Niveaux exigés en matière de qualité de l'air
Les particules, les gaz et autres contaminants sont susceptibles d'avoir un impact sur le
fonctionnement soutenu du matériel informatique. Les effets peuvent aller d'une interférence
intermittente à une panne réelle de composant. De par sa conception, la salle informatique
doit répondre à un niveau de propreté élevé. Les poussières, gaz et vapeurs en suspension
doivent être maintenus dans les limites définies aux fins de réduire au maximum leurs
éventuels effets sur le matériel.

Les niveaux de particules en suspension dans l'air doivent être conformes aux limites de
l'Environnement ISO 14644-1 Classe 8. Cette norme définit des classes de qualité de l'air
pour les zones propres en fonction de la concentration des particules en suspension. En
ordre de grandeur, cette norme fixe un nombre de particules inférieur à celui de l'air normal
dans un environnement de bureau. En général, les particules inférieures à dix microns sont
nuisibles au matériel de traitement de données, car elles existent en grand nombre et peuvent
facilement contourner le système de filtration de l'air interne de nombreux composants
sensibles. Le matériel informatique exposé à un grand nombre de particules submicroniques
met en péril la fiabilité du système, représentant une menace pour les pièces amovibles, les
contacts sensibles et les composants que la corrosion peut dégrader.

Une concentration excessive de certains gaz risque également d'accélérer la corrosion
et de provoquer la panne des composants électroniques. Dans les salles informatiques,
les contaminants sous forme gazeuse constituent un problème particulier en raison de la
sensibilité du matériel et du recyclage quasi complet de l'air ambiant. Dans la salle, la menace
des contaminants est aggravée par le caractère cyclique du flux d'air. Les niveaux d'exposition
qui ne sont pas préoccupants dans un environnement aéré attaquent à maintes reprises
le matériel dans une salle dont l'air est recyclé. L'isolation empêchant toute exposition
de l'environnement informatique au monde extérieur risque également de multiplier les
influences nuisibles ignorées dans la salle.

Les composés chlorés, l'ammoniac et ses dérivés, les oxydes de soufre et les hydrocarbures
sont au nombre des gaz particulièrement nocifs pour les composants électroniques. En
l'absence de limites appropriées d'exposition du matériel, des limites d'exposition constituant
un risque pour la santé s'imposent.

Bien que les sections suivantes décrivent en détail quelques pratiques d'excellence permettant
de conserver un environnement conforme à la norme ISO 14644-1 Classe 8, vous devez
observer certaines précautions élémentaires :

• Aliments et boissons sont à proscrire dans la zone ;
• Les cartons, le bois ou les matériaux d'emballage doivent être stockés dans la zone propre

du centre de données ;
• Une zone distincte doit être consacrée au déballage des nouveaux équipements des caisses

et cartons ;
• Tout travail de construction ou perforation dans le centre de données doit être interdit tant

que les équipements sensibles et l'air qui leur est destiné ne sont pas isolés. Les travaux
de construction génèrent une concentration de particules élevée, au-delà des critères de
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la norme ISO 14644-1 Classe 8 dans une zone localisée. Les murs secs et le plâtre sont
particulièrement nuisibles aux équipements de stockage.

F.3. Sources et propriétés des contaminants
Dans une salle, les contaminants peuvent prendre de nombreuses formes et provenir de
nombreuses sources. Tout processus mécanique risque de produire des contaminants
dangereux et d'agiter les contaminants sédimentés. Pour être considérée comme un
contaminant, une particule doit répondre à deux critères de base :

• Elle doit posséder les propriétés physiques susceptibles d'endommager le matériel ;
• Elle doit pouvoir migrer dans des zones où elle est susceptible de provoquer des dommages

physiques.

Seuls le moment et l'endroit permettent de distinguer un contaminant réel d'un contaminant
potentiel. En suspension dans l'air, les matières particulaires risquent de migrer vers des zones
où elles peuvent provoquer des dégâts. Pour cette raison, la concentration des particules
atmosphériques représente une mesure utile de la qualité environnementale de la salle
informatique. En fonction des conditions locales, les particules d'un millier de microns
peuvent s'élever dans l'air, mais leur vie active est très courte et elles sont retenues par la
plupart des dispositifs de filtration. Les particules submicroniques sont plus dangereuses pour
le matériel informatique sensible, car elles restent suspendues dans l'air plus longtemps et
sont plus susceptibles de contourner les filtres.

F.3.1. Activité des opérateurs

Le mouvement humain constitue probablement la source de contamination la plus importante
dans une salle informatique par ailleurs propre. Un mouvement normal est susceptible
de déloger des fragments tissulaires, tels que des cheveux ou des pellicules, ou les fibres
textiles des vêtements. L'ouverture et la fermeture de tiroirs ou de panneaux, ou toute activité
de métal sur métal risquent de produire de la limaille. Le simple fait de marcher risque
de soulever les contaminants sédimentés, qui peuvent alors s'élever dans l'air et devenir
dangereux.

F.3.2. Déplacement de matériel

L'installation et la reconfiguration matérielles impliquent une activité importante sur le sous-
plancher ; facilement délogés, les dépôts de contaminants s'élèvent dans l'air et rejoignent le
flux d'air d'alimentation du matériel de la salle. Le danger est plus important encore lorsque le
sous-plancher n'est pas vitrifié. Le béton non vitrifié répand de fines particules de poussière
dans le flux d'air et présente des risques d'efflorescence (dépôts de sels minéraux sur le
plancher dus à l'évaporation ou à la pression hydrostatique).

F.3.3. Air extérieur

S'il n'est pas correctement filtré, l'air extérieur à l'environnement contrôlé peut introduire
de nombreux contaminants. Les contaminants post-filtration dans les conduites peuvent
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être délogés par le flux d'air et introduits dans l'environnement matériel. Le risque est
particulièrement important dans les systèmes de climatisation de flux descendant dans
lesquels le vide du sous-plancher fait office de conduite d'alimentation d'air. Lorsque la
structure est contaminée ou que les dalles de béton ne sont pas vitrifiées, de fines particules
(efflorescence ou poussière de béton) risquent d'être transportées directement vers le matériel
de la salle.

F.3.4. Eléments stockés

Le stockage et la manutention de matériaux ou fournitures non utilisés peuvent constituer
des sources de contamination. Lors de leur déplacement ou manipulation, les boîtes en
carton ondulé ou les palettes de bois répandent des fibres. Les éléments stockés ne sont
pas que sources de contamination ; leur manipulation dans les zones contrôlées de la salle
informatique peut soulever les contaminants sédimentés.

F.3.5. Influences extérieures

Un environnement sous pression négative risque de laisser s'infiltrer les contaminants
provenant des espaces de bureaux adjacents ou de l'extérieur du bâtiment par les interstices
dans les portes ou fissures dans les murs. L'ammoniac et les phosphates sont fréquemment
associés aux processus agricoles et de nombreux agents chimiques peuvent être produits dans
les zones de fabrication. Lorsque ces industries sont présentes à proximité des installations
du centre de données, la filtration chimique peut se révéler nécessaire. Le cas échéant, il est
conseillé d'évaluer les conséquences éventuelles des émissions automobiles, des poussières de
carrières et d'usines de fabrication de produits de maçonnerie, et des brumes marines.

F.3.6. Activité de nettoyage

Des méthodes de nettoyage inappropriées peuvent également dégrader l'environnement.
De nombreux produits chimiques utilisés pour le nettoyage normal ou de bureau sont
susceptibles d'endommager les équipements informatiques sensibles. L'utilisation des
produits chimiques éventuellement dangereux répertoriés à la section " Equipement et
procédures de nettoyage " est déconseillée. Le dégagement gazeux de ces produits ou
leur contact direct avec les composants matériels risque de provoquer des défaillances.
Certains traitements biocides utilisés dans les systèmes de traitement de l'air des bâtiments
ne conviennent pas non plus aux salles informatiques, soit parce que les produits chimiques
qu'ils contiennent peuvent endommager les composants, soit parce qu'ils ne sont pas conçus
pour une utilisation dans le flux d'air d'un système de recyclage de l'air. Un balai-serpillère ou
un aspirateur muni d'un filtre inadéquat peuvent également être sources de contamination.

Il est essentiel de prendre les mesures adéquates qui empêcheront les contaminants (particules
métalliques, poussières atmosphériques, vapeurs de solvants, gaz corrosifs, suie, fibres
en suspension ou sels) d'entrer dans l'environnement de la salle informatique ou d'y être
générés. En l'absence de limites d'exposition du matériel, il est conseillé d'appliquer le seuil
d'exposition humaine défini par les organismes OSHA, NIOSH ou ACGIH.
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F.4. Effets des contaminants
Les interactions destructives entre les particules en suspension et les instruments
électroniques peuvent se manifester de différentes façons. Les interférences dépendent
du moment et de l'endroit où survient l'incident critique, des propriétés physiques du
contaminant et de l'environnement dans lequel le composant est placé.

F.4.1. Interférences physiques
Les particules solides d'une résistance à la traction égale ou supérieure à 10 % de celle
du composant peuvent enlever du matériau de la surface du composant par abrasion ou
incrustation. Les particules molles n'endommageront pas le composant, mais peuvent
s'accumuler et nuire à son fonctionnement. Si ces particules sont collantes, elles peuvent
recueillir d'autres matières particulaires. Même des particules très petites peuvent avoir une
incidence négative si elles s'agglutinent sur une surface collante ou s'agglomèrent suite à une
accumulation de charge électrostatique.

F.4.2. Défaillance due à la corrosion
La corrosion ou un contact intermittent dus à la composition intrinsèque des particules ou à
l'absorption de vapeur d'eau et de contaminants gazeux par les particules peuvent également
provoquer des défaillances. La composition chimique du contaminant peut revêtir une
grande importance. Le sel, par exemple, peut se dilater par absorption de la vapeur d'eau
contenue dans l'air (nucléation). Dans un environnement suffisamment humide, un dépôt
de sels minéraux à un emplacement sensible risque d'augmenter de volume et d'entraver un
mécanisme ou de provoquer des dommages en formant des solutions salines.

F.4.3. Courts-circuits
Sur les cartes de circuit imprimé ou autres composants, l'accumulation de particules
risque de créer des pistes conductrices. Bien qu'elles ne soient pas conductrices par
nature, de nombreuses particules peuvent absorber une importante quantité d'eau dans
des environnements où le degré hygrométrique est élevé. Les problèmes provoqués par
les particules électroconductrices peuvent aller d'un dysfonctionnement intermittent à des
défaillances d'exploitation en passant par des dommages réels occasionnés aux composants.

F.4.4. Défaillance thermique
L'encrassement précoce des dispositifs filtrés entraîne une restriction du flux d'air, susceptible
de provoquer une surchauffe interne et un écrasement de tête. Sur les composants matériels,
une accumulation importante de poussières risque également de former une couche isolante
susceptible de provoquer des défaillances thermiques.

F.5. Conditions ambiantes
Un niveau élevé de propreté doit être maintenu pour toutes les surfaces situées à l'intérieur
de la zone contrôlée du centre de données. Toutes les surfaces doivent être nettoyées
régulièrement par des professionnels ayant suivi une formation à cet effet, comme indiqué
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à la section " Equipement et procédures de nettoyage ". Un soin particulier doit être porté
aux espaces en dessous du matériel et à la grille du faux-plancher. Les contaminants situés à
proximité des entrées d'air du matériel peuvent être plus facilement déplacés vers des zones
où ils risquent de provoquer des dommages. Les particules accumulées sur la grille du faux-
plancher peuvent s'élever dans l'air lorsque les dalles sont soulevées pour accéder au sous-
plancher.

Le vide du sous-plancher dans un système de climatisation à flux descendant sert de plénum
d'alimentation en air. Cette zone est pressurisée par les climatiseurs et l'air climatisé est
ensuite introduit dans les espaces matériels à travers les panneaux de plancher perforés. Ainsi,
l'air circulant des climatiseurs vers le matériel doit d'abord traverser le vide du sous-plancher.
Des conditions inadéquates dans le plénum d'alimentation d'air risquent d'avoir de graves
conséquences sur l'état des zones matérielles.

Dans un centre de données, le vide du sous-plancher se limite souvent à un espace où il
est pratique de faire passer les câbles et les canalisations. Gardez à l'esprit qu'il constitue
également un conduit et que la propreté de l'espace sous le faux-plancher doit être maintenue
à un niveau élevé. Les matériaux de construction qui se dégradent, l'activité des opérateurs ou
les infiltrations provenant de l'extérieur de la zone contrôlée sont quelques-unes des sources
de contamination. Des dépôts se forment souvent aux endroits où les câbles et autres éléments
de sous-plancher constituent des barrages d'air permettant aux particules de s'accumuler.
Lorsque ces éléments sont déplacés, les particules sont réintroduites dans le flux d'air et
transportées directement vers le matériel.

Les matériaux de construction endommagés ou mal protégés constituent des sources
fréquentes de contamination du sous-plancher. Au fil du temps, le béton, les blocs de
maçonnerie, le plâtre ou le gypse se détériorent et répandent de fines particules dans l'air. La
corrosion sur les éléments du sous-plancher et les surfaces des climatiseurs de post-filtration
peut également poser un problème. Une décontamination minutieuse, adéquate et régulière
du vide du sous-plancher permet d'éliminer ces contaminants. Seuls les aspirateurs dotés de
filtres HEPA (High Efficiency Particulate Air, haute efficacité pour les particules de l'air)
doivent être utilisés dans le cadre de la procédure de décontamination. Les aspirateurs équipés
de filtres inadéquats ne retiennent pas les particules fines, qui défilent à grande vitesse dans
l'unité d'aspiration avant d'être propulsées dans l'air.

Le béton non vitrifié et autres matériaux de maçonnerie subissent une dégradation constante.
Les enduits d'étanchéité et les durcisseurs utilisés en construction sont conçus pour protéger
le plancher des déplacements nombreux ou pour le préparer à l'application de matériaux de
revêtement ; ils ne sont pas destinés aux surfaces intérieures d'un plénum d'alimentation d'air.
Bien qu'une décontamination régulière permet d'éliminer les particules libres, les surfaces
continuent de subir une dégradation lente et l'activité provoque l'usure du sous-plancher. Dans
l'idéal, toutes les surfaces du sous-plancher doivent être correctement scellées au moment de
la construction. Si tel n'est pas le cas, des précautions spéciales doivent s'appliquer quant aux
surfaces de l'espace en ligne.

Il est crucial de n'utiliser que les matériaux et la méthodologie adéquats dans le processus
d'encapsulation. En effet, des procédures ou enduits d'étanchéité inadéquats risquent de
dégrader les conditions qu'ils sont censés améliorer et de détériorer par là même la fiabilité
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et l'exploitation du matériel. Les précautions suivantes s'appliquent lors de l'encapsulation du
plénum d'alimentation d'air dans l'espace en ligne :

• Appliquez la substance d'encapsulation manuellement. La vaporisation est totalement
inadaptée dans un centre de données en ligne. Elle propulse l'enduit d'étanchéité dans le
flux d'air et risque d'encapsuler les câbles au plancher.

• Utilisez une substance d'encapsulation pigmentée. La pigmentation permet de voir la
substance d'encapsulation lors de son application, ce qui garantit une couverture complète
et permet d'identifier les zones endommagées ou exposées au fil du temps.

• La substance d'encapsulation doit présenter une grande flexibilité et une faible porosité
pour couvrir de manière efficace les textures irrégulières de la zone à traiter et réduire au
minimum la migration de l'humidité et les dommages que l'eau peut provoquer.

• La substance d'encapsulation ne doit pas libérer de contaminants nocifs sous forme
gazeuse. De nombreuses substances utilisées dans l'industrie présentent une teneur élevée
en ammoniac ou contiennent des produits chimiques nuisibles pour le matériel. Il est peu
probable que ce dégagement gazeux provoque des défaillances immédiates et désastreuses,
mais ces produits chimiques contribuent souvent à la corrosion des contacts, têtes et autres
composants.

Une encapsulation réussie du sous-plancher d'une salle informatique en ligne est une tâche
difficile et délicate. Toutefois, elle peut être réalisée en toute sécurité si vous appliquez
les matériaux et procédures qui conviennent. Évitez d'utiliser le faux-plafond pour
l'alimentation ou la reprise du système d'aération du bâtiment. Difficile à nettoyer, cette zone
est particulièrement sale. La surface des structures est souvent recouverte de revêtements
ignifuges fibreux, et les dalles de plafond et l'isolant sont également sujets à la diffusion de
particules. Avant même la filtration, cette exposition inutile risque de nuire aux conditions
environnementales de la salle. Il est également important que le vide du plafond ne soit pas
pressurisé, car de l'air non filtré pourrait s'infiltrer dans la salle informatique. Des colonnes ou
enveloppes de câbles pénétrant dans le sous-plancher et le faux-plafond peuvent provoquer la
pressurisation du faux-plafond.

F.6. Zones d'exposition
Toutes les zones d'exposition potentielles du centre de données doivent être traitées en
vue de réduire au maximum les influences éventuelles provenant de l'extérieur de la zone
contrôlée. La pressurisation positive de la salle informatique permet de limiter l'infiltration
des contaminants. Toutefois, la réduction des brèches dans le périmètre de la salle est tout
aussi importante. Pour conserver votre environnement dans les meilleures conditions, prenez
en compte les points suivants :

• Toutes les portes doivent être parfaitement ajustées à leur encadrement.
• Vous pouvez utiliser des joints et balais de porte pour éliminer les espaces vides.
• Evitez les portes automatiques dans les zones où leur ouverture peut se déclencher par

mégarde. Un autre moyen de contrôle consiste à placer à distance un déclencheur de porte
de manière à ce que le personnel de manutention puisse ouvrir les portes facilement. Dans
les zones particulièrement sensibles ou celles où le centre de données est exposé à des
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conditions indésirables, il peut être judicieux d'installer des sas. Un double ensemble de
portes muni d'un tampon permet de limiter l'exposition directe aux conditions extérieures.

• Scellez toutes les entrées séparant le centre de données des zones adjacentes.
• Evitez de partager le plafond de la salle informatique ou le plénum du sous-plancher avec

les zones adjacentes qui ne sont pas strictement contrôlées.

F.7. Filtration
La filtration constitue un moyen efficace d'éliminer les particules en suspension dans
un environnement contrôlé. Il est important que tous les appareils de traitement de l'air
du centre de données soient filtrés de manière adéquate afin de garantir le maintien des
conditions optimales dans la salle. Le refroidissement des processus à l'intérieur de la salle est
recommandé dans le cadre du contrôle de l'environnement. Les refroidisseurs de processus
font recirculer l'air ambiant. L'air des zones de matériel transite dans les unités où il est
filtré et refroidi, puis introduit dans le plénum du sous-plancher. Le plénum étant pressurisé,
l'air climatisé entre de force dans la salle par les dalles perforées, avant de retourner vers
le climatiseur. La conception et la configuration de la circulation de l'air associées à un
dispositif classique de traitement d'air dans les salles informatiques présentent un taux de
renouvellement d'air supérieur à celui des climatiseurs de confort. L'air y est donc filtré
plus souvent que dans un environnement de bureau. Une filtration idoine peut capturer une
grande quantité de particules. Les filtres installés dans les climatiseurs de recirculation de
la salle informatique doivent offrir un taux de rendement minimal de 40 % (norme 52.1 de
l'ASHRAE sur l'efficacité en matière de particules de poussière atmosphérique). L'installation
de préfiltres de faible qualité doit permettre de prolonger la durée de vie des filtres principaux
plus onéreux.

L'air introduit dans la zone contrôlée de la salle informatique pour la ventilation ou la
pressurisation positive doit d'abord passer par un dispositif de filtration haute performance.
Dans des conditions idéales, l'air issu de sources extérieures au bâtiment doit être filtré selon
un taux de filtration HEPA d'un rendement de 99,97 % (DOP Efficiency MILSTD-282) ou
plus. Il est conseillé de protéger les filtres coûteux d'efficacité élevée par plusieurs couches de
préfiltres que vous changerez plus fréquemment. Les préfiltres de faible rendement (efficacité
en matière de particules de poussière atmosphérique de 20 %) doivent constituer la première
ligne de défense. La seconde batterie de filtres doit se composer de filtres de type "sac" ou
plissés d'un rendement compris entre 60 et 80 % de l'efficacité définie par l'ASHRAE en
matière de particules de poussière atmosphérique.

Taux d'efficacité
en matière de
particules de poussière
atmosphérique

Taux de rendement
fractionnaire pour : 3
.0 micron

Taux de rendement
fractionnaire pour : 1
.0 micron

Taux de rendement
fractionnaire pour : 3
.0 micron

25-30 80 20 <5

60-65 93 50 20

80-85 99 90 50

90 >99 92 60

DOP 95 -- >99 95
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Les filtres de faible rendement se révèlent pratiquement inefficaces pour éliminer les
particules submicroniques de l'air. Il est également important que les filtres utilisés présentent
la taille correspondant aux dispositifs de traitement de l'air. En effet, des interstices autour des
panneaux risquent de laisser l'air contourner le filtre lorsqu'il circule à travers le climatiseur.
Tous les espaces et ouvertures doivent être remplis à l'aide de matériaux appropriés, tels que
des panneaux en acier inoxydable ou des assemblages de filtre personnalisés.

F.8. Pressurisation positive et ventilation

Il est nécessaire de prévoir une entrée d'air provenant de l'extérieur du système de la salle
informatique pour répondre aux exigences en termes de pressurisation positive et de
ventilation. Le centre de données doit être conçu pour une pressurisation positive, dont ne
disposent pas les zones adjacentes moins strictement contrôlées. La pressurisation positive
des zones plus sensibles est un moyen efficace de contrôler l'infiltration des contaminants au
travers des petites brèches présentes dans le périmètre de la salle. Les systèmes de pression
positive visent à exercer des forces d'air extérieures sur les portes et autres points d'accès dans
l'enceinte du centre de traitement afin de réduire l'infiltration des contaminants dans la salle
informatique. La quantité d'air introduite dans l'environnement contrôlé doit être minimale.
Dans les centres de données comportant plusieurs salles, les zones les plus sensibles doivent
être les plus pressurisées. Il est cependant très important que l'air utilisé pour la pressurisation
positive ne nuise pas aux conditions environnementales de la salle. Il est essentiel que l'entrée
d'air provenant de l'extérieur de la salle informatique soit filtrée et climatisée de manière
adéquate dans le cadre de paramètres acceptables. Ces paramètres peuvent être moins stricts
que les conditions souhaitées pour la salle dans la mesure où l'entrée d'air doit être minimale.
L'identification précise de limites acceptables doit reposer sur la quantité d'air introduite et les
effets éventuels sur l'environnement du centre de données.

Dans la mesure où un système de climatisation en circuit fermé équipe la plupart des centres
de données, il est nécessaire d'introduire une quantité minimale d'air afin de satisfaire
aux exigences de ventilation des occupants de la salle. En général, les zones des centres
de données présentent une faible densité de population ; la quantité d'air nécessaire à la
ventilation est donc minimale. Dans la plupart des cas, la quantité d'air nécessaire à la
pressurisation positive dépasse probablement celle nécessaire à la ventilation de la salle.
En règle générale, une quantité d'air extérieur inférieure à 5 % doit être suffisante pour
la ventilation d'appoint (manuel de l'ASHRAE : Applications, Chapitre 17). Un volume
de 15 CFM d'air extérieur par occupant ou station de travail doit suffire aux besoins de
ventilation de la salle.

F.9. Equipement et procédures de nettoyage

Même les centres de données les mieux conçus doivent faire l'objet d'un entretien constant.
Le maintien des conditions dans les limites souhaitées risque d'exiger des efforts importants
dans les centres de données dont la conception présente des défauts ou a fait l'objet de
compromis. La performance matérielle est un facteur important de la nécessité de maintenir
un niveau élevé de propreté dans le centre de données.
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La sensibilisation des opérateurs est un autre point à prendre en considération. Le maintien
d'un niveau élevé de propreté permet de mieux sensibiliser les occupants aux exigences et
restrictions qui s'appliquent à leur présence dans le centre de données. Les occupants et les
visiteurs du centre de données tiendront l'environnement contrôlé en haute considération et
seront plus enclins à agir comme il se doit. Un environnement maintenu à un niveau élevé
de propreté et de manière structurée et organisée inspire également le respect des occupants
et des visiteurs de la salle. Les clients potentiels qui visiteront la salle interprèteront l'aspect
général de la salle comme le reflet d'un engagement global envers l'excellence et la qualité.
Un calendrier de nettoyage efficace doit comporter des actions précises sur les long et moyen
termes. Elles peuvent se résumer comme suit :

Tableau F.1. Fréquence des actions

Fréquence Tâche

Actions quotidiennes Ramassage des déchets

Actions hebdomadaires Entretien du faux-plancher (aspirateur et serpillière humide)

Actions trimestrielles Décontamination du matériel

Décontamination des surfaces de la salle

Actions semestrielles Décontamination du vide du sous-plancher

Décontamination du climatiseur (le cas échéant)

F.9.1. Tâches quotidiennes

Ce cahier des charges se concentre sur le retrait des déchets et rebuts quotidiens de la salle.
En outre, il peut être nécessaire de passer chaque jour l'aspirateur dans les salles d'impression
ou les pièces dans lesquelles l'activité des opérateurs est importante.

F.9.2. Tâches hebdomadaires

Ce cahier des charges est principalement axé sur l'entretien du système de faux-plancher. Tout
au long de la semaine, les accumulations de poussières et les taches souillent le faux-plancher.
Le faux-plancher tout entier doit être nettoyé au moyen d'un aspirateur et d'une serpillière
humide. Indépendamment de leur utilisation, tous les aspirateurs utilisés dans le centre de
données doivent être équipés de la filtration HEPA (High Efficiency Particulate Air, haute
efficacité pour les particules de l'air). Les équipements dotés de filtres inadéquats ne sont pas
en mesure de retenir les particules plus petites. Au contraire, ils ne font que les agiter, ce qui
dégrade l'environnement qu'ils sont censés améliorer. Il est important que les serpillières et
les chiffons ne peluchent pas.

Les solutions de nettoyage utilisées dans le centre de données ne doivent pas constituer de
menace pour le matériel. Les solutions susceptibles d'endommager le matériel comportent les
produits suivants :

• Ammoniac
• Chlore
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• Phosphate
• Javel
• Produits pétrochimiques
• Décapants et rénovateurs

Il est également important de s'en tenir aux concentrations recommandées. En effet, un agent
approprié risque de provoquer des dommages en cas de concentration inappropriée. La
solution doit être conservée en bonne condition tout au long du processus et les applications
excessives doivent être évitées.

F.9.3. Tâches trimestrielles

Le cahier des charges trimestriel implique un calendrier de décontamination exhaustif et
détaillé. Il ne doit être mené que par des professionnels expérimentés du contrôle de la
contamination des salles informatiques. Ces opérations doivent être réalisées entre trois
et quatre fois par an, en fonction des niveaux d'activité et de la présence de contaminants.
Toutes les surfaces de la salle, y compris les placards, rebords, étagères, rayons et
équipements de support, doivent faire l'objet d'une décontamination en profondeur. Les
étagères en hauteur et les appareils d'éclairage ainsi que les zones généralement accessibles
doivent être traitées et nettoyés comme il se doit. Les surfaces verticales, telles que les
fenêtres, cloisons en verre, portes, etc., doivent être soigneusement nettoyées. Lors du
processus de décontamination des surfaces, il convient d'utiliser des chiffons imprégnés d'une
substance absorbant les particules. Dans le cadre de ces activités, toute étoffe ou tout chiffon
à poussière classique est à proscrire, tout comme les produits chimiques, cires et dissolvants.

Les dépôts de contaminants doivent être éliminés de l'ensemble des surfaces extérieures du
matériel, y compris les surfaces horizontales et verticales. Les grilles d'entrée et de sortie
d'air de l'unité doivent également être traitées. Ne nettoyez pas les surfaces de contrôle
de l'unité ; elles peuvent être décontaminées en insufflant de l'air légèrement comprimé.
Apportez un soin particulier au nettoyage des claviers et des commandes associées à la
sécurité des personnes. Pour nettoyer les surfaces du matériel, utilisez des chiffons ayant
subi un traitement spécial. Passez un produit d'entretien optique et un chiffon antistatique
sur les écrans. N'utilisez pas de produits chimiques dissipatifs de charge électrostatique sur
le matériel informatique ; leur causticité risque d'endommager la plupart des équipements
délicats. Dans la mesure où le matériel informatique est conçu pour dissiper la charge
électrostatique, aucun traitement supplémentaire n'est nécessaire. Après avoir décontaminé en
profondeur toutes les surfaces et tout le matériel de la salle, passez l'aspirateur HEPA et une
serpillière humide comme décrit en détail dans la section Tâches hebdomadaires.

F.9.4. Tâches semestrielles

Le vide du sous-plancher doit être décontaminé tous les 18 ou 24 mois en fonction de
l'état des surfaces du plénum et du degré d'accumulation des contaminants. Tout au long
de l'année, le vide du sous-plancher subit un volume important d'activités à l'origine de
nouvelles accumulations de contaminants. Bien que les activités hebdomadaires de nettoyage
du plancher décrites ci-dessus permettent de réduire en grande partie les accumulations
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de contaminants, une certaine quantité de poussières migre des surfaces au vide du sous-
plancher. Il est important de maintenir le degré élevé de propreté du sous-plancher, qui sert
de plénum d'alimentation d'air du matériel. Pour réduire la contamination croisée, mieux
vaut effectuer le traitement de décontamination du sous-plancher dans un délai assez bref.
Le personnel chargé de cette opération doit avoir reçu une formation complète afin d'évaluer
la priorité et la connectivité des câbles. Chaque zone exposée du vide du sous-plancher doit
faire l'objet d'une inspection et d'une évaluation individuelle en termes de déplacement et de
manipulation de câbles. Avant de déplacer des câbles, vérifiez que toutes les connecteurs de
type enfichage ou rotation sont correctement branchés. Menez toutes les activités concernant
le sous-plancher en prenant en compte la distribution de l'air et de la charge au sol. Dans le
but de maintenir l'intégrité du faux-plancher et les conditions psychrométriques, gérez avec
précaution le nombre de dalles que vous retirez du système de plancher. Dans la plupart des
cas, l'ouverture dans le faux-plancher ne doit pas dépasser 7 mètres carrés (six dalles) pour
chaque équipe de travail à tout moment. Le système de grille d'appui du faux-plancher doit
également être décontaminé en profondeur ; aspirez d'abord les débris détachés, puis passez
une éponge humide sur les résidus accumulés. Le cas échéant, les joints en caoutchouc et
la structure métallique composant le système de grille doivent être retirés et nettoyés avec
une éponge humide. Notez et signalez tout état inhabituel du vide du plancher, comme par
exemple les surfaces, câbles, dalles et suspensions endommagés.

F.10. Activités et processus
Dans le cadre du maintien des conditions d'un centre de données, l'isolation est un facteur
primordial. Toute activité inutile doit être évitée dans le centre de données, dont l'accès
doit être réservé au personnel indispensable. Les activités périodiques, telles que les
visites, doivent être limitées et les déplacements doivent s'effectuer à distance du matériel
afin d'éviter tout contact accidentel. L'ensemble du personnel travaillant dans la salle, y
compris les employés temporaires et le personnel d'entretien, doit recevoir une formation
sur les points sensibles de base du matériel afin d'éviter toute exposition inutile. Les zones
contrôlées du centre de données doivent être parfaitement isolées de toute activité générant
des contaminants. Dans l'idéal, les salles d'impression, salles de tri, centres de commande
ou toute autre zone dans laquelle les niveaux d'activité humaine ou mécanique sont élevés
ne doivent pas présenter d'exposition directe au centre de données. Les accès à ces zones ne
doivent pas nécessiter de déplacements via les zones principales du centre de données.
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Glossaire
2N PDU fournissant l'alimentation du réseau électrique CA redondant et des

troisième et quatrième racks auxiliaires. Voir également N+1  et 2N+1.

2N+1 Deux PDU pour la redondance CA. Chaque PDU possède des alimentations
CC supplémentaires pour la redondance N+1 par PDU.

ACSLS Voir Automated Cartridge System Library Software (ACSLS, logiciel
automatisé de la bibliothèque de bandes du système de cartouches).

Address Resolution
Protocol (ARP, protocole
de résolution d'adresse)

Protocole de couche réseau qui convertit une adresse IP en adresses
physiques, telles que des adresses Ethernet. La fonction de reprise d'ARP
permet au trafic d'être redirigé d'une connexion OSA-Express en échec vers
une autre connexion OSA-Express.

ADI Interface du lecteur d'automatisation.

Adressage d'emplacement
de lecteur

Nombre entier à dix chiffres compris entre 01 et 64 qui représente les
emplacements physiques dans lesquels sont insérés les assemblages de tiroirs
de lecteurs.

AEM Voir Module d'extension d'accès.

Assemblage de tiroirs de
lecteurs de bande

Structure mécanique hébergeant un lecteur de bande, un assemblage de
ventilateurs, des cartes logiques et d'alimentation et des connecteurs pour les
câbles de données et logiques. Identique à assemblage de tiroirs de lecteur.

Audit Inventaire des emplacements des cartouches dans toutes les zones de la
bibliothèque, incluant les emplacements dans la zone de stockage et la zone
réservée. Des audits sont effectués lorsque :

• La bibliothèque est initialisée lors de la mise sous tension.
• Une porte d'accès, ou les deux, sont ouvertes et fermées sans activer la

porte de sécurité de service.
• Une demande d'audit physique est effectuée via SLConsole.

Audit de l'hôte Processus de mise à jour des ID de volume et emplacements de la cartouche
dans des CD de l'hôte. L'audit est initié par une commande de l'hôte.

Audit de vérification Les audits de vérification sont appelés à partir de SLC et permettent de
valider l'état d'un emplacement de cartouche ou d'une plage d'emplacements
spécifique.

Audit physique Des audits physiques ont lieu lorsque les robots :

• Scannent les emplacements de cartouche dans la bibliothèque.
• Vérifient les volumes.
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• Mettent à jour l'inventaire de la carte de contrôle de la bibliothèque.
• Définissent l'état de l'emplacement de la cartouche sur "true".

Automated Cartridge
System Library Software
(ACSLS, logiciel
automatisé de la
bibliothèque de bandes du
système de cartouches)

Un package de systèmes ouverts qui permet de gérer le contenu de la
bibliothèque et de contrôler le matériel de la bibliothèque pour le montage et
le démontage des cartouches sur les lecteurs de bande. L'application fournit
également des services de gestion de bibliothèque de bandes, comme le suivi
des cartouches, le groupement, les rapports et le contrôle de la bibliothèque
de bandes.

Automated Cartridge
System Library Software
(ACSLS) High Availability
(HA, haute disponibilité)

Configuration matérielle et logicielle qui fournit la redondance double, la
récupération automatique et la récupération de basculement automatique pour
assurer la gestion ininterrompue des bibliothèques SL3000.

Basculement Déplacement vers un chemin secondaire ou redondant en cas d'échec du
chemin principal. Dans ACSLS HA, basculement vers le serveur ACSLS
alternatif en veille.

Bibliothèque logique Représentation virtuelle d'une bibliothèque physique. Identique à la partition
de bibliothèque virtuelle.

CAP Voir Port d'accès aux cartouches (CAP, Cartridge Access Port) .

Capacité Capacité de stockage de la bibliothèque de bandes. Voir également Capacité
activée et Capacité installée .

Capacité activée Nombre d'emplacements de stockage que la bibliothèque est autorisée à
utiliser. Ce nombre ne peut pas dépasser la capacité installée.

Capacité installée Nombre d'emplacements de stockage physiquement présents dans la
bibliothèque.

Carte HBC/HBCR Carte de contrôleur sur la bibliothèque SL3000.

Cartouche Conteneur de bandes magnétiques qui peut être traité sans séparer la
bande du conteneur. La bibliothèque utilise des cartouches de données, de
diagnostic et de nettoyage.

Cartouche de bande Conteneur de bandes magnétiques qui peut être traité sans séparer la
bande du conteneur. La bibliothèque utilise des cartouches de données, de
diagnostic et de nettoyage. Ces cartouches ne sont pas interchangeables.

Cartouche de diagnostic Cartouche de données utilisée pour les routines de diagnostic.

Cartouche de données Cartouche sur laquelle lecteur de bande peut inscrire des données.

Cartouche de nettoyage Cartouche de bande contenant des matériaux spéciaux permettant de nettoyer
le chemin de bande.
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Cartouche orpheline Dans les bibliothèques de bandes partitionnées, une cartouche se trouvant
dans un emplacement ou un lecteur non affecté (c'est-à-dire un emplacement
ou un lecteur non affecté à une partition définie). Les cartouches peuvent
devenir orphelines lorsque les limites de la partition sont modifiées,
que les partitions sont supprimées ou que les cartouches sont déplacées
manuellement vers des emplacements non affectés ou inaccessibles.

CEM Voir Module d'extension de cartouche .

Chargement en masse Chargement manuel des cartouches dans la bibliothèque de bandes durant la
phase d'installation, par exemple.

Chemin de données Chemin par lequel des données sont transférées entre les lecteurs de l'hôte et
les lecteurs de bande.

Commutateur de
mécanismes de
verrouillage

Commutateur permettant d'interrompre l'alimentation vers les mécanismes de
la bibliothèque, à l'exception des lecteurs de bande, lorsque la porte avant est
ouverte.

DEM Voir Module d'extension de lecteur (DEM).

dWWN Voir WWN dynamique .

ECM Voir Module de contrôle de système électronique .

Ejection Voir Exportation .

ELS Voir Enterprise Library Software (ELS).

Emplacement de lecteur Section partitionnée de l'assemblage de baies de lecteurs de bande incluant
un assemblage de tiroirs de lecteurs de bande.

Emplacements de dépose Cellules utilisées pour accueillir une cartouche en cas de panne du robot
manipulant la cartouche.

Ensemble rail Mécanisme de déplacement du robot entre les baies de cartouches et les
lecteurs de bande.

Enterprise Library
Software (ELS)

Produits logiciels permettant d'automatiser les opérations sur la bande pour
les utilisateurs du mainframe.

EPO Voir Mise hors tension d'urgence (EPO) .

Exportation Action au cours de laquelle la bibliothèque place une cartouche dans le port
d'accès aux cartouches de sorte que l'opérateur puisse retirer la cartouche de
la bibliothèque. Identique à éjection.

Format LTO (Linear Tape
Open)

Ensemble de normes de format de données créé pour permettre l'échange
mutuel de données entre les différents fournisseurs de lecteurs de bande LTO
Ultrium. Ces normes permettent aux cartouches de données d'être partagées.
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FRU Unité remplaçable sur site.

Get Activité lors de laquelle un robot récupère une cartouche à partir d'un
emplacement ou d'un lecteur.

HLI/PRC Interface de la bibliothèque de bandes de l'hôte (HLI)/Panneau, ligne,
colonne (PRC)

Host Software Component
(HSC, composant logiciel
hôte)

Composant d'ELS, HSC est un logiciel qui réside sur les systèmes
d'exploitation du mainframe et qui contrôle la bibliothèque. Le HSC reçoit
des demandes de l'interface de programmation et les traduit en commandes
qui sont transportées via le chemin de contrôle vers la bibliothèque. HSC est
le gestionnaire général de la bibliothèque, l'interface entre une bibliothèque
et un système d'exploitation mainframe. HSC gère un jeu de données
de contrôle, les enregistrements des cartouches stockées dans chaque
bibliothèque.

ID de volume ID de volume affecté à une cartouche. Identique à VOLSER .

Importation Processus d'insertion d'une cartouche dans le port d'accès aux cartouches
afin qu'elle puisse être introduite dans un emplacement de stockage par la
bibliothèque.

Insertion Voir Importation .

Interface de bibliothèque
de bandes primaires (PLI)

Chemin des communications entre le panneau opérateur et le contrôleur de la
bibliothèque.

Interface de transport de
bande (TTI)

Interface permettant de contrôler et de suivre le mouvement des bandes.

Interface de transport de
bandes (TTI)

Voir Interface de transport de bande (TTI) .

Jeu de données de contrôle Jeu de données utilisé par le logiciel hôte ELS/HSC pour contrôler les
fonctions de la bibliothèque de bandes automatisée. Egalement appelé base
de données de bibliothèque ELS.

LCM Voir Library Content Manager (LCM) .

Lecteur de bande Périphérique électromécanique qui déplace une bande magnétique et met en
oeuvre des mécanismes d'écriture et de lecture de données depuis et vers la
bande.

Library Content Manager
(LCM)

Logiciel assurant la gestion du contenu pour les environnements de bandes
automatisés des mainframes.

LTO Voir Format LTO (Linear Tape Open) .
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LUN Voir Numéro d'unité logique.

Magasin Baie amovible contenant des cartouches et placée dans le port d'accès aux
cartouches (CAP).

Mise hors tension
d'urgence (EPO)

(1) Schéma de sécurité permettant de mettre hors tension un sous-système ou
un système entier sans devoir interrompre les composants les uns après les
autres.

(2) Commutateur sécurisé sur un système ou un centre de données permettant
à un utilisateur de mettre immédiatement hors tension un système ou un
centre de données en coupant la source d'alimentation externe.

Module d'extension
d'accès

L'AEM constitue essentiellement un CAP de taille très importante, avec
toutes les caractéristiques d'un CAP, tel que l'état en ligne/hors ligne,
la possibilité de partage entre des partitions, etc. Les emplacements de
cartouche dans l'AEM ne peuvent pas servir à un stockage à long terme.

Module d'extension de
cartouche

Module facultatif pour la bibliothèque offrant des emplacements de
cartouches supplémentaires et extensibles.

Module d'extension de
lecteur (DEM)

Module permettant une extension supplémentaire des lecteurs de bande.

Module d'extension de
stockage (PEM)

Module supplémentaire disponible pour la bibliothèque SL3000 permettant à
un robot redondant d'y être stocké.

Module de base Fournit l'offre d'entrée de gamme pour la bibliothèque de bandes SL3000.
Constitue une structure unique et centralise l'infrastructure pour tous les
autres modules de la bibliothèque. Ce module inclut des configurations
d'alimentation, des unités robotiques, des modules électroniques, le port
d'accès aux cartouches (CAP), des emplacements de stockage, des lecteurs de
bande et des commandes.

Module de contrôle de
système électronique

Module incluant les cartes HBK, HBC/HBCR et HBT. Il s'agit de
l'assemblage qui :

• Traite les commandes d'un système hôte
• Coordonne les activités des robots et lecteurs de bande
• Surveille les informations d'état provenant des capteurs et des

commutateurs

N+1 Configuration permettant l'alimentation CA et l'alimentation CC redondante
grâce à l'ajout d'une deuxième alimentation CC à chaque bus d'alimentation
CC. Voir également 2N.

Numéro d'unité logique Identificateur unique pour l'allocation du stockage physique. Un LUN peut
renvoyer à un ensemble de RAID entier, une partition ou un disque dur
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unique ou à des disques ou des partitions multiples. Contrairement au LUN
physique, le LUN virtuel ne mappe pas vers un périphérique spécifique ou un
espace de stockage alloué mais vers un espace virtualisé qui peut être créé en
plus de l'espace physique réel disponible.

Panneau opérateur Voir Panneau opérateur tactile .

Panneau opérateur de la
bibliothèque

Voir Panneau opérateur tactile .

Panneau opérateur tactile Affichage à écran plat avec interface à écran tactile et ordinateur monté sur
panneau. Cette fonctionnalité est intégrée à l'avant de la bibliothèque.

PDU Voir Unité de distribution de courant (PDU, Power Distribution Unit) .

PEM Voir Unité de distribution de courant (PDU, Power Distribution Unit) .

PLI Voir Interface de bibliothèque de bandes primaires (PLI) .

Port d'accès aux
cartouches (CAP,
Cartridge Access Port)

Port bidirectionnel intégré au panneau de la porte de la bibliothèque de
bandes qui permet l'introduction manuelle ou l'éjection automatique de
cartouches de données ou de nettoyage. Identique à la fente d'importation/
exportation dans les bibliothèques SCSI et les bibliothèques des systèmes
ouverts.

Porte d'accès Portes situées de chaque côté de la façade permettant au personnel d'accéder
à la bibliothèque. Des CAP facultatifs sont attachés à la porte d'accès de
droite.

Put Activité au cours de laquelle un robot place une cartouche dans un
emplacement ou un lecteur.

Rail (1) Partie de l'ensemble de pistes supérieur du robot qui fournit l'alimentation
et les communications au robot. (2) Tous les emplacements et lecteurs de
cartouche accessibles par le biais d'un rail.

RE Voir Redundant Electronics (RE) .

Redundant Electronics
(RE)

Fonctionnalité offrant une protection de basculement dans les bibliothèques
d'entreprise. RE utilise deux ensembles de cartes de contrôleur de
bibliothèque. A tout moment, un ensemble peut être activé et l'autre
ensemble passer en mode veille. Le contrôleur de la bibliothèque actif peut
basculer en mode veille en réponse à une commande du logiciel ACSLS
ou de SLConsole. Le basculement automatique peut être initié par la
bibliothèque en cas d'échec d'une carte de la bibliothèque.

Remplacement à froid Pour supprimer et remplacer un composant système (généralement une carte
logique sans sauvegarde redondante) après que des opérations système ont
été interrompues et que l'alimentation du système a été désactivée.
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Robot Mécanisme de déplacement horizontal le long d'une piste pour le transport
des cartouches de bandes depuis et vers d'autres emplacements de la
bibliothèque.

Routage Processus de déplacement d'un paquet de données d'une source vers une
destination. Le routage permet aux messages de passer d'un périphérique à un
autre, et d'atteindre finalement leur cible.

SSL Voir SSL (Secure Sockets Layer) .

SSL (Secure Sockets
Layer)

Protocole cryptographique garantissant la sécurité de la communication.
Le chemin de communication entre l'interface PLI et la console distante de
l'opérateur se fait via SSL.

TCP/IP double Fournit deux connexions hôtes distinctes entre le logiciel hôte (ACSLS ou
HSC) et le contrôleur de la bibliothèque.

Unité de distribution de
courant (PDU, Power
Distribution Unit)

Périphérique permettant de distribuer l'alimentation CA du réseau à partir
d'un seul collecteur vers plusieurs prises de courant. Plusieurs unités de
distribution de courant CA fournissent une disponibilité optimisée car
l'alimentation est maintenue si l'une de ces unités (ou leur autre source de
courant si elles utilisent des sources CA distinctes) n'est plus alimentée.

VOLSER Numéro de série du volume. Identique à ID de volume.

World Wide Name
(WWN, nom universel)

Adresse 64 bits qui identifie de façon unique chaque périphérique et
fournisseur ; il est comparable à l'adresse MAC d'une interface Ethernet.
Chaque port d'un réseau Fibre Channel doit avoir un nom universel WWN
unique. Le nom universel WWN n'est pas juste une adresse matérielle
physique. Il sert également d'adresse logique pour les noeuds de réseau SAN.
Par conséquent, la configuration du réseau SAN est modifiée dès lors que le
matériel relié est modifié. Si un périphérique défectueux est remplacé, le nom
universel du noeud change et force ainsi la reconfiguration du réseau SAN.
Il existe trois noms universels pour les différentes baies de lecteurs : noeud,
port A et port B.

WWN dynamique Lorsque cette fonction est activée, dWWN nomme les emplacements de
lecteur de la bibliothèque de bandes au lieu des périphériques. Si un lecteur
est remplacé, le nouveau lecteur se voit attribuer le même nom que celui
qu'il remplace, ce qui élimine la nécessité de devoir reconfigurer le système.
dWWN attribue des noms aux différents emplacements de lecteur de bande
plutôt qu'aux périphériques.



184



Index · 185

Index
A
ACSLS

Fonctionnalité TCP/IP double et configuration
High Availability, 125
Fonctionnalité TCP/IP double et routage High
Availability, 125
Sous-réseaux distincts de TCP/IP double, 124

Activation de matériel
Journal d'audit des fonctionnalités, 80

Adressage, 
FC-SCSI, 142
HLI des CAP, 140
HLI-PRC, 138
Lecteurs de bande, 148
Microprogramme interne, 133
Microprogramme interne des AEM, 137
Microprogramme interne des CAP, 137

Adressage HLI-PRC, 138
Adresse du microprogramme interne, 133
AEM

Accès d'urgence, 101
Association à une partition, 53
Partitions de la bibliothèque, 34
Réinitialisation, 87
Suppression des associations de partitions, 53

Alertes de statut
Affichage, 73
Effacement, 95

Alimentations électriques
Informations de synthèse, 74
Statut, 74
Tâches de surveillance, 74

Ascenseur
Informations de synthèse, 74, 74
Statut, 74

Associations des CAP
Partitions de la bibliothèque, 35, 53
Suppression, 53

Audits
Ensemble de la bibliothèque, 71
Indicateur d'audit, 72
Physique, 71, 71, 72
Plage de cellules, 72

Porte d'accès principal, 72
Vérifié, 72

Autotests
Bibliothèque, 91, 91, 91
CAP, 92
Robot, 92

Autotests de la bibliothèque, 91
Exécution, 91, 91

B
Basculement de la bibliothèque en ligne, 86
Basculement de la bibliothèque hors ligne, 85
Bibliothèque

Mise en ligne, 86
Montage d'une cartouche, 102
Placement en mode manuel, 85

C
CAP

Affichage des informations de synthèse, 74
Affichage des propriétés, 74
Affichage du statut, 74
Autotest, 92
Disponibilité pour les actions de diagnostic, 53
États

Partitions de la bibliothèque, 54, 54, 54
Fermeture, 52
Insertion de cartouches, 49
Mise en ligne, 86
Mise hors ligne, 86
Mode d'insertion automatique, 54
Mode manuel, 54
Partitions de la bibliothèque, 34, 35, 53

CAP manuel, 54
Capacité

Activée. Voir Capacité activée., 
Bibliothèque non partitionnée, 27

Capacité activée
Cartouches orphelines, 29
Modifications et connexions FC-SCSI, 38
Modifications et connexions HLI, 38
Zones de stockage actives

Rapports, 80
Cartouches

Affichage des informations, 80
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Déplacement depuis un emplacement spécifique,
57
Déplacement par ID de volume, 57
Déplacements de récupération, 57
Éjection d'une partition, 53
Éjections, 50
Insertion dans le CAP, 49
Insertion dans une cellule ou un lecteur, 65
Insertion dans une partition, 53
Insertions, 49
Inspection, 65
Liste, 80
Localisation par adresse, 58, 58
Localisation par ID de volume, 58, 58
Manipulation, 64
Montage, 102
Nettoyage de la partie extérieure, 65
Non étiquetées, 64
Présentation des codes-barres, 61, 61
Stockage, 65

Cartouches de diagnostic
Autotests de la bibliothèque, 91
Description, 59
Exportation, 60
Importation, 59
Tâches de gestion, 59

Cartouches de nettoyage, 64
Importation, 59
Liste, 61
Seuil d'avertissement, 60

Cartouches orphelines
Bibliothèques non partitionnées, 29
Bibliothèques partitionnées, 35

Configuration de la bibliothèque
Affichage, 74

Contrôleur de la bibliothèque
Affichage de Redundant Electronics, 75, 75
Connexion au contrôleur de secours, 121
Propriétés, 74

Contrôleur des lecteurs, 74

D
Dépannage, 89
Déplacements de récupération, 57
Diagnostics

CAP, 53

Diffusions de réseau, 124

E
Eléments FC-SCSI, 142

F
Fichier d'activation de matériel

Affichage des fonctionnalités actuelles, 24
Affichage du contenu, 23
Comparaison avec les fonctionnalités existantes,
23
Installation, 23
Suppression, 24
Téléchargement, 23

Fichier d'instantané de journal
Processus de génération, 81
Processus de transfert, 82

Fichier MIB
Processus de transfert, 81

Fichiers de diagnostic pour le support, 81
Fonctionnalités activées

Affichage des fonctionnalités actuelles, 24

I
Inondations ARP, 124
Interface FC-SCSI, 37

Fonctionnalité FastLoad, 46, 46
Présentation des codes-barres, 61, 61

Interface HLI, 37
Affichage du statut des ports, 73

Interfaces hôtes
Bibliothèques non partitionnées, 37
HLI. Voir Interface HLI., 73
Modification du type, 37

J
Journaux

Journal d'audit des fonctionnalités, 80

L
Lecteurs

Affichage des informations de synthèse des
lecteurs, 75
Affichage des propriétés des lecteurs, 75
Affichage du statut, 75
Données de réseau, 75
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Mise en ligne, 86
Mise hors ligne, 86
Montage d'une cartouche, 102
SCSI FastLoad, 46, 46
Statut des voyants, 75

Lecteurs de bande
Adressage, 148
Adresse du microprogramme interne, 135
HLI-PRC, 141
Numérotation du matériel, 148

Liaison des ports, 73
Ligne centrale, 132

M
Mise hors tension de la bibliothèque, 99, 99
Mise sous tension de la bibliothèque, 99, 99
Mises à niveau du microprogramme de la
bibliothèque, 

Activation, 129
Téléchargement, 129

Mises en garde
Réinsertion d'une cartouche de nettoyage, 59
Solvants pour le nettoyage d'une cartouche, 65

Mode d'insertion automatique (CAP)
Description, 54

Mode manuel
Montage d'une cartouche, 102
Placement de la bibliothèque en mode manuel, 85

Mots de passe
Modification, 22

N
Nettoyage automatique de la bibliothèque de bandes,
45
Nettoyage des lecteurs

Configuration du nettoyage automatique de la
bibliothèque de bandes, 45, 46
Importation de cartouches de nettoyage, 59
Manuel, 101

Nettoyage manuel (lecteur), 101

O
Opérations d'éjection, 50

Bibliothèques partitionnées, 53
Opérations d'insertion, 49

Bibliothèques partitionnées, 53

Opérations manuelles
Précautions de sécurité, 100

Générales, 100

P
Panneau opérateur local

Alignement d'usine, 96
Connexion, 22
Réétalonnage, 96

Partitionnement sans interruption
Partitions FC-SCSI, 39

Partitions de la bibliothèque
Affichage, 29, 34
Associations d'AEM, 53
Associations des CAP, 35, 53, 53
CAP partagés, 35
Cartouches orphelines, 35
Conception, 33
Description, 
Éjection de cartouches, 53
États des CAP, 54, 54, 54
Fonctionnalité SCSI FastLoad, 46
Hôtes, 31
Insertion de cartouches, 53
Présentation des codes-barres, 61
Rapports, 81
Réservations des CAP, 35, 52
Suppression, 32
Tâches de configuration, 31
Utilisation des AEM, 34
Utilisation des CAP, 34, 35
Validation des modifications de configuration, 34

Placement de la bibliothèque en mode manuel, 85
Porte d'accès

Fermeture, 100
Ouverture, 100

Porte d'accès à l'AEM
Accès rapide, 101
Fermeture, 52

Porte d'accès principal
Audits, 72

Porte de sécurité
Informations de synthèse, 74
Propriétés, 74
Tâches de surveillance, 74

Porte de sécurité de l'AEM
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Propriétés, 75
Statut, 75

Ports
Statut, 73

Précautions de sécurité, 100
Générales, 100

Présentation des codes-barres, 61, 61
PTP

Propriétés, 74
Statut, 74

R
Rapport sur les événements de lecteur, 79
Rapport sur les événements de média de lecteur, 79
Rapport sur les statistiques d'événements généraux,
79
Rapports

Événements de lecteur, 79
Journal d'audit des fonctionnalités, 80
Récapitulatif des cartouches, 80
Tableau des cartouches, 80

Rapports SL Console
Événements de lecteur, 79
Événements de média de lecteur, 79
Événements généraux, 79

Rapports sur la bibliothèque
Affichage, 79
Enregistrement des données dans un fichier, tâches
de rapport de SL Console, 79
Recherche, 79

Redundant Electronics
Basculement manuel, 95
Tâches, 75

Réinitialisation
Bibliothèque, 87

Réinitialisation de la bibliothèque, 87
Réservations des CAP

Annulation, 52
Partitions de la bibliothèque, 35

Robot
Affichage des informations de synthèse, 74
Affichage du statut, 74
Autotest, 92
Basculement en ligne, 86
Basculement hors ligne, 86
Propriétés, 74

SCSI FastLoad, 46, 46
Tâches de surveillance, 74

S
SCSI FastLoad, 46, 46
Séquence d'initialisation de la bibliothèque, 99
SL Console

Modes, 17
Problèmes de communication, 76

SL Console autonome
Connexion, 21

SLC
Modification des mots de passe, 22

SLC autonome, 18
SLC Web, 18
SLConsole

Pack de supports, 17
Téléchargement, 17

SLConsole Web
Connexion à l'aide de l'interface de ligne de
commande, 21

SNMP
Transfert du fichier MIB de la bibliothèque, 81

Statut
Bibliothèque et périphériques, 76

Statut de la bibliothèque, 76
Affichage, 73

Statut des périphériques, 76

T
TCP/IP double

Définition, 123
Routage d'ACSLS, 124
Sous-réseaux distincts d'ACSLS, 124
Tâches de configuration, 42

Tiroirs des lecteurs
Statut, 75

Transfert du fichier d'instantané de journal, 82

V
VOP

Affichage pour lecteurs T10000, 75
VOP de lecteur

Affichage pour T10000, 75
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